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Introduction

ThumbsPlus is a graphic file viewer, locator and organizer which simplifies the process of 
finding and maintaining graphics, clip-art files, fonts and animations. It displays a small image 
(thumbnail) of each file. You can use ThumbsPlus to browse, view, edit, crop, launch external 
editors, and copy images to the clipboard. You can use drag-and-drop to organize graphics files 
by moving them to appropriate directories. ThumbsPlus will also create a slide show from 
selected graphics, and install bitmap files as Windows wallpaper.

You can print individual graphics files, or the thumbnails themselves as a catalog. ThumbsPlus 
can convert to several formats, either one at a time or in batch mode. You can also perform image 
editing in batch mode. ThumbsPlus will also convert metafile graphics to bitmaps (rasterize).

ThumbsPlus can process dozens of file types internally. Here's a comprehensive list and details 
on each format.

You can also use Object Linking and Embedding (OLE) to create thumbnails for and view any 
proprietary file type for which the server application is loaded on your system.



New Features in Version 3.0 - 3.0c

Please see the Release Notes for more detailed information on 3.0b and 3.0c changes.

(R) Registered version only.
(N) Network (concurrent user) license only.
(C) Added in version 3.0c.

· ThumbsPlus version 3.0 is a 32-bit application for Windows 95, NT and 3.1/3.11 (using 
Win32s). 

· Several new file types are supported:

PNG: PiNG format (read/write)
UUE: uuencoded files (read and decode)
AVI: Windows animation (now supported in the shareware version)
MOV: Macintosh animation (now supported in the shareware version)
CUR, ANI: Windows cursors (thumbnail only, Windows 95/NT 4 only)
(C) FIF: Fractal Compressed files (Iterated Systems, Inc.).
(C) STX, ST5, ST6, ST7, ST8: Santa Barbara Instruments Group.
(C) KIZ: Kodak Digital Postcard images.
(C) DCX: Multi-image PCX files.
(R) PFB: Adobe Type 1 fonts.
(R) DXF: AutoCAD Exchange format.
(R) MPG: MPEG compressed video.

· Improvements handling several file types:

GIF: Transparency is supported (read and write). 
(C) Animated GIF files may be played.

JPEG: Progressive mode is supported (read and write).
CMYK colorspace files can be read.

PSD: Photoshop version 3 files are supported.
(C) CIE L*a*b colorspace is supported.

TIFF: JPEG and ZIP compressed TIFFs are supported.
(C) Multi-page TIFFs are supported.
(C) CIE L*a*b colorspace is supported.

RAS: Bi-level SUN Raster files may now be read.

· Version 3.0 incorporates a new database format, which provides:

Keyword assignment and searching.

Automatic keyword assignment based on file type, file name, and file color 
characteristics.

Long file name support (except on Windows 3.1/3.11).

Selection of thumbnail size and color depth (32 gray levels, 236-color palette, or 15-bit 
high color).

Improved disk volume recognition (especially for network and CDROM drives), and 
assignment of volume aliases.



File annotations (comments in the database).

· ThumbsPlus can now read image files larger than 16Mb (except on Windows 3.1/3.11).

· Improved display speed and memory usage for large files. For some file types, 
ThumbsPlus will also view   while   loading   a file.

· Contact sheets (showing parts or all of a thumbnail catalog in a graphic file) with many 
configuration options.

· Improved OLE client support.

· Color selection for directory list folders and various other user interface elements.

· Toolbar improvements:

Customizable main window toolbar

View window toolbar (also customizable)

Tool tips for buttons on toolbars

· View window status line.

· Reorganization of menus for ease-of-use.

· Addition of right-button menus (context menus).

· Use of property sheets (tabbed dialog boxes) to simplify adaptation of the program to 
your needs.

· (R) Shows ZIP files as directories, which can be browsed, and the files in the archive 
may be treated as regular files.

· (R) 32-bit TWAIN scanner support.

· Improved algorithms and 32-bit code result in faster image manipulation and 
conversion.

· You may now delete directories and entire directory trees.

· ThumbsPlus can use the Windows 95 Recycle Bin for deleting files if selected in 
Options | Preferences • General. 

· (C) ThumbsPlus now supports multi-image files (TIFF or DCX). You can use Edit menu 
options in a view window to switch between pages, or to split the pages into separate 
images.

· (C) You can manage files from the view window; for example, the Space and Backspace 
keys (or File | Next file and File | Previous file) will display the next or prior file in the 
current directory. There are also menu selections and keystrokes to copy, move, rename 
and delete the current file.

· Improved network support:

  ThumbsPlus can better recognize and differentiate between network drives. It uses 
the connection information rather than the drive letter to match database thumbnails 
with their corresponding network files.

(N) Network user program defaults can be set up in a THUMBS.DEF file in the 



network directory with ThumbsPlus.

(N) ThumbsPlus may be installed on and run from a network drive, and the database 
may be shared on a network. (Single-user licenses will not operate on a network).

(N) Network database defaults can be set up in a THUMBS.TDD file in the directory 
with the database.



Thanks To...

Many thanks to everyone involved in the development and testing of ThumbsPlus. I would like 
to offer special recognition to:

Cricket, Adam, Rachel, Leah and Evan Crews, my wife and children, for putting up with me 
during the continuing development of ThumbsPlus.

Laura Shook, sister and Vice President, for her incredible devotion, unflagging support, and for 
being so wonderful to work with.

Jeff Hurley, Vice President, for his marketing savvy and much-needed attention to business 
details.

Hugh McArtan, for his late nights spent giving good adivce and answering thousands of e-mail 
messages.

Chuck Crews, brother and president of catalogue.com, who has maintained our World Wide 
Web server and tuned it to handle the flood of hits and downloads.

David Hanna, for excellent suggestions and great insight into what ThumbsPlus should become 
(and I hope it has!).

Tom Lane and the Independent JPEG Group. Many thanks for routines that are well-written, 
easy to understand, straightforward to implement, and were simple to integrate into ThumbsPlus.

Ray McVay and Mike Edgerton, of 'Go Graphics' for their continued support for ThumbsPlus. 
Thanks to Mike also for the diverse icons you have to choose from. (Select Properties from the 
File menu in Program Manager, then click on Change Icon to see them!)

The other members of the 'Go Graphics' Group who have also supported and encouraged us: 
Curt Bradshaw, Matt Drury, Bruce Herzog, Rollie Jones, Richard Lindner, John Parker, 
Tom Potocki, Tom Price,    Charlotte Smith, John Swenson, Howard Thue, Larry Wood and 
more.

Our overseas shareware and retail distributors: Pat O'Sullivan (Australia and New Zealand), 
Kenji Hino and Mr Nakamura at Village Center (Japan), Patrick Hochner at P&A Shareware 
(Japan), Hans Fremuth, Jupp and Franz Grieser at Kelly Data (Germany), Gerd Zottelein at 
PD Profi (Germany), Nick Thompson at The Thompson Partnership (UK), Daniel van Rooijen 
at CopyCats (Netherlands, Belgium).

Other people who have greatly encouraged or influenced ThumbsPlus: Joel Diamond, Ed 
Hoffman, Pat O'Sullivan, David Hanna, Brian Priebe, Ralph Mariano.

All of the beta testers, without whom many more bugs would have made it into the released 
product.

But, the most thanks are due to you. Without your dollars and support, we couldn't continue this 
interesting adventure!



Program Operation



Getting Started

The main window consists of the normal Windows interface (title bar, menus, etc.) and three 
functional areas, as shown below:

Click on the picture above (anywhere the cursor becomes a hand) to find out about the various 
parts of the display.

Additional information:

The toolbar provides short-cuts to several frequently-used commands.

The directory list displays disks and directories from which you may select a directory to 
display. Unless disabled from the Tree menu, directories are color-coded to indicate the presence 
of previously "nailed" images:

Selecting a directory works much like the Windows File Manager; most operations and menu 
short-cuts work similarly, and you can drag-and-drop selected files to move or copy them to 
different directories and drives.

When you select a directory from the directory list, file names (and thumbnails, if generated), 
display in the file list.

You may select one or more files from the file list, then take action on the selected image(s) from 
the toolbar or menus.

You may also drag the selected files to a new directory or disk.



Directory Color Codes

If the option to Indicate Thumbnails is on from the Tree menu, each directory folder is colored to 
indicate the presence of thumbnails on the path.

You may select the desired colors for folders using Options | Preferences • Colors.



Selected File

The captions (file names) of selected files are highlighted. Some toolbar and menu options will 
be grayed if no files are selected.



mainScrollbar

A scrollbar allows you to select the part of a list of items you want to display, when all of the 
items will not display in the area. For vertical scroll bars, click on the left and right arrows to 
move a column at a time; for horizontal scroll bars, click on the up and down arrows to move a 
line at a time.

You can drag the box to move proportionally within the scrolled data; you can click on either 
side of the box to move a full window of information at a time.



Selected Directory

The currently selected directory in the directory list is highlighted. This is the directory that 
contains the files in the file list.



Disk, Volume and Folder Icons

All disk drive in your system and all removable disks (floppies and CDROMs) that you have 
scanned for thumbnails are represented by small icons in the directory list.

Removable diskette, such as 3.5" and 5.25" floppies.

A local, fixed hard drive.

A network (remotely mounted) drive.

A CDROM drive.

A memory (RAM) disk, used only for temporary storage.

An off-line CDROM which has been scanned for thumbnails. You can view the 
thumbnails without having to insert the CDROM.

An off-line floppy or removable drive which has been scanned for thumbnails. You can 
view the thumbnails for these volumes without having to insert the floppies.

A network drive that was previously mapped but is not currently available.

(R) A ZIP file that is scanned like a directory by ThumbsPlus (based on the setting for 
Tree | Zip Files as Directories).



Disk Labels

Every disk or diskette used in DOS and Windows can have a volume label. If you want to keep 
track of files on multiple disks, it will be much less confusing (to you and to ThumbsPlus) if 
each disk is labeled uniquely. ThumbsPlus will use serial numbers instead if they are present. For 
read-only media (such as CDROMs), ThumbsPlus will synthesize a name based on the first 
character of all files in the root directory if it has neither a serial number or a label.



Vertical Split Bar

The cursor will change when over this area. You can press the left mouse button and drag the 
split bar to the desired position, so the directory and file lists are the sizes you want.



Maximize

This button maximizes ThumbsPlus (resizes it to fill the screen). You can click this button again 
to restore ThumbsPlus to its previous size.



Minimize

This button minimizes ThumbsPlus (reduces it to an icon). You can double-click the icon to 
restore ThumbsPlus.



Title Bar

This caption shows the current program (ThumbsPlus in this case), along with the file it has 
open.



System Menu

Selecting this button brings down the standard Windows system menu, from which you can 
move, size, restore, minimize, maximize, or close ThumbsPlus. You can also bring up the Task 
List (with the Switch To option) to switch to another application in Windows.



Status Line

The status line shows information about the currently selected drive, directory and files. It also 
shows the number of files in the directory.

When dragging to a directory, the text in the status line will turn red if there is insufficient space 
to copy the selected files.

When selecting from a menu or passing the mouse over toolbar buttons, a description of the 
action appears on the status line.

The status line may be turned on or off using the Window | Status Line menu selection.



Standard Dialog Boxes

Several dialog boxes are used in various places throughout the program, including:

Progress
Browse
Confirm
Confirm File Replacement



Progress Dialog Box

ThumbsPlus displays this dialog box when doing something that may take a while, or when 
processing multiple files. Any errors that occur display in the Errors Encountered area. For 
most operations, a Cancel button is available that will cancel the operation in progress. There is 
also a Background button which will minimize ThumbsPlus so that you can easily switch to 
another application. The title bar shows the activity in progress; directly below this appears 
additional information about the progress, such as the current directory or file name. There is 
also a percentage complete indicator (both numerical and graphed).

To receive more information about any error in the list, select it and then click the Help button or 
press F1. The error codes are also listed in this document.



Confirm Dialog

The Confirm dialog box displays whenever you perform a function that is set up to be confirmed; 
you may configure which actions require confirmation using the Options | Preferences • 
Confirmations dialog box. There's a convenient Yes to All button which allows you to avoid 
confirming each operation individually.

When a file would be replaced by an move or copy and confirmation for overwriting files is 
turned on, the Confirm File Replacement dialog will be used instead.



Confirm File Replacement

When a file move or copy operation would overwrite a file with the same name as the file being 
moved, ThumbsPlus will display this dialog box. Information and thumbnails (if available) for 
both the original and new files are shown.

The buttons available are:

Yes. Replace the original file with the new file. Keep asking if there are any more replacements.

No. Don't replace the original file with the new file. Keep asking if there are any more 
replacements.

Yes to All. Replace this original with the new file, and also replace any other duplicates that are 
encountered.

No to All. Do not replace this original, and do not replace any other duplicates encountered.

Yes to Newer. Replace this original and replace any other duplicates found as long as the file 
being moved is newer than the original. Files older than the originals will be skipped (and noted 
in the Progress box.

Yes to Same. Replace this original and replace any other duplicates found whenever the files are 
identical. Files that are different will be skipped.



Browse Dialog

Whenever ThumbsPlus requires a directory path, you can click on the Browse button to bring up 
this dialog box. From it, you simply select the desired directory path. ThumbsPlus also 
remembers the last place selected for each operation and initializes the dialog box for that 
directory. Some of the functions for which the Browse dialog box are available are:

File | Copy
File | Move
Picture | Batch Convert/Edit
Edit | Automatic Clipboard Save
Thumbnail | Contact Sheets



Toolbar

This is the default toolbar supplied with ThumbsPlus. You may customize the toolbar to your 
taste using Options | Customize Toolbar.

Click on any button below to see a description of its action.



Selecting Files

You select files from the file list (the area of the screen with thumbnails) by using the mouse or 
keyboard.

Using the Mouse to Select Files

You can use a mouse to select a file or group of files. Before you can select files, they must be 
visible in the file list.

To select a file:

Click the filename or thumbnail.

To select multiple items in sequence:

1. Click the first file you want to select.

2. Press the SHIFT key while you click the last file to select.

To select two or more file out of sequence:

Press and hold CTRL while you click on each file.

To cancel the selection of a file:

Press and hold CTRL while you click the selected file.

Using the Keyboard to Select Files

You can use the keyboard to select a file or group of files. Before you can select files, they must 
be visible in the file list.

To select a file:

Use the following keys to select a file or directory. 

Press To select

Up, Down A file above or below the current selection. 

End The last file in the list. 

Home The first file in the list. 

PageUp The file at the top of the previous screen. 

PageDown The file at the bottom of the next screen. 

To select two or more items in sequence:

1. Use the up or down arrows to move to the first file you want to select. 

2. Press and hold down SHIFT while you select the remaining files.

To select two or more items out of sequence:

1. Use the arrow keys to move to the first file you want to select.



2. Press and release Shift+F8. The selection cursor begins to blink.

3. Move to the next file you want to select.

4. Press the SPACEBAR to select each file.

5. Press Shift+F8 when you finish selecting files.

To cancel the selection of a file:

1. Press and release Shift+F8 so that the selection cursor begins to blink. 

2. Move to the selection you want to cancel, and then press the SPACEBAR. 

3. Press Shift+F8 when you finish canceling selections. 



Supported File Types

The list below shows the file types that ThumbsPlus supports. Items marked with (R) are 
available in the registered (-R) version only.

.AVI Video for Windows files

.BMP,.DIB,.RLE Windows Bitmap files

.CDR,.PAT,.BMF CorelDRAW, CorelGALLERY

.CEL AutoDesk Animator CEL files

.CGM Computer Graphics Metafile (binary encoding)

.CUR,.ANI Windows Cursor files

.DCX Multi-image PCX files

.DXF (R) AutoCAD Exchange format files

.EPS Encapsulated Postscript files (preview image only)

.FIF Fractal image files (Iterated Systems, Inc.)

.GEM GEM Metafiles

.GIF CompuServe Graphics Interchange Format files

.ICO Windows Icon files

.IFF,.LBM Amiga IFF format

.IMG GEM Image format

.JPG,.JFI,.JIF JPEG compressed files (in JFIF format)

.KDC Kodak DC40, DC50 digital camera native files

.KIZ Kodak Digital Postcard files

.MID Windows MIDI files

.MND,.MNI Mandelbrot for Windows image files

.MOV QuickTime Movies

.MPG (R) MPEG compressed movies

.PCX,.PCC ZSoft Picture files

.PCD Kodak PhotoCD files

.PFB (R) Adobe Type 1 Font files

.PNG PiNG format files

.PSD Adobe Photoshop files

.RAS,.SUN Sun Raster format

.RAW Raw grayscale or RGB images

.STX, .ST5, .ST6, .S
T7, .ST8

Santa Barbara Instrument Group (SBIG) files

.TGA,.WIN Targa TruevisionTM files

.TIF Tagged Image Format files

.TTF,.TTR TrueType fonts

.UUE UUencoded files

.WAV Windows sound files

.WMF,.MF Windows Metafiles and Placeable Metafiles

.WPG WordPerfect graphics files



AVI: Video for Windows

AVI is the standard Windows video format.

The registered version of ThumbsPlus supports playing, viewing, and thumbnailing (any frame) 
of Video for Windows files.

On Windows 3.1, Video for Windows version 1.1d or later must be installed to play AVI files.



BMP, DIB, RLE: Windows Bitmaps

This is the standard bitmap format supported by Microsoft Windows. ThumbsPlus supports all 
color depths (1, 4, 8 or 24 bit), and the compressed (RLE) formats for 4-bit (RLE4) and 8-bit 
(RLE8) bitmaps.

The standard VGA driver does not properly decompress 8-bit compressed BMP files; for best 
color viewing (and nicest thumbnails), you should load a 256-color or higher Windows video 
driver, which should eliminate this problem.

On Windows 3.1, some proprietary 8-bit drivers do not properly decompress 4-bit compressed 
files, though the situation is always improving, and this problem is becoming much less 
common.

ThumbsPlus currently writes only uncompressed BMP files.



CDR, PAT, BMF, CMD: CorelDRAW and CorelGALLERY

ThumbsPlus can create thumbnails for CDR, PAT and BMF files; however, it can only extract the 
preview bitmap from them. There is no internal support for the proprietary Corel format.

If you have Corel, you can set up CDR and PAT files for external OLE support (using the File 
Type Configuration dialog box), which will allow you to create much nicer thumbnails for them. 
However, the price is high: Corel is a very slow OLE server, so it takes much longer to create the 
thumbnails.

Corel files may also be viewed, printed, or copied to the clipboard as metafiles using the OLE 
support.

CorelGALLERY files (.BMF) can be viewed and thumbnailed via OLE also, as long as the Corel 
Gallery program itself is installed. As with the CDR files, OLE is considerably slower than the 
internal bitmap support.



CEL: AutoDesk Animator Cel Files

ThumbsPlus supports both the earlier and newer versions of .CEL files. The later version is a 
single-frame .FLC file.



CGM: Computer Graphics Metafile

CGM files are vector graphic files useful as clipart. They scale well, and have the distinction of 
being the only ANSI standard graphic format. There are many flavors of CGM files; ThumbsPlus 
supports the most popular for PCs (binary encoding), with the following limitations:

· Embedded cell arrays (bitmaps) are not supported.
· New (version 3) extensions, such as Bézier curves, are not supported.
· Font support is incomplete
· Rotated (non-orthogonal) ellipses and elliptical arcs are not correctly rendered.
· Hatches are rendered with the closest hatching format available from Windows.



CUR, ANI: Windows Cursor files

ThumbsPlus can create thumbnails for CUR and ANI files, though no viewing support is 
currently available. These files are supported only on Windows 95 and Windows NT 4.0.



DCX: Multi-image PCX files

The DCX format is a multi-page format for PCX files, generally generated by fax software. In 
particular, Intel's fax software produces DCX files.

Using the paging selections on the Edit menu selections, ThumbsPlus can view any of the images 
in a DCX file, and can split the pages into separate files.



DXF: AutoCADTM Exchange Format (R)

The DXF format is defined by AutoDesk, and is the format used for exchanging AutoCAD and 
other CAD system files. As opposed to the DWG format, which is proprietary and constantly 
changing, the DXF format is published and relatively stable.



EPS: Encapsulated Postscript

EPS files are Postscript language files, created for Postscript printers. ThumbsPlus can access 
only the preview image (which can be in either TIFF or Windows Metafile format).

Copying this format to the clipboard or otherwise saving or converting it only accesses this 
preview; the Postscript contents themselves are not accessed by ThumbsPlus.



FIF: Fractal Image files (Iterated Systems, Inc.)

FIF files are compressed using fractal compression, as patented and implemented by Iterated 
Systems Inc. ThumbsPlus can decode (read) these files; future support is planned for encoding 
them.



GEM: GEM Metafile

GEM Metafiles are vector graphic files which include drawing commands for rendering pictures. 
They are similar to, but less complete than, CGM files. GEM files originated on the Amiga, and 
have gone through several enhancement periods.

ThumbsPlus does not claim to support all GEM files at this time; fonts are not handled very well, 
and curve support is incomplete. However, the support is sufficient for most clip-art, the most 
common type of file stored in GEM format.



GIF: CompuServe GIF

The GIF format was developed by CompuServe, an on-line service, to provide good file 
compression and relatively fast decompression speed. GIF is a very popular format for online 
services, but is limited to a maximum of 256 colors.

Two standards have been developed: 87a and 89a. ThumbsPlus fully supports the 87a standard, 
and supports (for viewing) much of the 89a standard, including multiple images (GIF 
animations), text blocks and input extensions. Multiple images and other extensions are not 
supported on Windows 3.1, however.

ThumbsPlus can read and write interlaced and transparent GIF files. Transparency (for a specific 
color) is maintained when the image is saved. Note that if you modify the colors of the image, 
you'll most likely need to select a new transparency color. The topic GIF Save Options contains 
more information on saving GIF files.

ThumbsPlus cannot create or modify multiple-image GIF files, or GIF files with text or input 
extensions; only single-image GIF files can be written.

The LZW compression in GIF files is licensed under a patent from Unisys Corporation.



ICO: Windows Icons

ThumbsPlus supports Microsoft Windows icon files, which are associated with applications for 
display in Program Manager or alternate shell programs.

256-color icons are handled, but not well tested because of a general lack of availability of 256-
color icons.



IFF, LBM: Amiga and Deluxe Paint

The IFF format is an Amiga image storage format. LBM was created for the Deluxe Paint 
package, and is essentially the same. ThumbsPlus supports all known IFF and LBM formats 
except HAM and Dynamic HAM, which may be supported in the future.



IMG: GEM Images

The IMG format was originally designed for the Atari computers, then migrated to PCs for 
several GEM-based products, including Ventura Publisher. IMG files may also be embedded in 
.GEM metafiles.

ThumbsPlus supports reading of all known IMG types, but does not currently correct the aspect 
ratio for files with non-square pixels.



JPG, JIF, JFI: JPEG (JFIF) Files

The JPEG format was developed to provide a high degree of compression for images. It is a 
"lossy" compression method, meaning that some color information from the original is lost. 
When saving JPEG files, ThumbsPlus allows you to specify the intended quality of the image.

JPEG is generally appropriate for photographed or scanned images, and works best for 24-bit 
sources. JPEG is generally inappropriate for any type of line-drawn art.

The JFIF specification describes a standard way to incorporate JPEG images in disk files; only 
JFIF images are supported by ThumbsPlus. Some software (notably GIF2JPG, by Handmade 
Software), writes non-JFIF files which ThumbsPlus cannot handle.

ThumbsPlus incorporates the Independent JPEG Group's source code (release 6). This includes 
support for reading and writing progressive JPEG files.

Lossless JPEG is not currently supported. For lossless storage of 24-bit images, use TIFF, Targa, 
BMP, or PCX.

ThumbsPlus allows several loading options for JPEG files. When using a 256-color display, the 
JPEG file may be reduced to 256 colors during loading. This is not recommended if the image is 
going to be edited. See JPEG Load Options.

For more information on saving in the JFIF format, see JPEG Save Options.



KDC: Kodak DC40, DC50 Native Camera Images

KDC files contain the native image format for DC-40 and DC-50 Kodak cameras.



KIZ: Kodak Postcard files

Kodak postcards (KIZ) files are uuencoded HTML text and JPEG images. ThumbsPlus loads 
only the JPEG image contained in the file; the HTML and other information is ignored.



MID: Windows MIDI Music files

ThumbsPlus can play .MID files if you double-click them. The playing will cease when the 
MIDI file completes or you press the ESC key.

The thumbnail generated for .MID files is simply the icon of the application associated with 
them in File Manager or Explorer.



MND, MNI: Mandelbrot for Windows images

Mandelbrot for Windows is another Cerious Software product, which generates Mandelbrot set 
fractals. The files generated by this program may be thumbnailed and viewed in ThumbsPlus.

MNI files contain information about generating the image only, but may contain a preview 
bitmap. This preview can be extracted by ThumbsPlus from these files.



MOV: QuickTime for Windows

MOV is the standard Macintosh video format.

The registered version of ThumbsPlus supports playing, viewing and manual thumbnailing (from 
any frame) of QuickTime files.

Apple QuickTime for Windows must be loaded on the system to play MOV files. MOV files 
must be flattened to play on Windows. This means that the Macintosh resource and data file 
forks must be combined into a single file.



MPG: MPEG compressed video (R)

MPEG video files are compressed video files supported by many newer video cards and display 
drivers. ThumbsPlus requires an MCI-compliant MPEG driver to support these files; several are 
available on CompuServe, AOL or the Internet (i.e., SoftPEG). The best one we've seen is Xing 
Technologies' MPEG decoder.

As of this writing, these MPEG decoders do not provide MCI drivers: VMPEG, MpegPlay.



PCD: Kodak PhotoCD Images

Kodak PhotoCD files are a proprietary format developed by Kodak for photographic image 
storage. They are generally located on CD-ROM only, due to their extremely large size. They 
may be loaded at various resolutions.

ThumbsPlus can load at any of the following resolutions:

· Base/64 (96x64)
· Base/16 (192x128)
· Base/4 (384x256)
· Base (768x512)
· Base*4 (1536x1024)
· Base*16 (3072x2048)
· Base*64 (6144x4096)

ThumbsPlus can load as either Truecolor, 8-bit palette or as grayscale images. Use the Photo CD 
Loading options dialog box to select the desired size and color depth for loading PhotoCD files.

Encrypted and watermarked images are supported – ThumbsPlus will request the password when 
such an image is requested at an encrypted or watermarked size.



PCX, PCC: ZSoft Picture

PCX and PCC files are a fairly early PC graphic format, which has been extended over the years 
to support more and varied color depths.

The only known PCX format not supported by ThumbsPlus is 2-plane CGM files (4 color). 
These files may be supported in the future if there is sufficient interest.

ThumbsPlus does support 24-bit (3-planes x 8-bits per pixel) PCX files.

PCX files may or may not be compressed; ThumbsPlus always writes version 5, compressed 
PCX files, in the color depth of the current image.



PFB: Adobe Type 1 Font (R)

PFB files are Adobe Type 1 Font files. ThumbsPlus handles them similarly to TrueType fonts 
(TTF), and the same settings apply.

Note: PFB files are supported only on Windows 95.



PNG: PiNG format

PNG files are based a new graphics specification that provides for excellent lossless compression 
without any patented technology. Unlike GIF, which requires royalties to Unisys Corp., PNG is 
royalty free.

Only read support is currently provided for the PNG format, though write support will be added 
in a subsequent version.



PSD: Adobe Photoshop

PSD files are the native format used by Adobe Photoshop. There are various "flavors" of PSD 
files; ThumbsPlus can read most of them (as of Photoshop 2.5), with the following known 
limitations:

· Only the first channel of multi-channel PSD files is loaded (as grayscale).
· Duotone files are loaded as grayscale.

Version 3 Photoshop files are viewed and thumbnailed as they were last viewed in Photoshop. 
Version 2.5 compatibility mode must be set in Photoshop when saving the files (File | 
Preferences | General | More). Setting compatibility mode does not eliminate the availability of 
any version 3 features, but makes the files somewhat larger (to accommodate the extra image 
information).



RAS: Sun Raster

Sun Raster files are a popular image format for SUN UNIX systems. They can contain either 
color-mapped (256-color) or truecolor images.

Many packages write the colors reversed (Red for Blue, Blue for Red), without setting the 
appropriate flag in the header. You can use Image | Swap Red and Blue from to correct such files.



RAW: Raw Grayscale or RGB

ThumbsPlus can handle a wide variety of raw grayscale or RGB files, including:

· 8-bit grayscale
· 16-bit grayscale (Intel or Motorola byte order)
· 24-bit RGB (RGB or BGR order)
· 32-bit RGBA (RGBA, ARGB, BGRA or ABGR order)

ThumbsPlus can skip areas at the beginning or end of the file, and can replicate image scan lines 
(some medical imaging programs store only every other scan line). You use the Raw Loading 
Options dialog (Options | File Loading • Raw) to configure raw file types.

Note: In order for ThumbsPlus to recognize a file as a defined raw type, two criteria must be met:

1 The image information must be defined so that the file size matches the "expected file 
size" as described above.

2 The file extension must be defined (using Options | Preferences • File Types) as 
"equivalent to" the .RAW type.



STX, ST5, ST6, ST7, ST8: Santa Barbara Instruments Group

Santa Barbara Instruments Group manufactures and sells digital CCD cameras for astronomy. 
These formats are produced by the camera software. Both grayscale and color images can be 
loaded; for 16-bit grayscale, ThumbsPlus uses the range of pixels as last viewed or processed by 
SBIG software.

Note: The older .ST4 format files may be defined as 192 x 165 8-bit grayscale raw files, with a 
192 byte skip at the end of the file.



TGA, WIN: Targa TruevisionTM

ThumbsPlus supports 8-bit, 16-bit and 24-bit Targa files. The more recent Targa extensions 
(including the "Developer Area") are not yet supported, but planned for a subsequent release.

The alpha channel information not currently retained or processed.

ThumbsPlus saves TGA files at the appropriate color depth for the graphic; 4-bit (16-color) files 
are promoted to 8-bit Targa files.



TTF, TTR: TrueType fonts

ThumbsPlus can thumbnail, install, and remove TrueType fonts.

The default format of the thumbnail is to show the font name in the font itself. The text in the 
thumbnail may be changed using the TrueType Loading Options dialog box.

When installing and removing fonts, ThumbsPlus updates the WIN.INI file to reflected the added 
or deleted fonts. ThumbsPlus never deletes TTF files from the disk (unless, of course, you use 
File | Delete.



TIF: Tagged Image File Format

The Tagged Image Format was developed by several companies, including Aldus and Silicon 
Graphics, to be the be-all and end-all of image file formats. Because of its scope and 
extensibility, it is an extremely complex format which no single product can support completely.

The known TIFF formats not currently handled by ThumbsPlus are:

· Images in YCbCr (YUV) or proprietary color formats.
· Alpha channels (extra samples) are discarded when reading.

The following compression methods and special-interest formats are supported:

· Multi-image TIFFs (Using the paging selections on the Edit menu selections, 
ThumbsPlus can view any of the images in a multi-image TIFF file, and can split the 
pages into separate files.)

· Tiled TIFFs
· CCITT RLE, Group 3, and Group 4 Fax compression
· Packbits, Thunderscan and Next compression
· LZW compression
· Motorola (MM) format
· JPEG compression (post TIFF 6.0 format)
· ZIP "deflate" mode compression (experimental)
· CMYK TIFFs
· CIE L*a*b colorspace TIFF files
· 16-bit grayscale and 48-bit color TIFF files

ThumbsPlus writes uncompressed TIFFs, or compressed via CCITT Group 3 or 4 FAX, Packbits, 
JPEG, ZIP, or LZW.



UUE, 001: UUencoded graphics

UUE files are graphics which have been encoded for 7-bit transmission using the 'uuencode' 
method. These files are very popular on the Internet, especially in the Usenet Newsgroups. 
ThumbsPlus supports single and multi-part UUE files; multi-part files must have an extension 
indicating the part number (i.e., File.001, File.002, File.003). Only the .001 (or .UUE) file needs 
to be in the file list; the other parts will be automatically referenced when needed during 
decoding.

There are several loading options for UUE files, which include the capability to decode to a 
specific directory and to remove the original file. See Options | File Loading    • UUdecode.



WAV: Windows sound files

WAV files are the standard Windows sound format. ThumbsPlus can play them when they are 
double-clicked. You can stop playing by pressing ESC.

The thumbnail generated for WAV files is simply the icon of the application associated with them 
in File Manager or Explorer.



WPG: Word Perfect Graphics

WPG files are a vector (metafile) format that WordPerfect Corporation developed for use with its 
word processing products. Like other formats, WPG has evolved over the years.

ThumbsPlus supports both the original WPG (WPG1) and new (WPG2) formats for graphics; 
some charting and textual items aren't supported in WPG1, and the following are not supported 
in WPG2:

· Poly B-Splines.
· Complex polygons (components are rendered and filled separately).
· Object group rotation, skew, taper and translation.
· Text items are partially handled.
· Bitmaps are not rotated, skewed or tapered.
· Gradient fills are partially supported.



WMF, MF: Windows Metafile

The Windows Metafile format is the standard Windows format for storing vector and metafile 
graphics. It is quite powerful, as anything that can be drawn on the screen or printed on a printer 
can be stored in a metafile. It does, however, lack several rather rudimentary graphics primitives, 
such as Bézier curves and non-orthogonal ellipses.

ThumbsPlus can read and write Windows metafiles; vector graphics are also passed to and from 
the clipboard in this format.

Also, using OLE to load or thumbnail proprietary formats most often uses Windows Metafiles as 
the format for transfer of the picture of the file.



FIF End-User License

The license below applies to the files DECO_32.DLL and FIF.TXT.

END USER AND ROYALTY FREE DISTRIBUTION LICENSE AGREEMENT - FRACTAL IMAGE DECODER

REDISTRIBUTION PERMITTED ONLY IF PROGRAM AND FILES ARE NOT MODIFIED AND ALL FILES, INCLUDING 
THIS FILE, ARE INCLUDED.

GRANT: Iterated Systems, Inc. ("Iterated") hereby grants you a limited, nontransferable, terminable, non-exclusive license 
subject to the following to use its accompanying computer software product known as the Fractal Image Decoder (including the 
16-bit, 32-bit and Macintosh versions "Software") for individual use only on a Personal Computer described below.    You may 
place the Software on networks and online systems exclusively for the purpose of allowing downloading and copying of the 
Software for archival, distribution and installation purposes (but not for purposes of execution by the network or online system) 
provided any such copy must contain all of the original Software and text files including this License Agreement and any 
proprietary, license and copyright notices on the original.    This License Agreement only applies to the image compression 
decoder Software described above and does not grant any rights to any other Iterated software, even if related to the Software, 
including any software that encodes or compresses images in any way.

You may use the Software only on a single user Personal Computer that: (a) has one Intel 386, 486 or Pentium processor, 
Motorola 68036 or 68040 processor or IBM Power PC processor;    (b) operates only the Microsoft DOS and Windows operating 
system or the Macintosh operating system; (c) contains at least 4 megabytes of random access memory; (d) contains 80 
megabytes of internal hard disk storage; (e) contains a keyboard (not an infrared remote) and monitor (not a television set); (f) is 
able to produce printed output on a local printer; and (g) does not act as a server on any network (including a local area network, 
wide area network or Internet) or otherwise allow operation of the Software from a remote or separate computer or terminal 
("Personal Computer").    For the avoidance of doubt, and without limitation of the foregoing, "Personal Computer" does not 
include game players, television set-top boxes or so-called "Internet Appliances".

You may not permit other individuals to use, operate or copy the Software (except as permitted above).    You may not use or 
allow the use of the Software on any computer or other device that is not a Personal Computer (as defined above).    You may not 
modify, translate, reverse engineer, decompile, disassemble, (except to the extent applicable laws prohibit such restriction), or 
create derivative works based on the Software, copy the Software (except as specified above), rent, lease, transfer, license or 
otherwise transfer rights to the Software, or remove any proprietary notices, licenses, displays, installation procedures or labels 
on or in the Software, whether set forth in text files or on media. 

 DISCLAIMER OF WARRANTY: THE SOFTWARE IS LICENSED ON AN AS-IS BASIS, WITHOUT WARRANTY OR 
CONDITION OF ANY KIND AND ITERATED DISCLAIMS ALL WARRANTIES AND CONDITIONS, INCLUDING 
WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, AND NON-INFRINGEMENT.    The entire risk as to the quality and performance of the Software is borne by you.    
Should the Software prove defective, you and not Iterated assume the entire cost of any service and repair.    This Disclaimer of 
Warranty constitutes an essential part of the License Agreement.    SOME STATES DO NOT ALLOW EXCLUSIONS OF AN 
IMPLIED WARRANTY, SO THIS DISCLAIMER MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL 
RIGHTS THAT VARY FROM STATE TO STATE OR BY JURISDICTION.

LIMITATION OF LIABILITY: UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT, 
CONTRACT, OR OTHERWISE, SHALL ITERATED OR ITS SUPPLIERS, LICENSORS OR RESELLERS BE LIABLE TO 
YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF 
ANY TYPE INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, LOSS OF DATA, OR ANY AND ALL OTHER COMMERCIAL DAMAGES 
OR LOSSES.    IN NO EVENT WILL ITERATED BE LIABLE FOR ANY DAMAGES IN EXCESS OF ITERATED'S LIST 
PRICE LICENSEE FEE FOR THE SOFTWARE, IF ANY, EVEN IF ITERATED SHALL HAVE BEEN INFORMED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.    SOME STATES DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND 
EXCLUSION MAY NOT APPLY TO YOU.

TITLE:        Title, ownership rights, and intellectual property rights in and to the Software shall remain in Iterated and/or its 
licensors or suppliers.    The Software is protected by copyright laws of the United States and international copyright treaties.    
You are permitted to use only one copy of the Software, even if you receive multiple copies, whether via download or on 
magnetic media.    Title, ownership rights, and intellectual property rights in and to the content accessed through the Software is 
the property of the applicable content owner, and may be protected by copyright or other applicable law.    This License gives you 
no rights to such content.

TERMINATION:        This License will terminate automatically if you fail to comply with the limitations described above.    On 
termination, you must destroy all copies of the Software and documentation.

MISCELLANEOUS:      This Agreement represents the complete agreement concerning this license between the parties and 



supersedes all prior agreements and representations    between the parties.    This    Agreement may be amended only by a writing 
executed by both parties.    THE 

ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL    ON YOUR 
ASSENT TO THE TERMS SET FORTH HEREIN, AND NOT THOSE CONTAINED IN YOUR PURCHASE ORDER.    If any 
provision of this Agreement is held to be unenforceable for any reason, such provision shall be reformed only to the extent    
necessary to make it enforceable.    This Agreement shall be governed by and construed under Georgia substantive law as such 
applies to agreements between Georgia residents entered into and performed within Georgia, except as governed by United States 
Federal law.    You consent to the jurisdiction of the state and federal courts in the State of Georgia, U.S.A. The application of the 
United Nations Convention on Contracts for the International Sale of Goods is expressly excluded.

U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and documentation are provided with RESTRICTED RIGHTS.    
Use, duplication, or disclosure by or for the U.S. Government is subject to restrictions set forth in DFARS 252.227-7013 (c)(1)
(ii), FAR 52.227-19, and Clause 18-52.227-86(d) of NASA Supplement to the FAR, as applicable.    Contractor/manufacturer is 
Iterated Systems, Inc., 3525 Piedmont Road, Seven Piedmont Center, Suite 600, Atlanta, Georgia, U.S.A. 30305-1530.
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Keyboard - Main Window

TAB - Switch between the directory list and the file list.

You may press the first letter of a directory or file name to jump to the first name in the directory 
or file list (beyond the current position) with that name. Continue pressing the same letter to 
jump to other files beginning with that letter.

See also: Selecting Files for more information on the keyboard interface for selecting files.

Menu accelerator keystrokes:

Shift+Ctrl+C Edit | Auto Clip Save
Ctrl+C Edit | Copy
Ctrl+V Edit | Paste
Ctrl+K Edit | Select All
Shift+Ctrl+M Edit | Select Mask
Shift+Ctrl+A Edit | Clear All
Ctrl+Enter Picture | Batch Convert/Edit
F5 File | Copy
Ctrl+F5 File | Create Directory
Ctrl+Shift+F6 File | Delete Directory
Delete File | Delete
Shift+Enter Picture | Edit
F6 Picture | Properties
Shift+F6 File | Install Font
Ctrl+L File | Label
Shift+F5 File | Move
Ctrl+N File | New Database
Ctrl+O File | Open Database
Shift+F9 File | Print Catalog
Ctrl+F9 File | Page Setup
F9 Picture | Print
Ctrl+F6 File | Remove Fonts
Ctrl+Shift+F5 File | Rename
F8 Picture | Slide Show
Enter Picture | View
F7 Picture | Center Wallpaper
Ctrl+F7 Picture | Remove Wallpaper
Shift+F7 Picture | Tile Wallpaper
F1 Help | Contents
Ctrl+F1 Help | Search
Shift+Ctrl+D Options | Save for Startup | Directory Path
Shift+Ctrl+E Options | Save for Startup | Initial Database
Shift+Ctrl+P Options | Save for Startup | Window Position
Shift+Ctrl+L Window | Status Line
Ctrl+B Window | Toolbar
Shift+F1 Thumbnail | Update All



F2 Thumbnail | Make
F3 Thumbnail | Refresh
Ctrl+DELETE Thumbnail | Remove Orphans
Shift+Ctrl+DELETE Thumbnail | Remove Tree
Shift+DELETE Thumbnail | Remove
Ctrl+F2 Thumbnail | Scan Drive
Shift+Ctrl+F2 Thumbnail | Scan Tree
Ctrl+- Tree | Collapse all
/ Tree | Collapse to Path
- Tree | Collapse
* Tree | Expand Branch
+ Tree | Expand One Level
Ctrl+X Tree | Indicate Expandable
Shift+Ctrl+I Tree | Indicate Thumbnails
Ctrl++ Tree | Refresh Tree
Shift+Ctrl+F Tree | Show Offline
Shift+Ctrl+O Tree | Show Thumb Dirs Only
Shift+Ctrl+Z Tree | Show Zip Files as Dirs (R)

F4 Window | Show All
Shift+F4 Window | Close All
Ctrl+ F4 Window | Minimize All



Main Window Menus

File 
Edit 
Tree 
Picture 
Thumbnail 
Options 
Window 
Help



File Menu

New Database… Ctrl+N
Open Database… Ctrl+O
Copy… F5
Move… Shift+F5
Rename… Ctrl+Shift+F5
Delete… Delete
Create Directory… Ctrl+F5
Delete Directory Ctrl+Shift+F6
Label Disk Ctrl+L
Install Fonts Shift+F6
Remove Fonts Ctrl+F6
Print Catalog… Shift+F9
Register ThumbsPlus…
Exit Alt+F4



File | New Database Ctrl+N

If you have a lot of graphics files, you may want to organize them into separate databases. This 
option allows you to create a new database.

Use this option to create a new thumbnail database. There are several options you can set for the 
database, including the size of the thumbnails and their color depth. Note that larger (and more 
colorful) thumbnails require more disk space. The default of 96x72 pixels at 8-bit (256) color is 
fairly efficient. Increasing the size to 120x120 with 15-bit (32768) color will increase the 
thumbnail database size considerably.



File | Open Database Ctrl+O

If you have a lot of graphics files, you may want to organize them into separate databases. This 
option allows you to select another database to open.

ThumbsPlus databases have the extension ".TDB". Each of these databases has an associated 
option (INI) file, with the extension ".TDO".

ThumbsPlus can only one a single database at a time, though you can run ThumbsPlus multiple 
times, each time with a different (or the same) database.

You can specify the database for ThumbsPlus to use on the command line, from Program 
Manager. You can also double-click on .TDB files from File Manager or Explorer to bring up 
ThumbsPlus with a specific database.

To create a new database, use the File | New Database menu option.



File | Delete DELETE

Deletes the selected file(s). If confirmation of file deletion is selected from the Options | 
Preferences • Confirmations dialog box, you will be prompted whether or not to delete each file.



File | Copy F5

Prompts for the desired directory to copy the selected files to, and copies them there. Alternately, 
you can drag the selected files to the intended directory. To force copying (rather than moving, 
which is the default when dragging files to a directory on the same disk), you can hold down the 
CTRL key while dragging.



File | Install Fonts Shift+F6

This option is available if the first file selected is a TrueType font. It installs any selected fonts 
that are not already installed, and updates the WIN.INI file so they will be available the next time 
Windows starts.



File | Remove Fonts Ctrl+F6

Any selected TrueType fonts that are currently installed will be removed, and removed from the 
WIN.INI file. Be sure the first selected file is a TrueType font so that this selection will be 
available.



File | Label Disk Ctrl+L

Use this selection to create a volume label for a diskette. ThumbsPlus cannot keep track of which 
diskette contains which files unless they are labeled.



File | Move Shift+F5

Prompts for the desired directory to move the selected files to, and moves them there. If the 
directory is on another disk, this will copy each file, then delete the original. Alternately, you can 
drag the selected files to the intended directory. To force moving (rather than copying, which is 
the default when dragging files to a different disk), you can hold down the SHIFT key while 
dragging.



File | Rename Ctrl+Shift+F5

Prompts for a new file name for each selected file, and renames it accordingly. You cannot move 
a file to a different directory with this option; use File | Move instead.



File | Create Directory Ctrl+F5

Prompts for a directory name to create as a sub-directory for the current directory (selected in the 
Directory List).

Note that since it has no thumbnailed files in it, this new directory will not be visible in the 
directory list unless Tree | List Thumb Dirs Only is not checked.



File | Delete Directory Ctrl+Shift+F6

This selection removes the current directory, any files in it, and any sub-directories. You will be 
prompted to confirm if there are files within the directory, or within any sub-directories. 
ThumbsPlus is nice and simply removes the directory if it is empty!



File | Print Catalog Shift+F9

This selection prints a catalog of the thumbnails in the database. There are many configuration 
options divided among the tabs in the Catalog Options dialog box. Each of these tabs is 
described below.

 •      Printer  
 •      Layout  
 •      Header & Footer  
 •      Fonts  
 •      Options  



printerFile | Print Catalog • Printer

Use the Name field to select the printer you desire. If you want to print to a file that can be 
copied to the printer later, select Print to File. To edit the properties specific to the printer (i.e., 
page orientation, page size, color and dithering options), click on the Properties button.



File | Print Catalog • Layout

Use this tab to determine the layout on the page of the catalog.

Margins. Select the left, right, top and bottom margins.

Units. Select the desired units (inches, centimeters or pixels).

Thumbnail Size (units). Selects the size of thumbnails to print, in inches, centimeters or pixels 
(based on Units).

Columns. Selects the number of columns of thumbnails to present.

Line Spacing. Selects the spacing (in units) between lines of thumbnails or text.



File | Print Catalog  •  Header & Footer

Use this tab to enter a header and footer for the catalog. Each may be multiple lines, and may 
contain the following tokens that ThumbsPlus will use to substitute the appropriate value:

\p Page number.

\d Date

\t Time



File | Print Catalog • Fonts

Use this tab to select the typefaces and text colors for the catalog printout. You can select 
separate fonts for the header and footer, directory entries, and thumbnail captions.



File | Print Catalog • Options

The Options tab provides several choices for the contents of the catalog.

Include with thumbnails. Select the information about the thumbnails to include in the catalog.

Which files to include. Choose which files to include in the catalog.

Print heading for each directory. If this item is checked, then ThumbsPlus will print a heading 
for each directory printed in the catalog. This heading will contain the volume and directory 
names.

New page for each directory. Check this option to cause ThumbsPlus to start a new page for 
each directory or sub-directory.

Rebuild thumbnails at printer resolution. Check this option for high-resolution thumbnails, 
which take longer to generate (the disk files must be read and reduced to the proper size), but are 
much higher quality.

Automatically crop images. Causes ThumbsPlus to automatically crop images before making 
the thumbnails. This removes excess single-color borders from images.



File | Register ThumbsPlus

Use this selection to fill out an order form for ThumbsPlus that you can print to mail or fax to 
Cerious Software, Inc. Additional ordering information is available here in the help file.



File | Exit Alt+F4

Select this option to exit ThumbsPlus



Edit Menu

Copy Ctrl+C
Paste Ctrl+V
Select All Ctrl+A
Clear All Ctrl+Shift+A
Select Mask Ctrl+Shift+M
Auto Clip Save… Ctrl+Shift+C
Export Selected…



Edit | Copy Ctrl+C

This option copies the first selected file to the clipboard in the appropriate format for the file for 
raster images or metafile for vector images).

If no files are selected, this menu option is grayed.

You can make this option the default (double-click) option from the General Options dialog box.



Edit | Paste Ctrl+V

This option pastes the current clipboard contents to a ThumbsPlus View Window. If the 
clipboard is empty, or the contents are not in a recognized graphics format, this options is grayed.



Edit | Clear All Ctrl+A

This option deselects all selected files in the file list.



Edit | Select All Ctrl+Shift+A

This option selects all files in the file list for processing by any of the commands which accept 
multiple files, such as view, properties or slide show.



Edit | Select Mask Ctrl+Shift+M

This option prompts for a filename mask (i.e., "A*.GIF") and selects all files matching the mask. 
Any previous selection(s) are cleared.



Edit | Auto Clip Save Ctrl+Shift+C

This selection allows you to automatically save the clipboard contents to a disk file each time 
they change (and a compatible format -- bitmap or metafile -- is on the clipboard).

This is very useful for window or screen capture, too -- turn it on, and each time you press 
PrintScreen (for the entire screen) or Alt+PrintScreen (for the current window), ThumbsPlus will 
save the screen or window as a graphic file.

Enable. When checked, automatic clipboard saving is enabled. The Auto Clip Save menu 
selection is also checked when enabled.

Convert metafiles. When checked, metafiles on the clipboard will be rasterized and saved; 
otherwise, they will be saved as Windows metafiles (.WMF).

Image File save format. Select the desired file type to save.

Output Path. Select the directory where you want the auto-saved files to be stored. The Browse 
button allows you to find a directory easily.

Prefix. Enter a prefix for the file name. Use less than 8 characters; whatever is left will be filled 
in with a sequence number. For example, if you enter SCRN here, and select BMP as the type, 
the files will be saved as SCRN0000.BMP, SCRN0001.BMP, etc.

Seq. This is the next sequence number to use in the generated file names.



Edit | Export Selected

This option creates bitmap files of all currently selected thumbnails. The files are 96 x 72 pixels, 
8-bit color (236 colors used), and stored in Windows Bitmap (BMP) format with a .TNB 
extension and the same name as the original file. You will be prompted for a destination directory 
for the thumbnail files.

The files created with this option may be renamed or converted to other types. You can select the 
".TNB" file type in the File Types dialog box as equivalent to BMP files so they may be viewed, 
renamed or converted in ThumbsPlus.



Tree Menu

Expand One Level +
Expand Branch *
Collapse Branch -
Collapse All Ctrl+/
Collapse to Path /
Refresh Tree Ctrl++
Indicate Expandable Ctrl+Shift+X
Indicate Thumbnails Ctrl+Shift+I
List Thumb Dirs Only Ctrl+Shift+O
Show Offline Volumes Ctrl+Shift+F
Zip Files as Directories Ctrl+Shift+Z



Tree | Expand One Level

This option expands the currently selected directory entry in the Directory List by showing any 
sub-directories. Double-clicking an expandable entry also performs this action.

If Indicate Expandable is checked, the folders for directories which have sub-directories are 
marked with a '+'.

If Indicate Thumbnails is checked, directories are color-coded to indicate the presence of 
thumbnails.



Tree | Expand Branch *

This option expands the currently selected directory entry in the Directory List by showing any 
sub-directories. Any sub-directories are also expanded, thereby showing this "branch" of the tree 
in its entirety.

If Indicate Expandable is checked, the folders for directories which have sub-directories are 
marked with a '+'.

If Indicate Thumbnails is checked, directories are color-coded to indicate the presence of 
thumbnails.



Tree | Collapse Branch -

This option hides any subdirectories of the currently selected entry. Double-clicking on an 
expanded entry also does this.

If Indicate Expandable is checked, the folders for directories which can be collapsed are marked 
with a '-'.



Tree | Collapse All Ctrl+-

Hides all directories, leaving only the top level (drive and off-line volume) entries.



Tree | Collapse to Path /

This option collapses all entries except those directories on the currently-selected path. For 
example, if the current directory is C:\WINDOWS\SYSTEM, all entries for drives other than C 
are hidden, all first-level directories of C: are shown, and all sub-directories of WINDOWS are 
shown.



Tree | Refresh Tree Ctrl++

This option rereads the directory tree. Use this option if you change the directory structure from 
another application. This option also collapses the tree to the current path (Tree | Collapse to 
Path).



Tree | Indicate Expandable Ctrl+Shift+X

Checking this menu item causes ThumbsPlus to display a '+' in directory entries which contain 
sub-directories and may be expanded, or '-' in directory entires which are already expanded.



Tree | Indicate Thumbnails Ctrl+Shift+I

Checking this option causes ThumbsPlus to use differently colored folders to indicate 
"interesting" directories. Folders for directories which contain thumbnails are colored green; 
folders for directories which do not themselves have thumbnails, but whose subordinate 
directories do, are colored blue. This option is really useful only after drive(s) have been scanned 
for images (see Scan Drive).



Tree | List Thumb Dirs Only Ctrl+Shift+O

Select this option to only show directories which contain thumbnails. This is only useful once 
graphics files have been located (usually by Scan Drive).



Tree | Show Offline Volumes Ctrl+Shift+F

Select this option to display disks which have been scanned but are not currently on an inserted 
disk. This will display each such volume as a small diskette, with the disk label next to it. For 
this option to operate properly, it is important that each diskette have a unique label. This options 
works for CDROMs as well as diskettes.

This option will also allow you to view directories and files which have thumbnails, but have 
been removed from the disk by a program other than ThumbsPlus. The folders for these 
directories, and the names for these files, will be grayed. If you do not intend to restore these 
files to the disk, you can use Thumbnail | Remove or Thumbnail | Remove Tree to remove the 
thumbnails from the database.



Tree | Zip Files as Directories (R) Ctrl+Shift+Z

This option, available only in the registered release, causes ThumbsPlus to treat ZIP (PKZIP-
compatible) files as directories. You can thumbnail, view, print, catalog and process files within 
ZIP files just as if they were in normal directories.

Note that ThumbsPlus currently only reads from the ZIP files. Update support is planned for a 
future release.



Picture Menu

View Enter
Edit Shift+Enter
Properties F6
Batch Convert/Edit Ctrl+Enter
Slide Show F8
Annotate… Ctrl+E
Assign Keyword Ctrl+K
Find… Ctrl+F
Center Wallpaper F7
Tile Wallpaper Shift+F7
Remove Wallpaper Ctrl+F7
TWAIN Acquire…
TWAIN Select Source…
Page Setup Ctrl+F9
Print… F9



Picture | View ENTER

Opens a view window for each of the currently selected files, up to the maximum specified in the 
Options | Preferences • General dialog box. This option will be grayed if no files are selected.

From the Options | Preferences • General dialog box, you can selecting Viewing as the default 
(double-click) action for files.



Picture | Edit Shift+ENTER

Edits the first selected file by launching the editor defined for its file type.

From the Options | Preferences • General dialog box, you can selecting Editing as the default 
(double-click) action for files.



Picture | Properties F6

This option displays an information window for the first selected file. There are several tabs, as 
shown below:

 •    Physical
 •    Details
 •    Database
 •    Keywords



Picture | Properties • Physical

This tab in the Picture Properties dialog box shows physical file characteristics as stored on the 
disk or in a ZIP file.



Picture | Properties • Details

This tab in the Picture Properties dialog box shows detail information about the file (such as size 
in pixels, color depth, etc.)



Picture | Properties • Database

This tab in the Picture Properties dialog box shows information stored in the database about the 
file. You can also edit the annotation stored with the file.



Picture | Properties • Keywords

This tab in the Picture Properties dialog box shows the keywords associated with the file in the 
database. You can use the New button to associate new keywords with the file, and the Delete 
button to remove keyword associations.



Picture | Batch Convert/Edit Ctrl+ENTER

With ThumbsPlus, you can convert and edit (in a single pass) many files in the background while 
you continue to work on other things (even start another copy of ThumbsPlus) This option 
displays a dialog box, which you use to control the batch process. Once you've made the 
selections and press the OK button, ThumbsPlus will prompt you for any options for the specific 
output format you've chosen, including comment fields and compression options.

You must select the files you wish to process before selecting this option. See Selecting Files for 
more information on how to select specific files. Each option in the dialog box is discussed 
below.

Output Format. Select the output format for the files. ThumbsPlus will save each file in this 
format. If you select a metafile format, such as WMF, then the image editing options will be 
disabled, and only metafiles will be processed. If you select the WMF (encapsulated bitmap) 
format, ThumbsPlus will generate a metafile containing the bitmap -- it will not trace the bitmap 
to obtain a vector representation.

Alternate Extension. If you want the output files to have an extension different from the one 
selected in the Output Format, the enter it here.

Filter (R). Check this box to enable digital image filtering of each image. Click on the button to 
use the Filter dialog box to select and configure the filter to use. ThumbsPlus displays a 
description of the filter to the right of the button.

Misc. Brings up the Miscellaneous Batch Operations dialog box, which allows you to select the 
size for converting metafiles to bitmaps, and various miscellaneous functions such as autocrop, 
flip, and histogram equalization.

Resize. Check this box to enable rotation and/or resizing of each image. Click on the button to 



use the Rotate/Resize dialog box to set the options. ThumbsPlus displays a description of the 
action to be taken on the right of this button. If you rotate and resize, you may want to select an 
output Color Depth (below), as files are promoted to either 24-bit (truecolor) or 8-bit grayscale 
for proper rotation and resizing.

Color. Check this box to enable color adjustment of each image. Click on the button to use the 
Color Adjustment dialog box to set the amount of brightness, contrast, gamma and hue 
adjustment to apply to each image.

Color Depth. Use this selection to specify the output color depth, just as you would for an 
individual image. The Image | Color Depth dialog box will allow you to specify the number of 
colors you desire, the palette you want to apply (even one pasted from the clipboard!), and the 
type of dithering.

Output Path. Specify here the disk and directory you wish to send the converted and edited files 
to. You can use the Browse button to locate a directory you want to use.The files will be named 
the same as the input, except that the appropriate extension (default, such as BMP, JPG, or TGA, 
or specifically set in the Alternate Extension) will be used.

Overwrite Existing Files. Check this box if you want ThumbsPlus to overwrite files of the same 
name. If this box is not checked, and ThumbsPlus encounters an output file already there, it will 
skip that input file and display a message in the "Errors Encountered" area in the progress dialog 
box.



Batch Convert/Edit | Miscellaneous Batch Operations

This dialog box allows you to select various image operations that you can do from the View 
window menus.

Metafile Rasterization. These items are used when a metafile or vector graphic is converted to a 
bitmap. They are the same items requested from the Image | Convert to bitmap menu option.

Width - The width of the bitmap to create from the metafile. 

Height - The height of the bitmap to create from the metafile.

Maintain Aspect Ratio - Force the bitmap to be the same aspect ratio as the original 
metafile.

Autocrop. All same-colored borders from the image are removed. This option works only for 
bitmap (raster) images with solid borders. The lower-left corner pixel is used as a reference pixel 
-- all contiguous border of this color is cropped from the image. This function is done 
individually from the Edit | Autocrop menu selection in a view window.

Invert. Replaces each pixel in the image with its inverse -- black becomes white, red becomes 
green, etc. (See Image | Invert.)

Swap Red & Blue. Swaps the red and blue value of each pixel. This is required for some file 
types for which the RGB order is ambiguous or incorrectly reported in the file header. (See 
Image | Swap Red & Blue.)

Flip Horizontally. Replaces the image with a mirror image (left-to-right). (See Image | Flip 
Horizontal.)

Flip Vertically. Replaces the image with a mirror image (top-to-bottom). (See Image | Flip 
Vertical.)

Equalize Histogram (R). Computes an intensity histogram and equalizes (as much as possible) 
the intensity levels in the image. This improves the appearance of some images, but may give 
others too much contrast. See Image | Histogram for more information.



Picture | Slide Show F8

Displays the selected images one at a time, in full-screen mode, with a delay between images. 
Press any key or the left mouse button to end the slide show. You can configure the slide show by 
selecting Options | Slide Show.



Picture | Annotate Ctrl+E

Use this selection to enter or change a comment in the database about the file. The file must have 
a thumbnail to be able to save an annotation. The annotation may also be entered, viewed and 
edited using Picture | Properties • Database.



Picture | Assign Keyword Ctrl+K

Use this selection to assign a keyword to the selected file or to multiple selected files. You may 
either select an entry from the drop-down list or type a new keyword.

You may search for images using the keywords you have assigned by using the Picture | Find 
selection.

You can have ThumbsPlus automatically assign some keywords using Options | Preferences • 
Keywords.



Picture | Find Ctrl+F

Use this selection to search for pictures based on keywords that were automatically or manually 
assigned. You may enter or select up to three keywords and a match method (All, Any, Most). 
Then, click on the Find button to show the number of matches. Click on Show to replace the 
current file list with the matching thumbnails.

For convenience, the directory list remains visible; you may drag files from the matched list to 
directories as always.

To manually assign keywords, select the pictures to assign and use Picture | Assign Keyword. For 
ThumbsPlus to automatically assign keywords (based on image type, name and color 
information), see Options | Preferences • Keywords.

Note: Selecting Find or Show when no keywords are entered will show all thumbnails in the 
database.



Picture | Center Wallpaper F7

This option installs the first selected file in the file list as the Windows wallpaper on the desktop. 
If the file is not a Windows bitmap file, or if it is not on a local hard drive, it is converted to a 
bitmap and copied to a temporary file, which is installed.

This option centers the bitmap on the screen, and is recommended for large images.



Picture | Tile Wallpaper Shift+F7

This option installs the first selected file in the file list as the Windows wallpaper on the desktop. 
If the file is not a Windows bitmap file, or if it is not on a local hard drive, it is converted to a 
bitmap and copied to a temporary file, which is installed.

This option tiles the screen with the bitmap, and is recommended for small images.



Picture | Remove Wallpaper Ctrl+F7

This options removes the Windows desktop wallpaper.



Picture | TWAIN Acquire (R)

This selection will acquire one or more images from the currently selected TWAIN data source. 
You must have TWAIN software from your scanner, camera, or other TWAIN data source vendor 
to use this option.

You will most likely receive a dialog box that lets you preview, crop and set-up the scanner. 
ThumbsPlus does not provide support for any scanners which are not TWAIN compliant.

If you have multiple TWAIN sources, you can use File | TWAIN Select Source to select the 
particular source you wish to use.

ThumbsPlus is currently compatible only with 32-bit TWAIN sources. Please contact your 
scanner or camera manufacturer for 32-bit TWAIN data source drivers.



Picture | TWAIN Select Source (R)

Use this option to activate the TWAIN Data Source Manager (DSM), from which you may select 
the desired TWAIN source (generally a scanner, camera or other input device).



Picture | Page Setup Ctrl+F9

This dialog box allows you to customize the printing of individual graphics files.

Margins. Set the top, left, right and bottom margins on the page (in inches).

Stretch image to fit page. Will cause ThumbsPlus to stretch the images to fill the printed page 
(within the margins).

Maintain aspect ratio. When selected, ThumbsPlus will ensure that the width and height 
maintain the ratio in the original image, to avoid distortion.

Print Borders. Causes ThumbsPlus to draw a simple black rectangle around the edge of the 
image.



Picture | Print F9

This selection prints all selected graphics files. Each prints on a separate page, with no textual 
information. You can set the margins and other options using the Page Setup dialog box. To print 
a catalog of thumbnails, use the Print Catalog menu option.



Thumbnail Menu

Make F2
Update All Shift+F2
Scan Drive Ctrl+F2
Scan Tree Shift+Ctrl+F2
Remove Shift+Del
Remove Tree Shift+Ctrl+Del
Remove Orphans Ctrl+Del
Contact Sheets Ctrl+F9



Thumbnail | Make F2

This option does the hard work of ThumbsPlus: it reads the graphic files selected in the Image 
List and reduces them to create thumbnails, and stores the thumbnails in the ThumbsPlus 
database. These miniature pictures of your graphics files make life with Windows easier by 
helping you find specific images or drawings quickly and easily.

To create or update thumbnails for all files in the current directory, use the menu option 
Thumbnails | Update All. To scan a disk drive for all recognized files, use Thumbnails | Scan 
Drive.

Unlike these other options, Thumbnail | Make does not check for updated files and always 
makes thumbnails, regardless of whether one is already on file.



Thumbnail | Update All Shift+F2

This option creates or updates thumbnails for all recognized files in the current directory. If a 
thumbnail already exists for a file, its update date and time are checked against what is stored in 
the ThumbsPlus database. If the file has been modified since the thumbnail was made, it is 
regenerated from the file.

While running, a progress box displays which indicates how much of the work is complete. Click 
Cancel to quit making thumbnails. This progress box also contains a list box where any errors 
which occur are listed. These errors include the file name being "nailed" at the time of the error. 
If any errors occur, the progress box will remain until you click OK.



Thumbnail | Scan Drive Ctrl+F2

When you select Scan Drive, ThumbsPlus examines all files on the current drive looking for 
files that it recognizes and creates a thumbnail for each of them. If a thumbnail already exists for 
a file, its update date and time are checked against what is stored in the ThumbsPlus database. If 
the file has been modified since the thumbnail was made, it is regenerated from the file.

While running, a progress box displays which indicates how much of the work is complete. This 
progress indicator is based on the total space in use on the drive, and is updated by the size of 
each file as it is examined. Since graphics files are usually grouped together, and different types 
of files take various amounts of time to analyze and reduce, this indicator does not really indicate 
the amount of progress made in time, but only how far through the disk ThumbsPlus has looked.

Click Cancel in the progress box to quit making thumbnails. This progress box also contains a 
list box where any errors which occur are listed. These errors include the file name being 
"nailed" at the time of the error. If any errors occur, the progress box will remain until you click 
OK.

Note that most CD-ROM disks have useless "total size" information stored on them, so the 
progress percentage is essentially meaningless for these drives. 



Thumbnail | Scan Tree Ctrl+Shift+F2

When you select Scan Tree, ThumbsPlus examines all files in the current directory and any of its 
sub-directories.

While running, a progress box displays which indicates how much of the work is complete. This 
progress indicator is based on the total space in use on the drive, and is updated by the size of 
each file as it is examined. Since graphics files are usually grouped together, and different types 
of files take various amounts of time to analyze and reduce, this indicator does not really indicate 
the amount of progress made in time, but only how far through the disk ThumbsPlus has looked.

Click Cancel in the progress box to quit making thumbnails. This progress box also contains a 
list box where any errors which occur are listed. These errors include the file name being 
"nailed" at the time of the error. If any errors occur, the progress box will remain until you click 
OK.



Thumbnail | Remove SHIFTDELETE

This menu selection removes all thumbnails that are selected. This option does not delete the 
corresponding files.



Thumbnail | Remove Tree Ctrl+Shift+DELETE

This option removes all thumbnails for the current directory tree selected in the Directory List. 
The corresponding files are not deleted.



Thumbnail | Remove Orphans Ctrl+DELETE

This selection will remove any "orphaned" thumbnails (those for files that have been deleted 
from another program) in the current directory tree or the current drive.

Orphaned thumbnails may also be removed automatically whenever you change to a directory by 
checked "Automatically remove orphans" in the Options | Preferences • General dialog box.

Some users prefer that orphans remain for removed files, especially those that have been 
archived.



Thumbnail | Contact Sheets

ThumbsPlus will generate contact sheets (graphic files containing thumbnails) either from 
thumbnails already in the database or from the original files themselves.

There are many configuration options that you can set; these are covered in the various tabs 
shown below.

 •    Output
 •    Background & Borders
 •    Layout
 •    Header & Footer
 •    Fonts
 •    Options



Thumbnail | Contact Sheets • Output

Directory for output. Select the directory for the contact sheets. Use the Browse button to find 
one.

File name or prefix. When a single sheet is selected, this field is used as the complete file name. 
When multiple sheets are created, this field is used as the file prefix, and a sequence number 
(001, 002, etc.) is appended.

Overwrite existing files. If this option is selected and the file already exists, it is overwritten.

Image size. Select a size (in pixels) for the contact sheets. Several standard choices are provided, 
or you may define a custom size.



Thumbnail | Contact Sheets • Background & Borders

Background. Select the type of background. Solid color fill creates a background that is a 
single, solid color. Load from file allows you to use a graphics file as a background. If the file is 
smaller than ½ the dimensions of the contact sheet, it will be tiled. Otherwise, it will be stretched 
to fill the sheet.

Borders. Select the type of borders for the thumbnails.

Line color. Select the color for the borders (simple style only).

Interior fill. Select a color for filling the interior of the thumbnail boxes on the contact sheet. If 
"Don't fill" is selected, then the border will be placed around the thumbnail itself, rather than 
around the area reserved for it.



Thumbnail | Contact Sheets • Layout

Use this tab to determine the layout on the page of the catalog.

Margins. Select the left, right, top and bottom margins.

Units. Pixels are always used as the units for contact sheets.

Thumbnail Size. Selects the size of thumbnails to generate, in pixels.

Columns. Selects the number of columns of thumbnails to present.

Line Spacing. Selects the spacing (in pixels) between lines of thumbnails or text.



Thumbnail | Contact Sheets • Header & Footer

Use this tab to enter a header and footer for the contact sheets. Each may be multiple lines, and 
may contain the following tokens that ThumbsPlus will use to substitute the appropriate value:

\p Page number.

\d Date

\t Time



Thumbnail | Contact Sheets • Fonts

Use this tab to select the typefaces and text colors for the catalog printout. You can select 
separate fonts for the header and footer, directory entries, and thumbnail captions.



Thumbnail | Contact Sheets • Options

The Options tab provides several choices for the contents of the contact sheets.

Include with thumbnails. Select the information about the thumbnails to include on the contact 
sheets.

Which files to include. Choose which files to include on the contact sheets.

Print heading for each directory. If this item is checked, then ThumbsPlus will print a heading 
for each directory included on the sheets. This heading will contain the volume and directory 
names.

New page for each directory. Check this option to cause ThumbsPlus to start a new sheet for 
each directory or sub-directory.

Rebuild thumbnails at printer resolution. Check this option for high-resolution thumbnails, 
which take longer to generate (the disk files must be read and reduced to the proper size), but are 
much higher quality.

Automatically crop images. Causes ThumbsPlus to automatically crop images before making 



the thumbnails. This removes excess single-color borders from images.



Options Menu

Preferences Ctrl+P
Font Ctrl+Y
File Loading Ctrl+L
Customize Toolbar Ctrl+B
Save for Startup

Directory Path Ctrl+Shift+D
Tree size and options Ctrl+Shift+T
Initial Database Ctrl+Shift+E
Window size & pos Ctrl+Shift+P

Database
Edit Keywords…

       Statistics  Ctrl+T
Thumbnail Size

(50%, 100%, 150%, 200%)
Sort By

(Name, Type, Size, Date, Descending)
Show for Files

(Thumbnail, Name, Size, Date
Dimensions, Resolution, Include Hidden)



Options | Preferences Ctrl+P 

This selection opens a tabbed dialog box with a tab for each of several categories of options that 
you can control.

 •      General  
 •      File Types  
 •      File List  
 •      Colors  
 •      Confirmations  
 •      Viewing  
 •      Slide Show  
 •      Monitor  
 •      Keywords  
 •      Advanced  



Options | Preferences • Advanced

Use this tab to select modify several advanced parameters for ThumbsPlus.

Maximum image bitmap cache size. For images that require less than this much memory to 
load, ThumbsPlus maintains an image bitmap to speed up repainting when the image must be 
displayed. This size is based on the in-memory size of the image, not the disk size of the image 
file.

Bitmap window size for larger images. For images larger than the maximum bitmap cache size, 
ThumbsPlus uses a bitmap "window" to display the image a piece at a time. This parameter 
selects the size, in Kbytes, of that window.

Copy metafiles to the clipboard at actual size. Some applications do not handle proportional 
metafiles from the clipboard well. If you find metafiles pasted into other applications upside 
down or at really unusual sizes, select this option.

Copy metafiles to the clipboard proportionally. This option works for most applications. If 
metafiles are pasted very large when actual size is set, try proportional instead.



Options | Preferences • Colors

Use this tab to select the colors for the various ThumbsPlus user interface elements. To modify a 
color, simply click on the button and select a new color from the list. You may use the mouse or 
the keyboard (arrow keys and Enter) to select a color.



Options | Preferences • Keywords

ThumbsPlus can automatically generate keywords for images when making thumbnails. Use the 
selections in this tab to control that process.

From Filename. Assigns a keyword based on each word in the filename of each image.

From comment. Assigns keywords based on each word in the comments residing in each image 
(for GIF, JPEG and TIFF file types).

From file type. Assigns a keyword based on the file type of each file (i.e., .JPG).

From attributes (color, etc.). Assigns a keyword for color and encoding attributes of the file; for 
example: raster, vector, palette, RGB, grayscale.



Options | Preferences • Monitor Gamma

This tab allows you to calibrate the gamma correction value for your monitor. A gamma value of 
0.0 means that ThumbsPlus will not gamma correct any image.

Simply adjust the scroll bar, using either the arrows at the ends or by dragging the central box, 
until the central gray square is as close as possible to the color of the surrounding pattern. For 
best results, calibrate in a darkened room.

As some monitors exhibit different characteristics at different display resolutions and color 
depths, ThumbsPlus will save a different gamma value for each combination.

Some image types have a specific gamma value for which they are corrected (for example, GIF 
files are corrected for a monitor gamma of 2.0). If you choose to use gamma correction, you need 
to set each type appropriately, from the Assumed Gamma dialog box. Unless this value is set for 
a specific file type, it will not be adjusted.



Options | Preferences • File Types

New. Runs the File Type Configuration dialog box so you can define a new file type for 
ThumbsPlus to handle.

Configure. Runs the File Type Configuration dialog box to change the configuration of a 
specific file type.

Select All. Select this option to show all configured file types in ThumbsPlus. Files that are not 
recognized will not have thumbnails, but you can move, copy, delete and rename these files.

Clear All. Select this option clear all selected file types, so you can start selecting from scratch.



File Type Configuration

This dialog box, which is accessed from the Options | File Types dialog box using the New or 
Configure button, allows you to define a new file type for ThumbsPlus to support, or to modify 
the configuration of a specific type.

ThumbsPlus can recognize any file type it supports internally, regardless of its specific name or 
extension. However, for files accessed through external filters or OLE, the extension may be 
important.

Extension. Enter the one, two or three character extension (without the period) for the file type 
to define.

Description. Enter a description of the file type. If the file type is equivalent to another (see 
below) you can leave the description blank --ThumbsPlus will automatically use the description 
of the base file type.

Equivalent to type. If the file type is equivalent to a type already known to ThumbsPlus, select 
that type here. This will disable most of the other entries in the dialog box, since the access to the 
type is defined through its base type.

Class. Select the type of file. For most purposes, Vector and Raster are appropriate. Several of 
the types give more information about the type of file and may be useful for categorizing OLE-
based files. OLE-based types not classed as Raster are loaded as Vector.

Load file using. Select the method that ThumbsPlus should use to load the file:

Internal - ThumbsPlus should use its internal loading routines to load the file. The file must 
be recognizable by ThumbsPlus.

Filter - Use a Aldus Rev. 1 filter to load the file. The next field (>>) should be used to select 
the filter; if the list is blank, use the Hunt for filters button to search for filters on your 
system.

OLE - ThumbsPlus should attempt to attach to an OLE server for the file type to render it as 



a metafile or bitmap. Select the appropriate server from the next (>>) field.

None - ThumbsPlus should not attempt to load the file. It can still be shown in the file list, 
with an appropriate icon, if Edit Using is set to Association.

Edit file using. Select the method that ThumbsPlus should use to edit the file. Note that raster 
images may be edited to some degree from within a ThumbsPlus view window.

Association - Use the Windows File Manager association, as registered by FIle Manager, to 
launch the program to edit the file. If you don't select a specific item from the next list 
(>>), ThumbsPlus will use the file extension to attempt to locate an association.

Command - Enter a specific command to edit the file. You can use '%F' in the string as a 
token to be replaced by the file name.

None - Don't attempt to launch an editor for this file type.

Print file using. Select a method for printing the file type. If it can be loaded into ThumbsPlus, 
the Internal method usually works best. Otherwise, you may select Command or Association, 
as described under Edit File Using.



Options | Preferences • File List

This option displays a dialog box from which you can control the display of the file list and 
thumbnails in ThumbsPlus. Note that many of these options can be controlled more quickly 
using the Options | Thumbnail Size, Options | Sort By, and Options | Show for Files menu 
selections.

Order by. Selects the order in which files are displayed in the file list. You can sort by name, 
extension, size or date. You can also change the sort method using the Options | Sort by menu.

Show for each file. Select the items you wish to view for each file. These items may also be 
selected using the Options | Show for files menu.

Name mask. Check this box and enter a mask to select files based on a mask rather than on the 
types selected in the File Type dialog box.

Thumbnail display size. ThumbsPlus can enlarge    or reduce the thumbnails on the fly. This is 
especially useful for very high resolution displays (1240x1024 and higher), or if you want to see 
a lot of thumbnail simultaneously. Select the desired thumbnail size here. The stretching 
operation makes the file list display slightly slower. The options available are 50%, 75%, 100%, 
150% and 200%. This selection may also be made from the Options | Thumbnail size menu.

Include hidden files. Causes ThumbsPlus to display system and hidden files in addition to 
normal files.

Show font names. When this is selected, ThumbsPlus will scan TrueType font files and load the 



font names. It will display these instead of the file names. Additionally, the font names will be 
green if the font is installed.

Left justify file names. Selecting this option will display the file names left-justified under the 
thumbnails, rather than centered.



Options | Preferences • General

This option displays a dialog box which allows you to set the parameters for the operation of 
ThumbsPlus

Automatically Crop Images. Automatically crops, by removing all continuous border of the 
same color, any image. This may be on or off for each of the following operations:

On copy to clipboard
When making thumbnails
When viewing

Default Action. Selects the default action (taken for a double-click with the left mouse button). 
Select one of the following operations:

View Image
Copy to Clipboard
Edit Image

Minimize ThumbsPlus. Selects times when you would like the ThumbsPlus main window to 
automatically reduce to an icon for less screen clutter; similar to the Minimize on Use option in 
the program manager. You may elect to minimize ThumbsPlus at any of the following times:

When viewing
On copy to clipboard



When editing an image

Save files in. Using this option, you can select the default location for any "Save as" operation 
from a view window. Selecting Current directory will use the current path from the main 
ThumbsPlus window, while selecting Last saved location will remember each time you save a 
file, and use that location as the default the next.

Show orphaned thumbnails. Orphaned thumbnails (thumbnails for files which have been 
removed or moved by another program) can be shown in the file list; however, this option slows 
the file list display as ThumbsPlus scans the database for any entries which do not have 
corresponding files on disk.

Automatically removed orphaned thumbnails. Selecting this will cause ThumbsPlus to scan 
for orphaned thumbnails (thumbnails for files that have been removed from another program) 
whenever you change directories, and automatically remove them. You may instead remove 
orphans manually using the Remove Orphans option on the Thumbnail menu.

Use Windows 95 recycle bin for deleted files. This option tells ThumbsPlus to move deleted 
files to the Recycle Bin, rather than directly removing them from the disk. This option is 
available only on Windows 95.



Options | Preferences • Confirmations

This menu selection allows you to configure which items ThumbsPlus prompts for confirmation. 
For example, if you want ThumbsPlus to make sure before deleting files, that option should be 
checked. The dialog box looks like this:

Each option determines whether or not ThumbsPlus will display a dialog box to confirm the 
listed operation after it is selected.



Options | Preferences • Slide Show

This dialog box allows you to control the operation during a Slide Show.

Delay between slides. Select either a number of seconds that ThumbsPlus will wait between 
slides, or mark the Control manually checkbox to manually switch slides (using the left mouse 
button or the space bar).

Background color. Select the background color to use for images smaller than the screen.

Skip files smaller than. When selected, ThumbsPlus will not display raster images smaller than 
the entered size (width and height).

Stretch bitmaps to screen. Causes ThumbsPlus to stretch images to fill the screen as much as 
possible.

Reduce bitmaps to screen. Similar to "Stretch," except that only bitmaps larger than the screen 
are resized. Bitmaps smaller than the screen size are centered.

Maintain original aspect ratios. When stretching bitmaps, ThumbsPlus will ensure that the 
width-to-height ratio remains constant, rather than distorting the image.

Hide cursor. Hides the mouse cursor during the slide show.

Build bitmaps from metafiles. When this checkbox is selected, ThumbsPlus will build an in-
memory bitmap from a metafile before displaying it. This eliminates watching the metafile draw.

Show filenames. ThumbsPlus will display the file name (at the bottom of the screen) of each file 



as it displays in the slide show.

Random order. The list of file names will be shuffled before the slide show begins.



Options | Preferences • Viewing

You control the operation of viewing files with this dialog box.

Initial Size:

Automatic. The size of the view window is based on the size of the image or metafile being 
displayed.

Full Screen. The entire screen is used to display the picture, without menu bar or caption. 
See View | Full Screen for more information on this mode.

Maximize. The window is maximized.

Minimize. The window is iconized.

Initial Stretching

Don't stretch. The image is not initially stretched.

Fit images to window. The image is always stretched or reduced to fill as much of the 
window as possible (depending on the setting for Maintain aspect ratio).

Reduce to fit window. Initially, the image will be set to Stretch to fit mode only if the 
image is larger than the window ThumbsPlus creates for it. Otherwise, the image will be 
centered.

Fit images to width. The width of the image will be stretched to fit the width of the 
window. This is especially useful for documents in portrait orientation (higher than wide).



Background color. Select a background color for the sides or top if the window is larger than the 
image.

Maximum number of open view windows. Selects the maximum number of View windows 
which ThumbsPlus can manage at one time. Select a number between 2 and 40. Once this limit is 
reached (approximately), ThumbsPlus will close the oldest window before opening another.

Maintain aspect ratio. The ratio between the width and height of the image is kept constant, to 
avoid distorting the image.

Dither Metafiles. Windows Metafiles generally include 24-bit color information. On 256-color 
palette-based displays, these colors will be dithered. ThumbsPlus generates (up to) 236-color 
palettes for displaying metafiles, resulting in much smoother displays. However, generating the 
palette and modifying the metafile display to take it into account slows the display process down. 
Select this option if you are in a hurry. Also select this option if you are using a 16-color or 24-
million color display driver, or if you get strange results displaying or thumbnailing metafiles.

Show comments when available. If an image has comments stored with it in the file, selecting 
this option will cause ThumbsPlus to automatically display them. The View | Edit Comments 
window displays automatically whenever you view an image with comments. ThumbsPlus can 
read comment fields from GIF, JPEG and TIFF files.

Disable Undo. If you select this option, ThumbsPlus will not save the information necessary to 
undo image operations. This will speed up edit time and require less memory and temporary disk 
space.

Show Toolbar. When you check this item, ThumbsPlus will automatically create a toolbar for 
each view window.

Show Status line. When you check this item, ThumbsPlus will automatically create a status line 
for each view window.

View while loading images. This option causes ThumbsPlus to display the view window while 
loading each image, so you can see the image as it loads. On some displays, this may make the 
load take a bit longer.



Options | Font

This selection allows you to select a font for display of the directory list, file list and status line. 
Note that the same font is used for all of these user interface elements.



Options | File Loading Ctrl+L

This dialog box provides options for loading several of the file types. Each of the tabs (listed 
below) provides configuration options for a specific file type.

 •      JPEG  
 •      WP Graphics  
 •      TrueType Fonts  
 •      PhotoCD  
 •      GIF  
 •      Raw  
 •    UUdecode



Options | File Loading • GIF

This tab sets the options for loading GIF files. This tab is not available on Windows 3.1 systems, 
where only the first image is loaded.

Viewing options. Select how ThumbsPlus displays GIF files.

Final appearance. Only the final appearance of an animated GIF file is displayed; 
intermediate frames are played in memory, but only the final images shows in the view 
window.

First image only. The first graphic image from the GIF file is loaded. This was the behavior 
before version 3.0c, and is the only option available for Windows 3.1.

Play to window. An animated GIF file plays into the view window so you can see the 
changes as they would appear in Netscape or any other browser. You can set several playing 
options (below) to control how the animation progresses. Looping (as in Netscape) is not 
supported; the animation plays only once.

Playing options. Select how ThumbsPlus plays GIF files (options for Play to window).

Disable input waits. GIF files can have blocks which specify that the animation should wait 
for user input. This option disables those waits.

Disable timed delays. GIF files can have specific timed delays between image or text 
displays; this option will ignore such delays and play frames as fast as possible.

Ignore text blocks. This option causes ThumbsPlus to ignore any displayable text blocks in 
the GIF file.



Thumbnail options. Select the disposition of GIF files to use for making thumbnails.

Final appearance. The thumbnail is generated from the appearance of the GIF file after all 
frames have played.

First image only. Only the first image is used to generate the thumbnail.



Options | File Loading • Raw

This tab sets the options for loading raw grayscale or RGB files.

Raw file types. This is a list of all defined raw file formats. You may select an item from this list, 
then click Edit to modify it or Delete to remove it. You can click New to add a new raw format. 
Both Edit and New use the Edit Raw Type dialog box to configure the file type.



Edit Raw Type

Use this dialog box to add a new raw file type, or to modify an existing raw type.

Name. Select a name for the format.

Width. The width of the image, in pixels.

Height. The height of the image, in pixels.

Replicate scan rows. Some raw types (notably some files generated by ocular cameras) store 
only every other scan line (i.e., the pixel shape is rectangular). This option will cause 
ThumbsPlus to write each scan line twice, restoring the proper aspect ratio.

Pixel format. Select the style of pixels in the raw image. ThumbsPlus can handle several pixel 
formats directly:

· 8-bit gray. Each pixel of the image is represented by a single byte which represents the level 
of gray. Pixel values range from 0 (black) to 255 (white).

· 16-bit gray. Each pixel is represented by two bytes, with the least significant byte first (Intel 
byte order). Pixel values range from 0 (black) to 65535 (white).

· 16-bit gray (swap). Each pixel is represented by two bytes, with the most significant byte 
first (Motorola format). Pixel values range from 0 (black) to 65535 (white).

· 24-bit RGB. Each pixel is represented by three bytes: one byte each for red, green and blue, 
in that order.

· 24-bit BGR. Each pixel is represented by three bytes: one byte each for blue, green and red, 
in that order.

· 32-bit RGB. Similar to 24-bit RGB, except that each pixel is represented by four bytes. The 
fourth byte is usually an alpha channel, which is ignored by ThumbsPlus.

· 32-bit BGR. Like 24-bit BGR, except that a fourth byte is present (usually an alpha channel) 
which is ignored by ThumbsPlus.



Note: By default, the alpha channel (ignored by ThumbsPlus) is assumed to be the fourth byte in 
32-bit RGB or BGR formats. However, if your files are stored in ARGB or ABGR order, you can 
set the Bytes to Skip at start to one (1), and the Bytes to Skip at end to minus one (-1). This will 
cause ThumbsPlus to ignore the first byte in each four-byte pixel, rather than the last.

Bytes to skip. Some raw formats contain extra data at the beginning or end of the file, or both. 
Use these fields to enter the amount of data to skip at the start or end of the file.

Expected file size. Using the entries in the other fields, ThumbsPlus computes the expected size 
on disk of the defined type and displays it here. For ThumbsPlus to recognize the file, its size 
much match this value.

Note: In order for ThumbsPlus to recognize a file as a defined raw type, two criteria must be met:

1 The image information must be defined so that the file size matches the "expected file size" 
as described above.

2 The file extension must be defined (using Options | Preferences • File Types) as "equivalent 
to" the .RAW type.



Options | File Loading • JPEG

This tab sets the options for loading JPEG files.

The JPEG library allows you to select how to load JPEG files. JPEG files are always stored as 
24-bit (truecolor) images, but the library can automatically dither them to 8-bits for displaying on 
256-color devices. This dithering will interfere with editing, however: if you want to edit JPEG 
files on an 8-bit display, it is best to load them as Truecolor even though they don't look as nice. 
In other words, on an 8-bit (256 color) display, JPEGs are best loaded for viewing as 8-bit color, 
but best loaded for conversion or editing as 24-bit (Truecolor). For quick viewing on 8-bit 
displays, load them as Grayscale.

The Two-Pass Quantization and Dither options apply only if loading as 8-bit color; deselecting 
either or both will speed the load and conversion to 8-bit, at a sacrifice in appearance. The JPEG 
load dithering is similar to the Floyd-Steinberg dithering available as an option in the Color 
Depth dialog box.

The Full, 1/2, 1/4 and 1/8 size options allow you to load a JPEG file at smaller than its actual 
dimensions. This speeds up loading considerably, and allows you to load files that are too large 
for your system's memory configuration.



Options | File Loading • WP Graphics

Use this tab to set options for rendering WordPerfect graphic (WPG) files.

Ignore Shadows. If this box is checked, ThumbsPlus will not render object shadows in WPG 
files. This may speed processing, and may make files easier to edit in other (non-WP) 
applications.

Ignore Gradient fills. If this box is checked, ThumbsPlus will not render gradient fills. This will 
greatly speed processing and reduce the size of resultant metafiles (either copied to the clipboard 
or saved to disk).

Ignore Text objects. Check this box if you don't want text information in WPG files rendered.

Use TrueType fonts only. Check this box to force ThumbsPlus to select a TrueType font for any 
text in WPG files. This option is meaningless if Ignore Text Objects is checked.



Options | File Loading • TrueType Fonts

Use this tab to control the actions taken when ThumbsPlus thumbnails and views TrueType fonts.

Thumbnail Sample Text. This text is used to create the thumbnail for the font. By default, this 
is blank and the font name alone is used to create the thumbnail.

Include Font Name. Checking this box causes ThumbsPlus to use both the sample text above 
and the name of the font for the thumbnail.

Window Sample Text. This text is displayed at the bottom of the font view window to show an 
example of how the text looks with several characters together.



Options | File Loading | UUdecode

When to uudecode

On demand only. ThumbsPlus will uudecode files only when double-clicked to view. This 
limits the times that ThumbsPlus processes the files.

When making thumbnails. ThumbsPlus will uudecode when making thumbnails.

Where to uudecode.

Temporary file. ThumbsPlus will uudecode into a temporary file, which will be removed 
after the thumbnail is made or image viewed.

Original directory. ThumbsPlus will uudecode into the original directory (where the UUE 
file resides), using the file name specified in the UUE file.

Specific directory. ThumbsPlus will uudecode into a specific directory, using the file name 
specified in the UUE file. You can use the Browse button to select a directory.

Delete original file when uudecode is successful. ThumbsPlus will remove the .UUE (or .001) 
and subsequent (.002, etc.) files after successfully decoding the file. Should the decode produce 
any warnings or errors, the original will not be removed. This option is not available when 
decoding to temporary files.

Overwrite existing files with the same name. ThumbsPlus will automatically overwrite any file 
of the same name. This option is not available when decoding to temporary files.



Options | File Loading • PhotoCD

This tab selects the options for loading PhotoCD images.

The Size to load section allows you to select the desired size of the loaded image. Note that the 
horizontal and vertical sizes will be reversed for images stored in portrait orientation.

The Color format section allows you to select the color resolution of the loaded image.



Options | Customize Toolbar

Use this dialog box to configure the ThumbsPlus toolbar to your liking. Most menu commands 
are available as toolbar buttons; simply drag the ones you want to the place you want on the 
toolbar.

You can also move buttons on the toolbar, or drag them completely off to remove them. Buttons 
may only be on the toolbar once – if you add a button a second time, it will move to the new 
position.

You may make two rows of buttons, but the second row will not display properly until you select 
OK to save your changes.

You may also double-click the toolbar to open this dialog box.

There is no keyboard interface for customizing the toolbar (toolbars are for mouses, aren't they?).

Available buttons. Shows the buttons available for the toolbar. Drag a button to the toolbar to 
add it.

Large buttons. Selects the larger size of toolbar button (32x32 pixels), versus the small version 
(20x20 pixels).

Text on buttons. Adds descriptive text (as in Tool Tips) to each button. This makes the buttons 
quite a bit larger.

Enable Tool Tips. Enables tool tips, which will describe each button if you leave the cursor over 
it for about a second.



Options | Save for Startup | Directory Path Ctrl+Shift+E

This option saves the current directory as the startup directory for the current database; whenever 
you open this database, ThumbsPlus will position to the current directory. This helps, for 
example, if you have a "Fonts" database, and a directory containing fonts. You can set the startup 
directory for the Fonts database to the Fonts directory, so that you don't have to click around in 
the directory list to find the fonts.



Options | Save for Startup | Initial Database Ctrl+Shift+E

This option sets the current database as the default database for ThumbsPlus. Unless another 
database is specified on the ThumbsPlus command line, ThumbsPlus will open this database. See 
File New Database and File Open Database for information on creating and managing 
ThumbsPlus databases.



Options | Save for Startup | Tree Size and Options Ctrl+Shift+T

This option saves the current size (width) of the directory tree and the checked options from the 
Tree menu.



Options | Save for Startup | Window Size & Position Ctrl+Shift+P

This option saves ThumbsPlus's current window position and size. Subsequent runs of 
ThumbsPlus will place the main window at its current position. Note that this is set for the 
current database only, so that you can configure different databases to start at different window 
positions.



Options | Database | Edit Keywords

Use this option to edit the keywords in the database. You may select one or more keywords in the 
list at the left, then click on buttons to "do something" to them.

Delete. Removes the keywords from the database. This also disassociates any thumbnails from 
the keyword.

Change. You can type a new value for the keyword. It will remain associated with all thumbnails 
that were associated with the original. This button is only available if a single keyword is 
selected.

Combine. You may combine multiple keywords to a single database entry. Extra associations 
(i.e., references to more than one of the selected entries) will be dropped. This button is only 
available if multiple keywords are selected.



Options | Database | Statistics Ctrl+T

Shows various thumbnail database statistics for the current database.



Options | Thumbnail Size

You may quickly change the thumbnail size in the file list using any of these selections (50%, 
100%, 150%, 200%). The sizes are relative to the size of the thumbnails as created by File | New 
Database.

These selections are also available from Options | Preferences • File List.



Options | Sort By

Select the field to sort the file list (Name, Type, Size, Date). You may also sort in descending 
order (Descending).

These selections are also available from Options | Preferences • File List.



Options | Show for Files

Select the items shown for each file in the file list (Thumbnail, Name, Size, Date, Dimensions, 
Resolution). You may also select whether to include hidden and system files.

These selections are also available from Options | Preferences • File List.



Window Menu

Show All F4
Close All Shift+F4
Minimize All Ctrl+F4
Toolbar Ctrl+Shift+B
Status Line Ctrl+Shift+L
Refresh File List F3



Window | Show All F4

Causes ThumbsPlus to display all open view windows (in the order they were opened). 
Minimized (iconized) windows are restored; hidden windows are brought to the front.



Window | Close All Shift+F4

Closes all opened view windows. If you have selected confirmation on closing modified 
windows from the General Options dialog box, ThumbsPlus will prompt you before closing any 
modified windows.



Window | Minimize All Ctrl+F4

This option will minimize (reduce to an icon) all open view windows. These icons display on the 
normal Windows desktop for easy access.



Window | Toolbar Ctrl+Shift+B

This menu option toggles the toolbar on or off.



Window | Status Line Ctrl+Shift+L

This menu option toggles the status line on or off.



Window | Refresh File List F3

This option re-reads the current directory and searches for thumbnails for any files there. You 
should select this option if you delete, move or add to the files in the current directory.



Help Menu

Help Topics F1 Displays the ThumbsPlus Help contents
Menus Displays help for the main menu
Error Messages Displays help for error messages
License Displays the shareware license
Ordering! Provides ordering information
Search for Help on… Ctrl+F1 Allows you to search the Help file
About ThumbsPlus… Show the ThumbsPlus About box
System Information Displays current system information



Help | System Information

This option displays the system information dialog box, which show various information about 
the current system. Cerious Software may ask for some or all of this information for 
troubleshooting.



View Window
The View Window provides a quick and easy way to view and globally edit (crop, color adjust, 
modify color depth, rotate, resize, filter, invert, flip, etc.) graphics images from within 
ThumbsPlus. You can also save modified files in various formats. 

Keyboard
Menus



Keyboard - View Window

Menu accelerator keystrokes:

F4 Edit | Autocrop
Esc Edit | Cancel Selection
F8 Edit | Clone
Ctrl+C Edit | Copy
Ctrl+R Edit | Crop
* Edit | Goto Page
Alt+PageDown Edit | Next Page
Alt+PageUp Edit | Previous Page
Ctrl+E Edit | Select All
/ Edit | Split Pages
F2 Edit | Thumbnail From Selection
Ctrl+Z Edit | Undo
Shift+Alt+F4 File | Close All
F5 File | Copy file
Del File | Delete file
Shift+F5 File | Move file
Space File | Next file
Ctrl+F9 File | Page Setup
Backspace File | Previous file
F9 File | Print
Ctrl+Shift+Z File | Reload
Ctrl+Shift+Z File | Reload
Ctrl+Shift+F5 File | Rename file
Ctrl+S File | Save
Ctrl+A File | Save As
F1 Help | Menus
Ctrl+F1 Help | Search
C Image | Color Adjust
D Image | Color Depth
B Image | Convert to Bitmap
U Image | Count Unique Colors
Ctrl+F Image | Filter | Last Filter (R)

Shift+F Image | Filter | New Filter (R)

F Image | Filter | Select Filter (R)

H Image | Flip Horizontal
V Image | Flip Vertical
M Image | Histogram (R)

I Image | Invert
R Image | Rotate/Resize
W Image | Swap Red & Blue
6 Image | Turn ( 90)
2 Image | Turn (180)
4 Image | Turn (270)



G View | Assumed Gamma
Ctrl+F6 View | Autosize Window
F7 View | Comments
F3 View | Full Screen
L View | Gridlines
Shift+F6 View | Maintain Aspect Ratio
Ctrl+O View | Options
Ctrl+W View | Stretch to Fit Width
F6 View | Stretch to Fit Window
Z View | Zoom In
Shift+Z View | Zoom Out



View Window Menus

File
Edit
Image
View
ThumbsPlus!
Help



File Menu

Save Ctrl+S
Save As… Ctrl+A
Save Selection As… Ctrl+Shift+A
Save Palette As… Ctrl+P
Close Alt+F4
Close All Shift+Alt+F4
Reload Shift+Ctrl+Z
Previous file Backspace
Next file Space
Copy file… F5
Move file… Shift+F5
Rename file… Ctrl+Shift+F5
Delete file Del
Print… F9
Page Setup… Ctrl+F9



File | Save Ctrl+S

Select this option to save the current view window as its original name. If the file is a format not 
supported for writing, ThumbsPlus will save it as a native format (BMP or WMF).



File | Save As Ctrl+A

This option saves the current file, allowing you to select a file name from a standard Windows 
Save As dialog box. It may be used to save a cropped or otherwise modified image. ThumbsPlus 
currently supports several types to save as: BMP, GIF, JPG, TIF, TGA and PCX for images, and 
WMF for metafiles.

Some file types also have optional information (such as comments) which can be saved in the 
file. If there are options available for the type you select, an Options dialog box will appear after 
you click OK in the Save As dialog box.

The JPEG Save Options dialog box even shows a preview of the "lossiness" of the compression.

The TIFF Save Options dialog box allows you to set the compression and resolution of the file, 
and to add or modify image comments.

The GIF Save Options allows you to specify the GIF level of the output, and to add or modify 
image comments.

If the current file has an extension representing another format (such as .PCX or .CGM), it is 
changed to reflect the format being saved.



File | Save As Options (TIFF)

Compression.

None is the most compatible with other applications, and fastest to load.

LZW is best for 8-bit color and grayscale, and for 24-bit color files.

CCITT Group 3 and CCITT Group 4 are valid only for bi-level files.

Best Fit will cause ThumbsPlus to use CCITT group 4 for any bi-level files, and LZW 
compression for any others.

Comments. Allows you to edit the contents of the TIFF Description tag.

Resolution. Allows you to set the suggested resolution for the image, in dots-per-inch or dots-
per-centimetre.

Separate color channels. Allows you to store RGB (Truecolor) images in separate red, green 
and blue channels. You should not use this option with LZW compression.



File | Save As Options (GIF)

GIF files may be saved as the older 87a format, or the newer 89a. Version 89a files can have 
comments, which you can edit by clicking the Comments button.

You can also save GIF files as interlaced.



File | Save As Options (JPEG)

Quality. Select a quality value, between 1 and 100. Values between 25 and 95 are recommended. 
Values below 25 are likely to degrade the image far too much, and values above 95 make the file 
larger without any appreciable quality increase.

Smoothing. This option is sometimes useful for storing dithered 256-color images as JPEGs; it 
attempts to smooth the differences between pixels caused by dithering, but tends to blur the 
image somewhat.

Grayscale. Stores the image as a single-channel, 8-bit grayscale image. This removes all color 
information from the image.

Comments. Click on this button to edit or add comments to the image file.

Preview. Allows you to see the effect of the lossy compression on the image. You may scroll this 
preview around to different parts of the image to see the effect on specific details. The Delta 
option shows the differences between pixels, before and after compression. Medium gray is 
"zero difference."

A truecolor or highcolor (24-bit or 16-bit) display driver is required to utilize the JPEG loss 
preview.



File | Save Selection As Ctrl+Shift+A

This option operates exactly like File | Save As, except that it only saves the selected area.



File | Save Palette As Ctrl+P

This option saves the palette of the current file to a .PAL file, which is really just a PCX file with 
a different extension. You can use these PAL files (or any bitmap file with a palette) to apply a 
palette to a given picture using the Color Depth dialog box, or even to apply the same palette to 
multiple files in Batch Convert/Edit.

You can make the .PAL files visible in ThumbsPlus by selecting them in the Options | File Types 
dialog box from the main window.

ThumbsPlus .PAL files are not similar to or interchangeable with .PAL files from other 
applications.

ThumbsPlus stores a small (generally 64x64) pixel bitmap along with the palette, so that useful 
thumbnails may be generated from the files.



File | Print F9

This selection prints the graphic in the current view window. All options from the Page Setup 
dialog box are applied.



File | Reload Ctrl+Shift+Z

This option reloads the current image from its disk file (the last time it was saved, or the original 
if you haven't saved it). It effectively undoes all changes since the last time the file was saved.



File | Close ALT+F4, ESC

This option closes the view window and removes it from the screen. If you have modified the 
image and selected confirmation for closing modified images (from the Confirmations dialog 
box), ThumbsPlus will ask you if you wish to save the modified image.

ESC will also close the image unless it is displayed full screen, in which case it is restored to a 
window, or if there is a selection, in which case the selection is cancelled.



File | Close All Shift+ALT+F4

This option closes all open view windows. If you opted to confirm closing modified images 
(from the Confirmations dialog box), ThumbsPlus will prompt you to save each one before 
closing it.



File | Next fileSpace

In a view window that was generated by loading an image from disk, this selection will open the 
next file in the current directory. If there are no more images, or if the current image was pasted 
from the clipboard or scanned, this option will be unavailable.



File | Previous file Backspace

In a view window that was generated by loading an image from disk, this selection will open the 
previous file in the current directory. If the current image is the first in the directory, or if the 
current image was pasted from the clipboard or scanned, this option will be unavailable.



File | Copy file… F5

For windows generated by loading an image, this option will allow you to copy the file to 
another location. If the file was pasted or scanned (rather than loaded from disk), this option is 
unavailable.



File | Move file… Shift+F5

This option will allow you to move the current file to another location. If the file was pasted or 
scanned (rather than loaded from disk), this option is unavailable.



File | Rename file… Ctrl+Shift+F5

This option will allow you to rename the current file on disk. If the file was pasted or scanned 
(rather than loaded from disk), this option is unavailable.



File | Delete file Del

This option will allow you to delete the current file from the disk. If the file was pasted or 
scanned (rather than loaded from disk), this option is unavailable.



Edit Menu

This menu provides options that operate on a selected area in the view window. Only bitmaps 
can be selected from; to operate on a portion of a metafile, it must first be converted to a bitmap 
using the View-Convert to Bitmap option.

Use the mouse to select an area in the view window: press the left mouse button to start a 
selection area at one corner, and hold it down while moving the mouse to the opposite corner. 
Then release the mouse button. ThumbsPlus will draw a rectangle around the selected area. If the 
area is large enough, ThumbsPlus will also display the selected area size in a small rectangle in 
the center of the area.

To select an area from the center out, hold the SHIFT key down, press the left mouse button at 
the place you want to be the center of the selection, and drag the mouse to a corner. Then release 
the mouse button.

Undo Ctrl+Z
Copy Ctrl+C
Crop Ctrl+R
Cancel Esc
Select All Ctrl+E
Thumbnail from Selection F2
Autocrop F4
Clone F8
Next Page Alt+PageDown
Previous Page Alt+PageUp
Goto Page… *
Split Pages… /



Edit | Clone F8

This menu selection copies the current image to a new window. The file is not re-opened, so any 
changes made already are reflected in the copy.



Edit | Copy Ctrl+C

This menu selection copies the currently selected area in the view window to the clipboard. 



Edit | Crop Ctrl+R

Use this menu option to reduce the view window to only the selected area of the image. Anything 
outside the selected area is eliminated. This change will only be written to the disk file if you use 
the File-Save or File-Save As option. 



Edit | Cancel Selection ESC

This option removes the selection rectangle from the window. 



Edit | Undo Ctrl+Z

This selection restores the image to its state before the last Rotate, resize, Color Adjustment, 
Color Depth, Crop, Autocrop or Filter operation.

This menu item will show what will be undone, or show "Can't undo" if there is nothing to undo. 
Some operations (such as Invert) are not saved for undo, as they can be re-selected to undo them.



Edit | Select All Ctrl+A

This option selects the entire contents of the view window for processing.



Edit | Thumbnail from Selection F2

This selection uses the currently selected area in the view window to generate a thumbnail for the 
image. This is especially useful for clipart files which contain many related images. You can 
select a representative part of the file and create the thumbnail from only that part.



Edit | Autocrop F4

This option automatically crops the current image, removing any edges composed entirely of the 
same color. The pixel in the bottom left corner of the image is used as the reference pixel. Each 
of the four sides is compared to this pixel; any side entirely of that color is removed. This 
process is repeated for each side until a pixel of a different color is found.



Edit | Next page Alt+PageDown

In a multi-image file (TIFF or DCX), this will display the next image in the file. The title bar 
shows the current page number and the total number of pages in the file.



Edit | Previous page Alt+PageUp

In a multi-image file (TIFF or DCX), this will display the previous image in the file. The title bar 
shows the current page number and the total number of pages in the file.



Edit | Go to page… Alt+PageDown

In a multi-image file (TIFF or DCX), this option will allow you to select a specific page number 
to view. Page numbers start at one. 

Page number. Select the page number to display. Page numbers start at one.

First page. Display the first page.

Last page. Display the last page.



Edit | Split pages… Alt+PageDown

In a multi-image file (TIFF or DCX), this option will allow you to split the images into 
individual files. You can select the format, directory and file prefix for the operation. The original 
file is left intact.

Image save format. Select the format for the image. The defaults are TIF for multi-page TIFF 
files and PCX for multi-page PCX files.

Output path. Select the directory to which to write the individual images. You can use the 
Browse button to find a particular drive and folder.

Filename prefix. Enter the first part of the name of the file. A sequence number is automatically 
appended, starting at 0001. Note that the prefix is limited to 4 characters on Windows 3.1 
because of file name limitations.



Image Menu

Filter
Select Filter… F
New Filter… Shift+F
Apply Last Filter Ctrl+F

Histogram… M
Color Adjust… C
Color Depth… D
Rotate & Resize R
Flip Horizontal H
Flip Vertical V
Swap Red & Blue W
Invert I
Count Unique Colors U
Turn

90° Ctrl+KeyPad 6
180° Ctrl+KeyPad 2
270° Ctrl+KeyPad 4

Convert to Bitmap B



Image | Count Unique Colors U

This option counts the number of colors in an image. For images stored as 8 bits per pixel or 
fewer, it is very fast; but for 24-bit images, it may take a while (and temporarily use up to 2Mb 
of memory). If there is insufficient memory to count the actual colors in an image, ThumbsPlus 
will ask if you want an estimate instead.



Image | Filter | Select Filter (R) F

This dialog box allows you to select a filter for processing the current image (or group of images 
in Batch mode).

Category. Select the type of filter you wish to apply. Some types available are: Sharpen, Blur, 
Edge Detection, Effects and Noise.

Filter. Select the specific filter from that category. A sample of the results of the filter will be 
shown in the preview to the right.

Diameter. For statistical and morphological filters, you may select the diameter of the aperture 
to use for processing. Larger apertures will produce more profound effects.

Apply to. Select the channel(s) to apply the filter to. Intensity applies the effect only to the 
intensity (brightness) of each pixel -- the hue is maintained. All channels processes all three 
channels (red, green and blue) separately. And, for some filter types, you may select only a single 
color channel.

Orientation. For linear filters (those defined by a convolution mask) which are not symmetrical, 
ThumbsPlus can rotate the mask to several positions. Select the arrow which represents the 
direction you wish to apply the filter. 

Modify. Click this button to modify the currently selected filter. Note that only linear filters can 
be modified within ThumbsPlus. Statistical and multipass filters may not.

New. Click this button to add a new filter.



Image | Filter | New Filter (R)Shift+F

You use this dialog box to modify an existing linear filter or define a new one. Only linear filters 
(defined by a convolution mask) may be modified or added in ThumbsPlus.

Category. Select the category in which this filter belongs. Categories help to locate specific 
filters from the many choices.

Order. ThumbsPlus can apply 3x3, 5x5 or 7x7 filters. This selects the size of the filter. If you 
reduce the size once you've entered values, some will be lost.

Array. Enter the actual pixel accumulation values here. The central value represents the current 
pixel being processed. Each pixel is multiplied by the corresponding value in the array and added 
to a total.

Divisor. The sum of pixel x array values is divided by this value. For most filters, this divisor 
should be the same as the sum of values in the array; the    button will place this sum in the 
Divisor field.

Bias. This value is added to the result of (Array x pixels) / Divisor. It is used for some effects, 
such as embossing and etching. It is especially useful when the sum of values in the array is zero.

L. Click to force the array to be left-right symmetrical. All values on the left of the array will be 
repeated on the right (and if you change a value on the left, it will automatically change on the 
right). This button is on by default if you edit a filter that is left-right symmetrical.

T. Click to force the array to be top-bottom symmetrical. All values in the top of the array will be 
repeated automatically on the bottom (and if you change a value on the top, it will automatically 
change on the bottom). This button is on by default if you edit a filter that is top-bottom 



symmetrical.

Remove. Click to remove the current filter from the filter list (THUMBS.FLT).



Image | Filter | Last Filter (R) Ctrl+F

Repeats the last filter selected (using Image | Select Filter) on the current image.



Image | Histogram (R) M

This option displays a histogram of the intensity of the image. It shows the relative number of 
pixels at each intensity level. If the values are bunched together, the picture lacks contrast; if they 
are skewed to the left or right, the picture is most likely too dark or too light.

In some cases, equalizing the histogram (using the Equalize button) will improve the 
appearance. ThumbsPlus will attempt to modify intensities to come as close to even levels of 
each as possible.

The histogram is most useful for 256-level grayscale and RGB Truecolor images.



Image | Invert I

This selection inverts an image -- each color becomes the opposite color, creating a negative 
effect. This is most useful for printing CompuServe stock trend charts (and other dark drawn 
images), which otherwise use lots of toner or ink. It can also be useful for some incorrectly 
stored TIFF or PCX images (marked as MIN_IS_BLACK, but stored as MIN_IS_WHITE).

This option is its own inverse, so it is not saved for undoing.



Image | Swap Red & Blue W

This option swaps the red and blue values of each pixel or color map entry. It is useful for images 
(especially Sun Raster) which are saved with these values reversed. Note that this operation is 
not saved for undo, as selecting it again undoes it.



Image | Flip Vertical V

This option reverses the image from top to bottom. Note that this operation is not saved for undo, 
as selecting it again undoes it.



Image | Flip Horizontal H

This option reverses the image from left to right. Note that this operation is not saved for undo, 
as selecting it again undoes it.



Image | Rotate/ResizeR

This dialog box allows you to either rotate or resize an image, or both simultaneously. You can 
also control how the rotation occurs (whether the corners are cut off) using a zoom control.

Zoom percentage. Zooms in or out. This is most useful for controlling what happens to the 
corners of the image during rotation. Use the arrow keys or mouse to slide the control box left or 
right to decrease or increase the zoom amount. This option is not available when fitting to the 
bounding box (see below).

Rotation angle. Angle (counter-clockwise) of rotation, in .01-degree increments.

New Size. Various options for the new size of the image, include specific percentages and 
specific sizes. You can also select Window to size the image to the current window size, or 
Custom to enter specific values.

These values may be entered either as exact pixel measurements, or as percentages of the 
original.

Aspect Fit. This selection sets how ThumbsPlus treats an original whose dimensions are of a 
different ratio than the destination. In other words, it controls the size of the destination file.

Fit Both. The final image fits in the specified rectangle as closely as possible.

Fit Height. The final image must be the same height as the specified height.

Fit Width. The final image will be the same width as the specified width.

Bounding Box. Most useful for rotations: the final image size is calculated as the size 
necessary to include the entire image after rotation. This avoids cutting of corners or edges.



None. The aspect ratio of the original is ignored.

Interpolate (resample). Selecting this box (highly recommended!) will cause ThumbsPlus to set 
the values of new pixels to averages of surrounding pixels. This requires that the image be either 
24-bit color or 256-gray level. If it is not, ThumbsPlus will automatically change the color depth.

ThumbsPlus remembers the last settings from this dialog box so that you can re-use them for 
additional images, or for batch processing.

If you rotate or resize a 256 (or fewer) color image and select interpolation, ThumbsPlus will 
automatically promote it to 24-bit (truecolor to be able to interpolate intervening pixels. You can 
then use the Color Depth selection to adjust the colors to the number you desire. Likewise, 
ThumbsPlus will promote any grayscale image less that 256 levels to an 8-bit grayscale image.



Image | Turn Ctrl+6, Ctrl+2, Ctrl+4

These three options (to turn the image by 90, 180 or 270 degrees) rotate the image quickly. Note 
that you can achieve these same functions (even in batch mode) by using Rotate/Resize with an 
angle of 90, 180 or 270, and specifying Bounding Box as the Aspect Fit.



Image | Color Depth D

Use this window to modify the color depth of an image. For example, it will convert a color 
image to grayscale, or a 24-bit image to 8-bit, or just about anything to monochrome (bi-level).

Desired Color Depth. Select the number of colors you desire in the final image.

Bi-level. Selects a two-color (black & white) destination image. Each pixel requires a single 
bit.

Threshold. When you select bi-level as the desired color depth, you may enter a threshold 
value for the dividing point between black and white. This number must range between 1 and 
764. The sum of red, green and blue values for each pixel is compared to this threshold; if 
below, the destination pixel becomes black; if above, it becomes white. Note that if dithering 
is selected, this value may not make as much difference, as any error is propagated through 
neighboring pixels.

16 Colors. Selects a sixteen-color destination image; each pixel requires 4 bits.

236 Colors. Selects a 236-color destination image; each pixel requires 8 bits. This selection 
is useful for 256-color Windows users, as it leaves the 20 colors that Windows requires.

256 Colors. Selects a 256-color destination image; each pixel requires 8 bits.

Truecolor. Selects a 24-bit destination image; each pixel requires 24 bits.

Custom. Select a number between 4 and 256. For color counts between 4 and 16, 4 bits per 
pixel are required; for a count of greater than 16, 8 bits per pixel are required.

Palette. Unless converting to Truecolor, you must select the palette to use. Several fixed and 
optimized palette selections are available:

Optimized (5-bit median cut). Uses the "median cut" algorithm to select a color palette that 
best matches the colors of the original image. Selects from a total of 32,768 possible colors 
(5 bits each for red, green and blue).

Optimized (6-bit median cut). Uses the "median cut" algorithm to select a color palette that 
best matches the colors of the original image. Selects from a total of 262,144 possible colors 



(6 bits each for red, green and blue). In some cases, this will mean a better color selection 
than the 5-bit algorithm, but it runs somewhat slower.

Optimized (8-bit median cut). Uses the "median cut" algorithm to select a color palette that 
best matches the colors of the original image. This algorithm selects from a total of 16 
million possible colors (8 bits each for red, green and blue). In some cases, especially 
rasterizing drawing with solid areas or gradient fills, this option produces much better results 
that 5 or 6-bit quantization. However, it is quite a bit slower, and will use very large amounts 
of memory if the number of colors in the original image is high. Not suggested for 
photographic images.

Optimized (popularity). Selects the n most-used colors in the original image.

Grayscale. Creates a fixed levels-of-gray palette, with n evenly spaced colors.

ThumbsPlus Color. Selects the same colors used in the ThumbsPlus thumbnails; this is also 
the palette used for the Quick Dithering option (see below).

Windows Color. Uses the 16 standard Windows colors (yuck - but sometimes you need 'em).

Standard VGA. Selects the default 16 VGA palette colors.

6x7x6 Even Distribution. Creates a palette with 6 levels of red, 7 of green and 6 of blue, 
evenly spaced. (Not very pretty for most images, but okay for some dithering jobs.)

6x6x6 Even Distribution. Creates a palette with six levels each of red, green and blue, 
evenly spaced. This is similar to the 6x7x6 palette, but more useful for pictures with large 
amounts of gray.

Indeo. Uses the 236-color Indeo palette recommended for video frames. This is also a very 
useful general palette, somewhat similar to the ThumbsPlus palette.

Cinepak. Uses the recommended 236-color Cinepak palette recommended for video 
composition.

Pasted from Clipboard. Pastes a palette from the image on the clipboard. This is useful for 
adapting several images to a common palette.

Loaded from File. This option allows you to load a palette from an existing graphics file, or 
from a ThumbsPlus palette file (.PAL), which you may create using the Save Palette As... 
option on the View window File menu.

Identity palette. Checking this box will cause ThumbsPlus to adjust any 17 to 236 color palette 
to be a Windows identity palette, placing the 20 Windows system colors in the first 10 and last 
10 color map positions.

Dither. When reducing the number of colors in an image, you may select a dithering method 
from those listed below.

(none). No dithering. Colors are simply mapped to the closest available color in the selected 
palette.

Floyd-Steinberg. The most popular error diffusion dithering method. Fairly quick with 
reasonable results.

Burkes. Another error diffusion dither. Takes slightly longer than Floyd-Steinberg, and 



sometimes produces nicer results.

Stucki. A fairly complex error diffusion dither. Slower than Floyd-Steinberg or Burkes, but 
usually the nicest results, especially for truecolor to 256-color conversions.

ThumbsPlus retains the last selections you made in this window so you can apply the identical 
changes to subsequent files, or during batch processing.



Image | Color Adjust C

Use this selection to alter the brightness, contrast, gamma and red, green and blue levels in an 
image.

Brightness. This control changes the overall brightness of an image. Use negative values to 
darken an image, and positive values to lighten it. Use the arrow keys or the mouse to change the 
value.

Contrast. This control changes the contrast; that is, the difference between the light and dark 
areas. Positive values increase the difference between them, while negative values decrease the 
contrast.

Gamma. This control changes the color values or gray levels in an image to provide for a 
specific gamma correction. The display itself doesn't change (because ThumbsPlus knows the 
new assumed gamma value, and adjusts for it!), but the image itself does. This is most useful if 
you have linear files (gamma = 1.0), and wish to make them "standard" GIF files (gamma = 2.0), 
so they will display reasonably correctly with viewers which don't provide gamma correction.

R, G, B. These controls modify the amount of Red, Green and Blue in the image. They work 
similarly to the Brightness control, but individually on each color channel.

None. Sets all controls to zero.

View. On Truecolor or Highcolor displays, this button repaints the image with the selected 
changes. This button is absent on 256-color displays, as ThumbsPlus automatically animates 
palette of the image to show the changes.

Note that ThumbsPlus "remembers" the last values you used to adjust an image, so you can use 
them to adjust another, or as input to Batch processing of images.



Image | Convert to Bitmap B

This option converts a metafile to a bitmap. You may enter the desired height and width, and 
whether or not to maintain the original aspect ratio of the metafile. 

Width. Enter the desired width of the bitmap. This defaults to the current window width.

Height. Enter the desired height of the bitmap. This defaults to the current window height.

Maintain aspect ratio. Select this option to force the bitmap to be the same aspect ratio as the 
original metafile. This defaults to the setting of the Maintain Aspect Ratio option in the View 
window.



View Menu

Full Screen F3
Autosize Window Ctrl+F6
Maintain Aspect Ratio Shift+F6
Assumed Gamma… G
Zoom In Z
Zoom Out Shift+Z
Zoom to Fit All F6
Zoom to Fit Width Ctrl+W
Gridlines L
Comments F7
Properties Ctrl+I
Customize Toolbar Ctrl+T
Toolbar T
Status Line S



View | Autosize Window Ctrl+F6

This option will make the view window the same size as the image displayed in it (if possible).



View | Assumed Gamma G

This dialog box allows you to assign the assumed gamma value for an image, and to set the 
default for a file type (so that any files loaded with the given type will be assumed to be adjusted 
for that gamma value.)

Use the arrows or the mouse to change the assumed gamma value. Select a value of zero (0.0) to 
turn off gamma correction for this image.

Check Set Default for Type to assume the selected value for all loaded images of this file's file 
type.

If you're using a palette-based (256-color) display driver, the change will be immediately visible. 
For 24-bit (truecolor) and 16-bit (highcolor) displays, you must click on the View button to see 
the changes.



View | Maintain Aspect RatioShift+F6

This option causes ThumbsPlus to maintain the original file's aspect ratio when stretching to fill 
the window. This applies to both metafiles and bitmaps.



View | Zoom to Fit All F6

When this option is checked, the image will be stretched (or shrunk) to fill the size of the 
window. Note that you cannot select portions of the image when stretched.



View | Zoom to Fit Width Ctrl+W

When this option is checked, the image will be stretched (or shrunk) so that the width of the 
graphic fits the width of the window. This is most useful for portrait-oriented files, such as 
documents.



View | Gridlines L

This option toggles the display of grid lines between pixels when zoomed in by 4x or more.



View | Zoom Out Shift+Z

This function zooms back out after Zooming in.



View | Zoom In Z

This selection "zooms in" on the current bitmap or metafile. For bitmaps, each pixel is shown as 
a square. For metafiles, only a portion of the file is viewed, but at increased magnification.

It is useful for viewing details in an image. It does not modify the image itself -- use Image | 
Rotate/Resize for changing the size of an image.

You can select Zoom In multiple times to view progressively smaller areas of an image. You may 
also use the keys 1-9 to zoom from 1x (unzoomed) to approximately 9x.



View | Comments F7

When this option is available, it indicates that the graphic being viewed has comments embedded 
in it. Select it to view these comments. Comment viewing is currently supported for the 
following types of files:

GIF - version 89a comment field

JPEG - COM marker field(s)

TIFF - Description tag



View | Full Screen F3

This option causes the View Window to use the entire screen, without title bar or menus. If the 
image is larger than the screen, you will still have scroll bars. While in full screen mode, use the 
right mouse button or the F10 key to see the View Window menus, which will appear vertically 
instead of horizontally. You can perform any of the View Window commands while in full screen 
mode; however, cropping an image will reduce the window to the size of the cropped image. You 
can select View-Full Screen again or press F3 to exit full screen mode.



View | Properties

If the current image was loaded from a file, this selection shows the Properties Dialog for the file 
on disk. Changes made since the file was loaded are not shown.



View | Customize Toolbar

Use this dialog box to configure the ThumbsPlus toolbar to your liking. Most menu commands 
are available as toolbar buttons; simply drag the ones you want to the place you want on the 
toolbar.

You can also move buttons on the toolbar, or drag them completely off to remove them. Buttons 
may only be on the toolbar once – if you add a button a second time, it will move to the new 
position.

You may make two rows of buttons, but the second row will not display properly until you select 
OK to save your changes.

You may also double-click the toolbar to open this dialog box.

There is no keyboard interface for customizing the toolbar (toolbars are for mice, aren't they?).

Available buttons. Shows the buttons available for the toolbar. Drag a button to the toolbar to 
add it.

Large buttons. Selects the larger size of toolbar button (32x32 pixels), versus the small version 
(20x20 pixels).

Text on buttons. Adds descriptive text (as in Tool Tips) to each button. This makes the buttons 
quite a bit larger.

Enable Tool Tips. Enables tool tips, which will describe each button if you leave the cursor over 
it for about a second.



View | Toolbar

This selection turns the view window toolbar on or off. If the toolbar is currently on, this option 
will be checked.

· If you want to have a toolbar for each new view window, use Options | Preferences • 
Viewing from the main window.

· To customize the toolbar, use View | Customize Toolbar.

· The toolbar is hidden in full screen mode.

· When using a display driver with 256 or fewer colors, the toolbar may appear ugly – its 
colors must be mapped to the current image colors.



View | Status Line

This selection turns the view window status line on or off.

· If you want to have a status line for each new view window, use Options | Preferences • 
Viewing from the main window.

· The status line is hidden in full screen mode.

The fields in the status line are:

1 Modified flag. The text MOD is darkened if the image has been modified.

2 Quick-Dither flag. The text Q8 appears when a 24-bit image is dithered to 8 bits for 
display on a 256-color display driver.

3 Zoom factor. When using the integral zoom (2x to 9x), this field indicates the current 
factor.

4 Image size and depth. This field contains the width, height and color depth (in bits) of 
the current image.

5 Selection size. The size of the currently selected area of the image. This field is blank if 
no selection is active.

6 Position. When selecting, this field contains the coordinates of the upper-left corner of 
the selection rectangle. When no selection is active, this field contains the current cursor 
position in the image.

7 Pixel color. This field shows the current pixel color (red, green, blue). Each sample 
ranges from 0 to 255. When selecting, this is the color of the anchor point of the 
selection (the first point selected).



Help Menu

Help Topics F1 Displays the ThumbsPlus Help contents
Menus Displays help for the main menu
Error Messages Displays help for error messages
License Displays the shareware license
Ordering! Provides ordering information
Search for Help on… Ctrl+F1 Allows you to search the Help file
About ThumbsPlus… Show the ThumbsPlus About box

ThumbsPlus Menu

This "quickie" menu, which has no drop-down items associated with it, simply brings the 
ThumbsPlus main window to the top of all windows. It is useful when a large view window 
obscures or covers the ThumbsPlus main window.



Help Menu 

This menu provides access to the ThumbsPlus Help system and the About box.



Additional Information
Hints and Tips
Windows Display Drivers
.INI and .TUO File Settings



Hints and Tips

File Manager Drag & Drop. ThumbsPlus will act as a drag-and-drop client from File Manager. 
Simply drag file names from File Manager to the ThumbsPlus window (or icon). ThumbsPlus 
will open a view window for each file (up to the maximum number of view windows specified in 
the Viewer Options). You can also drag files from ThumbsPlus to other applications.

View Window Shortcuts. Double-clicking with the left mouse button in a view window will 
change it to full screen mode. Double-clicking with the right mouse button in a view window 
will close the window.

Metafile Viewing. If you're displaying true-color (24-bits) or standard VGA, turn on "Dither 
Metafiles" from the Viewer Options dialog box. In the case of true-color, Windows never dithers; 
in the case of standard VGA, the special code to create solid colors for the dithered colors cannot 
work.

Background Colors. For full-screen displays of 256-color images on a palette-based (256-color) 
display, select either black or white as the background color from the Viewer Options or the 
Slide Show Options dialog box, as ThumbsPlus steals the other system colors to more accurately 
display the image.

Internal Drag & Drop. Although ThumbsPlus has only a single window, you can drag files to 
directories not visible on the directory list by scrolling it after selecting the files you want to 
move or copy.

Performance. Though there is no built-in limitation on the number of file ThumbsPlus can 
handle, I recommend creating multiple catalogs (databases) if you have more than about 5000 
files. Besides reducing the memory required to handle the index, smaller catalogs will speed up 
access to thumbnails in the database.



Windows Display Drivers

ThumbsPlus works best with highcolor (15 or 16 bit) and truecolor (24 bit) color, but also works 
well in 256-color (8 bit) modes. You should select an appropriate driver for your display adapter 
using the Control Panel.

Click here to set up your display drivers using the Control Panel.

Selecting a Driver

Several different color depths and screen resolutions may be available; here is some information 
on the possible choices:

Four different color depths are generally considered "Super VGA;" these are:

256-color (8 bits required per pixel)

This provides the minimum number of colors to display a single color graphic; multiple 
graphics must usually share some colors, so quality is sacrificed on all but the "top most" 
window. 24-bit graphics must be pre-processed before display to achieve reasonable color; 
ThumbsPlus uses a fast "quick-dither" to the thumbnail palette. This is indicated by a [Q8] 
appended to the file name in the view window title bar.

32768-color (16 bits required per pixel)

This mode divides the 16 bits into 5 red, 5 green and 5 blue pixels. One pixel is not used. 
This provides much better viewing capability than the 256-color mode, but requires more 
video memory. You can simultaneously view multiple 256-color graphic files. Truecolor (24-
bit) files will suffer some loss in quality (because nine bits of each pixel are ignored), and 
may be somewhat slower to display because the display driver has to "map" the colors.

65536-color (16 bits required per pixel)

This mode provides similar capability to the 32768-color mode, with (very) slightly better 
results. The extra (16th) bit is usually used for green.

16-million color (24 bits required per pixel)

Eight bits are used for each color (red, green, blue). This provides true color viewing -- no 
color information is lost from 24-bit images, and as many as desired may be viewed 
simultaneously. This is the most accurate color mode, but generally slower than 256-color 
mode.

Your video card may be capable of several different color depths and several different 
resolutions. Here is a table showing the minimum amount of video memory required for most 
popular color resolutions for each color depth, rounded up to 512Kb (Kilobytes) increments. 
Note that video memory is separate from system memory -- it's on the video card itself, and not 
usable for programs or data.

256 (8-bit)
32768/65536

(Hicolor)
16.7 Million
(Truecolor)

640x480 512Kb 1Mb 1.5Mb



800x600 512Kb 1Mb 2Mb

1024x768 1Mb 2Mb 2.5Mb

1280x1024 1.5Mb 3Mb 4Mb

1600x1200 2Mb 4Mb 6Mb

Video cards with less than 512K of memory are not capable of running Windows with more than 
16 colors.

Your monitor must also be capable of displaying the required vertical and horizontal resolution.

Using higher color depths also requires more system memory, as bitmaps are often stored in 
system memory at the color depth (bits per pixel) required for the current display.



.INI and .TUO File Settings

The following tables list the global and database-specific paramaters, and indicate the menu or 
dialog box from which the parameter can be changed:

Global Parameters (THUMBS.INI)

Section Parameter Menu/Dialog box Description

 [Registration] UserName File>Register Your user name; entered when you register 
ThumbsPlus

UserCode Your user code; assigned when you register 
ThumbsPlus.

[Startup] WindowLeft,
WindowTop,
WindowWidth,
WindowHeight

Options
>Save for Startup
>Window Position

These parameters store the initial position and size 
of the ThumbsPlus main window for startup.

ThumbnailFile Options
>Save for Startup
>Initial Database

Path and file specification of the initial database for 
ThumbsPlus to load when starting. This may be 
overridden by specifying a database on the 
Command Line for the ThumbsPlus icon.

No3dControls (none) When non-zero, disables 3-D controls and dialog 
box appearance.

[Confirmations] FileDeletions Options>Confirmations When non-zero, requests you to confirm deletion of 
any file.

FileCopies Requests for confirmation for copying files.

FileMoves Requests for confirmation for moving files.

Directory... (Not yet implemented)

CloseModified
Window

Requests confirmation when closing a view 
window that has changed (been edited).

CloseApplication Asks "Are you sure you wish to exit ThumbsPlus" 
when you close the main window.

FileOverwrite Requests confirmation before overwriting a file 
with the same name (copy or move).

[KnownFilters] Options
>File Types
>Configure
>Hunt for Filters

This sections contains a list of the graphic import 
filters which have been located using the Filter 
Hunt dialog box.

[JpegLoading] QuantizeColors Options>Jpeg Loading Selects whether the JPEG library reduces the color 
depth during the load of an image.

TwoPassQuant When quantizing colors, selects whether a two-pass 
quantization is selected.

Grayscale Discards color information and loads JPEG images 
in grayscale.

Dither Selects whether dithering is performed when 
reducing the color of a JPEG image on load.

QuantColors The number of colors to reduce to, when 
QuantizeColors=1.

[Batch] Format File
>Batch Edit/Convert

File format (i.e., BMP) in which to store batch 
converted files.

AutoCrop Autocrop images during the batch conversion.

Resize Rotate or resize during the batch conversion.

ColorAdjust Images are color adjusted during the batch 
conversion.



Depth Specifies whether the color depth is adjusted.

Overwrite Overwrite files with the same name.

AltExtension Specifies an alternate file extension for output files.

OutputPath Specifies the directory where converted files are 
placed.

[AutoPaste] Prefix Edit>Auto Clip Save Indicates the prefix for file names that are saved.

Sequence Next sequence number to use for Auto Clipboard 
Save.

Format File format for files saved from Auto Clipboard 
Save.

ConvertMetafiles Specifies whether metafiles are converted to 
bitmaps.

OutputPath Location to store Auto Clipboard Saved files.

[Directories] SaveAs View>File>Save As Destination directory for Save As... dialog box.

Copy Files File>Copy Destination directory for copying files.

Move Files File>Move Destination directory for moving files

Local (Database Specific) Parameters (THUMBS.TUO)

Section Parameter Menu/Dialog box Description

 [Startup] InitialDirectory Options>Save Startup
Directory

Initial open directory in the directory list.

[FileTypes] SelectedTypes Options>File Types List of file types which are selected in the File 
Types dialog box.

[Options] AutoCropClipboard Options>General Set to one (1) to automatically crop images when 
copied to the clipboard.

AutoCropThumbnail Set to automatically crop images when making 
thumbnails

AutoCropView Set to automatically crop images when viewing.

MinimizeOnCopy Set to automatically minimize the ThumbsPlus 
window whenever an image is copied to the 
clipboard.

MinimizeOnView Set to automatically minimize ThumbsPlus 
whenever an image is viewed.

MinimizeOnEdit Set to minimize ThumbsPlus whenever an image is 
passed to an external editor.

AutoRemoveOrphans Set to automatically remove orphans when 
changing to a new directory.

DefaultAction Specifies the default action to perform when 
double-clicking an image.

Font The parameters for the font used for the file and 
directory lists. (size; weight; italic; typeface; style)

[FileList] Order Options>File List Specifies the order in which files are listed.

ShowFlags Coded value for what to show for each file.

UseMask Whether or not to use a file mask rather than the list 
of selected types from the Options>File Types 
dialog box.

Mask The file name mask to use for the file list.

ThumbnailSize The size of thumbnails, in percent (100, 150, 200).

ShowFontNames Whether to show font names rather than the file 
names for Truetype fonts.



[Menu] IndicateExpandable
Branches

Tree>Indicate
Expandable

Show expandable (or collapsible) directories with a 
"+" (or "-").

IndicateBranchesWith
Thumbnails

Tree>Indicate
Thumbnails

Show directory branches with thumbnails by color-
coding.

ShowThumbnail
BranchesOnly

Tree>Show Thumb
Dirs Only

Only show directory branches with thumbnails.

ShowOfflineVolumes Tree>Show Offline
Volumes

Include off-line (i.e., diskette and CDROM) 
volumes in the directory list.

StatusLine Options>Status Line Hide (0) or display (1) the status line.

Toolbar Options>Toolbar Hide (0) or display (1) the toolbar.

DirectoryListWidth (none) Specifies the last set directory list width (using the 
vertical spacer between the directory and file lists).

[Catalog] Font File>Print    Catalog Parameters of the font for catalog printing. (size; 
weight; italic; typeface; style)

Margins File>Print Catalog Margins for the catalog pages (left, top, right, 
bottom)

PrintFileNames Print file names below thumbnails in catalog (0,1).

CatalogTitle Title to print at top of catalog.

LineSpacing Spacing between lines

ThumbnailSize Scaled size of thumbnails (100-1000 percent)

Columns Number of columns of thumbnails

[PageSetup] LeftMargin,
RightMargin,
TopMargin,
BottomMargin

File>Print Setup
>Page Setup

Margins for image printing (in units defined from 
International Control Panel settings).

StretchToFit Stretch images to fit page (within margins).

MaintainAspectRatio Maintain aspect ratio when stretching images.

DrawBorder Draw a border around the image.

[SlideShow] BackgroundColor File>Slide Show Color index for background color for slide show.

DelaySeconds Number of seconds to delay between "slides."

ManualControl Set to advance slides with left mouse or keystroke.

StretchToScreen Stretch images to fit screen.

MaintainAspectRatio Maintain height : width aspect ratio when 
stretching.

HideCursor Hide the mouse cursor

ConvertMetafilesTo
Bitmaps

Convert metafiles (vector graphics) to bitmaps 
before displaying.

SkipSmallFiles Skip any files smaller than the specified size.

SmallFileWidth,
SmallFileHeight

Minimum size of files to display in slide show

RandomOrder Set to process files in random order (shuffled).

[Viewer] StretchImageToFit File>View Stretch images to fit window when window is 
resized.

FitPageWidth Stretch image to fit the width of the window 
(vertical scroll only).

MaintainAspectRatio Maintain the proper aspect ratio when stretching 
images or metafiles.

DitherMetafiles Use quick (unoptimized) display for metafiles.

InitialSize Coded value for the initial window size.



BackgroundColor
Index

Color index of background color.

MaxViewWindows Maximum number of view windows that may be 
simultaneously opened (2-40).

AutoDisplay
Comments

Automatically bring up a comment display window 
when viewing any image that has internal 
comments.

[Comments] Font View>View
>Comments

Font parameters for displaying comments (size; 
weight; italic; typeface; style)



Ordering Information

Here's what Adam, Leah and Evan Crews think of people who use ThumbsPlus past the 30-
day evaluation period without registering!

ThumbsPlus is distributed as shareware for evaluation for thirty days (see License). Please 
remember that using unlicensed shareware past the evaluation period is unethical and illegal. To 
register and receive the latest version of ThumbsPlus, please complete the order form. 

Ordering ThumbsPlus Online:

CompuServe
Internet

Ordering ThumbsPlus by telephone (credit card orders)

Cerious Software, Inc.
Public Software Library (PsL)

Ordering ThumbsPlus by mail, fax or phone:

U.S. Japan
Australia The Netherlands
Belgium United Kingdom
Denmark Other Countries
Germany



CompuServe

ThumbsPlus may be registered on-line on CompuServe by "GO SWREG." The registration ID 
for a single-user ThumbsPlus license is 1357. You may also register several of the site license 
options via SWREG.



Internet (World Wide Web)

ThumbsPlus can now be ordered via secure WWW server (https). Please select "Secure Order" 
from our home page at http://www.cerious.com. An unsecured form is also available for users 
without an appropriate browser.



Ordering - Cerious Software, Inc.

You may place credit card orders (Visa and MasterCard only) with Cerious Software, Inc. 
directly. Please have your information ready (see the order form) and call:

704-529-0200



Public Software Library (PsL)

Telephone orders by credit card are accepted through the Public Software Library. Specify 
product #11209.

Voice:  800-242-4775
        713-524-6394

PsL will notify us the day of your order and we will ship the product directly to you. Any 
questions about the status of shipment, refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc., must be directed to Cerious 
Software, Inc. directly.



ThumbsPlus Order Form (U.S. and Other)

Click here to print this order form on 8.5x11 or A4 paper in portrait mode. If you do not have a printer, please write or type the 
information requested below. You may also use the order form built into the ThumbsPlus program (File | Register).

I like ThumbsPlus and want to register it. I understand I will receive the latest version, a printed manual, support via the Internet, 
CompuServe, America Online or telephone, and the peace of mind that comes with "doing the right thing."

Name

Organization

Address

City State Country Zip/Postal Code

Telephone number E-mail address

Please let us know where you obtained ThumbsPlus:____________________________________

Quantity License Price (USD) Quantity License Price (USD)

    ____ Single-user $      65     ____ 5 user concurrent 310

    ____ 5 user site 245     ____ 10 user concurrent 605

    ____ 10 user site 470     ____ 25 user concurrent 1460

    ____ 25 user site 1140

    ____ Extra manuals 5 (with multi-user licenses only!)

    ____ Manual on disk (MS Word) 10 (with multi-user licenses only!)

    ____ Manual on disk (TIFF) 15 (with multi-user licenses only!)

q U.S. shipping $        5
q Canadian shipping         7
q Other Int'l Shipping         10
q NC Sales Tax ______ (NC residents only)

    Total: __________

    Payment: q Check or Money Order q Visa q MasterCard

|__|__|__|__|      |__|__|__|__|      |__|__|__|__|      |__|__|__|__| |__|__| |__|__|
Authorized Card Holder Number month year

Expiration Date

_________________________________________ ______________
Authorized Cardholder Signature Date

Please remit to:

Cerious Software, Inc.
1515 Mockingbird Lane, Suite 910
Charlotte, NC 28209 USA

You may also fax credit card orders to 704-529-0497.



Japanese Version



Order Form - United Kingdom

The Thompson Partnership (United Kingdom)

You can order from The Thompson Partnership by payment with cheque or credit card.    The credit cards accepted 
are: MC, Visa, Diners Club, and American Express. 

Telephone Orders: 44 (0) 889 564601
Fax Orders: 44 (0) 889 563219
Internet Orders: sales@ttp.co.uk
Internet Support: support@ttp.co.uk

Please use this form when ordering by fax or mail:

Name ________________________________________________

Company _____________________________________________

Address ______________________________________________

Address ______________________________________________

Town ________________________________________________

City _________________________________________________

Country _______________________    Postal Code ___________

VAT Number (Applicable to non-UK orders ONLY)

_____________________________________________________

Telephone _______________________________

Credit Card Type __________________________

Credit Card Number _______________________

Expiration Date ___________________________

Disk Size: 3.5"

____ Copies of Thumbs Plus @ £39.00 £____________

V.A.T.    @ 17.5% £____________

Shipping and Handling £3.00

Total: £____________

Make cheques or EuroCheque payable to: The Thompson Partnership.
(Be sure your card number is on the reverse of the cheque)

Mail to:

The Thompson Partnership
Lion Buildings
Market Place
Uttoxeter
Staffs
ST14 8HZ



Ordering in Japan (English version)

Please contact:

P.&A. Shareware Distribution
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196 Japan

Tel: 0425-46-9141
Fax: 0425-46-9142
CompuServe: 76663,124
NiftyServe: PAF02461

Click for information on the Japanese version.



Ordering in Denmark (English version)

Please contact:

Kelds Shareware
Aabrinken 3
7850 Stoholm Denmark
CompuServe: 100342,1543



Order Form - Germany (English or German version)

Registrier-Formular ( für Bestellungen beim PD-PROFI)

Name ________________________________________________

Firma ________________________________________________

Straße ________________________________________________

Plz/Ort ________________________________________________

________________________________________________

Tel. _______________________________________________

Fax. _______________________________________________

EMail _______________________________________________

Hiermit bestelle ich zu Ihren Geschäftsbedingungen:

___x    registrierte Version Thumbs+Plus DEM 59.-- deutsch (2.0)

___x    registrierte Version Thumbs+Plus DEM 89.—englisch (3.0)

Porto/Verpackung Inland DEM 10.--

Nachnahme zuzüglich DEM 5.--

total: DEM _____

Zahlungsweise: Visa    (    )      MC    (    )      AMEX    (    )      Scheck/bar    (    ) 

Lastschrift    (    )      Nachnahme    (    )

Lastschrift: Kontoinhaber: _____________________________

Kontonummer: _____________________________

BLZ: _____________________________

Bank: _____________________________

Kreditkartenbestellungen:

Karten-Nummer: ______________________________    gültig bis:    ____/____

Karteninhaber:    __________________________________

Auslandskunden erfragen die Preise bitte telefonisch oder per Fax. 

Unterschrift (des Erziehungsberechtigten)    _______________________________

Bitte senden oder faxen an:

PD-Profi Zöttlein Software Vertriebs GmbH Tel.    +49-8432-1296
Schulstr. 13 Fax. +49-8432-8674
D-86666 Burgheim-Wengen CIS. 100326,53



Thumbs+Plus v3 Bestelformulier voor Nederland en België

 Klik hier om het formulier af te drukken!

Met dit formulier kunt u de geregistreerde versie van Thumbs+Plus bestellen. Vul het formulier daartoe volledig in, en stuur het 
tezamen of gelijktijdig met uw betaling naar:

CopyCats Software & Services
Postbus 1088
1700 BB    Heerhugowaard (NL)
Tel/Fax +31 (0)72-5745993
E-mail 100121.1562@compuserve.com

U ontvangt uw bestelling dan binnen enkele dagen per post.    Door registratie wordt u legaal gebruiker. U ontvangt een gedrukte 
handleiding (geldt niet voor economy-versie) en de nieuwste geregistreerde versie van de software. U kunt een beroep doen op 
technische ondersteuning en u wordt op de hoogte gehouden van het verschijnen van upgrades. De geregistreerde versie biedt 
diverse extra mogelijkheden, zoals digitale beeldfilters en effecten, histogrammen en ondersteuning van TWAIN scanners 
en .AVI, .MOV, .DXF en Adobe Type-1 bestanden. Bovendien kan hij bestanden in .ZIP-files rechtstreeks benaderen! 

Naam    : Dhr / Mw _________________________________

Bedrijf : __________________________________________

Adres   : __________________________________________

Postcode: ______________  Woonplaats: ______________

Telefoon: _________________ fax: ___________________

BTW-nummer (Belgische bedrijven): |B|E|-|_|_|_|_|_|_|_|_|_|

JA, Thumbs+Plus bevalt mij! Stuur mij:

Stuks: Produkt:                              Prijs:                Totaal: 

___ x  Thumbs+Plus full registered version á Dfl 119,50 / 2210 BEF  ________

___ x  Thumbs+Plus economy version*        á Dfl 89,95 / 1665 BEF  ________

                                                  Totaalbedrag**:  ________

*:    De economy-version is identiek aan de 'full' version, maar wordt zonder gedrukt handboek geleverd. 
**: Deel s.v.p. het totaalbedrag door 1,175 indien u uw BTW-nummer vermeld hebt.

Betaalwijze (één keuze aankruisen s.v.p.):

[      ]      Bijgesloten cheque of girobetaalkaart in Dfl of BEF (volledig invullen s.v.p.).
[      ]      (NL) Overgemaakt aan Postbank 43.28.577 t.n.v. CopyCats
[      ]      (B) Overgemaakt aan Postrekening 000-1656064-80 t.n.v. CopyCats
[      ]      Op rekening (bedrijven en overheidsinstellingen)

Overige:

Datum:      ____-____-19____

Handtekening: ______________

Hoe kwam u aan deze evaluatie-versie van Thumbs+Plus?:    ____________________________

Genoemde prijzen zijn inclusief 17,5% BTW en order voorbehoud. Ook site-licenses zijn leverbaar - bel s.v.p. voor prijsinformatie.

Dank u voor uw bestelling!



Evaluation License

ThumbsPlus is supplied "as is". The author disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any purpose. 
The author assumes no liability for damages, direct or consequential, which may result from the 
use of ThumbsPlus.

ThumbsPlus is provided free of charge for a thirty day evaluation period. Any use beyond this 
period requires that ThumbsPlus be registered with the author, Cerious Software). This 
registration fee will license one copy of ThumbsPlus for use on a single computer. Site licenses 
are also available.

If you wish to distribute ThumbsPlus, alone, as part of a package, or in any publication, and 
receive any type of remuneration, you must contact Cerious Software for authorization and 
terms.

If you believe ThumbsPlus is valuable and useful, please give it to anyone else you think would 
be interested, and encourage them to register their copy.

ThumbsPlus may not be distributed as part of or for use with any commercial product 
without express written permission from Cerious Software, Inc. For information about the 
CD-ROM Developer's Kit for ThumbsPlus (Thumbs+CDK), please contact Cerious 
Software.

License statement required by Unisys Corp. for licensing LZW compression:

Use of this software is permitted only to the extent reasonably required to determine whether to 
purchase the software.

After payment is made, use of this software is limited to use on only a single personal computer 
or workstation which is not used as a server. An additional payment is required for each use on 
another personal computer or workstation.

Only a single copy may be made of this software solely for backup or archival purposes. The 
software may also be transferred to a single hard disk.

Any use of this software in violation of the above is not licensed.

For information concerning licensing the LZW compression and/or decompression capability, 
please contact:

Unisys Corporation
Welch Licensing Department - CISW19
Township Line & Union Meeting Roads
PO Box 500
Blue Bell, PA 19424 USA



Site Licenses

Cerious Software, Inc. offers corporate and site licensing for ThumbsPlusTM. These licenses 
provide all major upgrades to ThumbsPlus for one year, unlimited support by telephone or 
electronic mail (CompuServe or Internet), and maintenance releases when required.

Licenses may be upgraded for the difference between the price paid for the original license and 
the current cost of the new license. Licenses may be renewed each year for 25% of the license 
cost. This will continue the updates and support for an additional year.

Site Licenses

Cerious Software, Inc. will provide a single distribution, which may be installed on the number 
of licensed systems or placed on an internal company network for use by the number of licensed 
users.

LPK-5 5 users $    245.00

LPK-10 10 users 470.00

LPK-25 25 users 1,140.00

LPK-50 50 users 2,145.00

LPK-100 100 users 3,900.00

LPK-200 200 users 6,500.00

Concurrent Usage Licenses

Cerious Software, Inc. will provide a single distribution kit, which may be installed on a 
network-available system to be used by no more than the licensed number of users at any given 
time.

CPK-5 5 users $    310.00

CPK-10 10 users 605.00

CPK-25 25 users 1,460.00

CPK-50 50 users 2,860.00

CPK-75 75 users 4,150.00

CPK-100 100 users 5,390.00

Corporate License

This license offers use of ThumbsPlus on unlimited computers in the licensed organization. 
Cerious Software, Inc. will provide distribution for up to ten (10) sites, each of which may be 
installed on as many machines as desired, or placed on internal company networks. Cerious 
Software reserves the right to limit the scope of the definition of "organization."

LPK-CORP unlimited users $7,500.00

Prices are in US dollars, effective 1 Feb 1996, and subject to change without notice.



Ordering - Australia, New Zealand, PNG

Click for the order form.

  

Australian Shareware Registration Price List
Cerious Software, Inc. - SOLE Authorised Agent for Aust., PNG & NZ.

THUMBS+PLUS! v2.0d/v2.1 Graphics file manager, editor, viewer & cataloguer for Windows
AUS$95

THUMBS+PLUS! PRINTED MANUAL*
A4 size , thermal bound $15

THUMBS+PLUS! MANUAL ON DISK*
(.TIF or W4W v6 format) $5

THE MANDELBROT SET v3.0a
Random graphics generator for Windows $40

All programs are available as shareware at $10 for the first disk & $5 ea for subsequent disks (rebatable if 
programs ordered are registered within 30 days).

* All Manuals and Utilities Disks are available to REGISTERED USERS ONLY

Registration fees may be made by cheque/money order made out to:- Patrick O'Sullivan (address below) 
or by direct deposit. Deposit/Credit slips are available at any National Australia Bank branch. Just fill in 
the date, deposit amount and the appropriate boxes as follows:-

Branch name Prahran - Dandenong Credit Union Co-Operative Ltd.
Account name CREDIT P. O'Sullivan
Branch BSB number 083 422
Account number 10806 7706

and on the reverse of the deposit slip:-

Name and address of depositor.

Please include the above information with your order by fax, E-mail or post to any of the addresses at the 
bottom of this page.

NB: Please remember to keep the completed & stamped stub of the deposit slip as your
proof of payment.

Patrick O'Sullivan
PO Box 65
Armadale Vic 3143
Ph: 61-03-9509-5250
Fax: 61-03-9576-0801
CIS: 100240,273
pat@ozonline.com.au
pat@melbpc.org.au

Site & Corporate licenses are available upon enquiry.



Order Form - Australia, New Zealand, PNG

          Registration Details/Shareware Order Form

Your Full Name:__________________________________________

       Company:__________________________________________

       Address:__________________________________________

              :__________________________________________

              :__________________________________________

              :__________________________________________

    Home Phone:________________________________(Optional)

    Work Phone:________________________________(Optional)

E-Mail Address:__________________________________________

Preferred Disk Format: 1.2___ 1.44___

Programs ordered:_________________________@________

                :_________________________@________

                :_________________________@________

                :_________________________@________

                :_________________________@________

                :_________________________@________

                :_________________________@________

                                     TOTAL:________

Remit to:

Patrick O'Sullivan
PO Box 65
Armadale Vic 3143
Ph: (03) 9509-5250
Fax: (03) 9576-0801
CIS: 100240,273
Discovery: 350952500
Internet: pat@melbpc.org.au
Site & Corporate licenses are available upon enquiry.





Thumbs+Plus Error Messages
For errors reported directly by ThumbsPlus (the message number is displayed as part of the 
message), you can press F1 from the message box to go directly to the help topic for that 
message.

Select the message number from the list below. You may also press F1 when any message is 
displayed to view the help topic for that message. If the error is in the "Errors Encountered" area 
of the progress dialog box, you can select the error, then click on Help or press F1 for more 
information.

5001 5003 5004 5006 5007 5008 5010 5011 5012 5013 5014

5015 5016 5018 5019 5020 5021 5022 5023 5024 5025

5026 5027 5028 5030 5035 5036 5037 5038 5039 5040

5041 5042 5043 5044 5045 5046 5047 5048 5049 5050

5051 5052 5053 5054 5055 5057 5058 5059 5060 5061

5062 5063 5064 5065 5066 5067 5071 5072 5073 5074

5075 5076 5077 5079 5080 5082 5083 5084 5085 5086

5089 5090 5091 5092 5093 5094 5095 5096 5097 5098

5099 5100 5101 5102 5103 5104 5105 5106 5107 5108

5109 5110 5111 5112 5113 5114 5115 5116 5117 5118

5119 5120 5124 5125 5126 5127 5128 5129 5130 5131

5133 5134 5135 5136 5137 5138 5139 5140 5141 5142

5143 5144 5145 5146 5147 5148 5149 5150 5151 5152

5153 5155 5156 5158 5159 5160 5161 5162 5163 5164

5165 5166 5167 5168 5169 5170 5171 5172 5173 5174

5175 5176 5177 5178 5179 5180 5181 5182 5183 5184

5185 5186 5187 5188 5189 5190 5191 5192 5193 5194

5195 5196 5197 5198 5199 5200 5201 5202 5203 5204

                5205          5206          5207          5208          5209          5210          5211  5301 5302 5303

5304 5305 5306 5307 5308 5309 5310 5311 5312 5313

5314 5315 5341 5342 5343 6001 6002 6003 6004 6005

6006



[5001] Out of Memory

ThumbsPlus was unable to allocate the amount of memory required to do the function you 
selected. Because ThumbsPlus loads each graphic into a single memory block, you cannot load a 
file larger than about 16 megabytes, which is the largest memory block that Windows will 
allocate. Also, you must have enough physical RAM available -- Windows 3.1 does not page 
pieces of a single memory block.

There are several things you can do to make more memory available:

1. Close (rather than minimize) any applications that you aren't using.

2. Close any ThumbsPlus view windows which are open.

3. You can increase the amount of virtual memory that is available for programs using the 
Enhanced 386 area of the Windows Control Panel. Please refer to your Windows 
documentation or the on-line help for information.

If all else fails, you can buy more memory!

If the problem seems unrelated to actual memory usage on your machine, please report it to 
Cerious Software. 



[5003] Error creating thumbnail file

ThumbsPlus could not create the thumbnail file. Some things that may cause this error are:

1. The file name is invalid, or the directory path or drive doesn't exist.

2. The disk is read-only or write-protected.

3. The disk is full.

4. The network drive is no longer available.

5. The file is locked by another application on your system, or by another system on the 
network.

6. You don't have sufficient permission to create files in the directory on the network drive.

7. The file information on disk is invalid; run SCANDISK or CHKDSK to validate file and 
directory allocations.



[5004/<oscode>] Cannot open Thumbnail file '<filename>': <O/S error message>

ThumbsPlus could not find or open the specified thumbnail database file. The error reported by 
the operating system should also be shown, and you can look up that error code here in this 
documentation.



[5006] Error reading Thumbnail file

ThumbsPlus could not read from the thumbnail database file. This is generally caused by one of 
these problems:

1. The file is on a network drive which has become unavailable.

2. The file is corrupted, either internally or at the operating system level. In DOS, a 
SCANDISK or CHKDSK should be performed. The problem could be mis-allocated (cross-
linked) sectors.

3. A sector or sectors on the physical disk drive have gone bad. A SCANDISK with surface 
check may find the problem.

4. For a CDROM database, either the CDROM itself has actually failed (my kids have broken 
a couple!), the drive is dirty or not operating properly, or the DOS CDROM access software 
(MSCDEX and the driver for the particular model) is corrupted. Try rebooting your system.

For hardware or disk allocation problems, consult your system or operating system 
documentation for steps to correct the problem. If you don't have a backup, you may have to 
delete your .TDB file and rebuild your database.



[5007] Error writing thumbnail file

This error may be caused by several problems:

1. The disk or diskette is write protected.

2. A network drive has become unavailable.

3. Network permissions do not permit writing to the file.

4. The physical disk has bad sectors. A SCANDISK with surface test is recommended.

5. The allocation tables for the disk are invalid. A SCANDISK is recommended.

6. On a compressed partition, the operating system may not have reported the actual amount of 
free space, so ThumbsPlus sometimes cannot tell before writing that the disk would fill up. 
(When ThumbsPlus can tell, it reports error [5008]).

7. ThumbsPlus could not identify the drive as read-only when it opened the file. Except for 
some brain-damaged network software, this is not usually a problem.



[5008] Thumbnail file is full

ThumbsPlus could not allocate enough space on the disk to add the thumbnail. If you have 
moved or deleted a large number of thumbnails in the current database, you may be able to 
reclaim some disk space by purging the database. Otherwise, you'll need to move some files to 
another disk or partition, or remove unnecessary files.

Often, the temporary directory (usually \TEMP or \WINDOWS\TEMP) fills with unneeded files 
which may be removed. You should reboot your system and check this directory. Any files there 
which are not needed (often beginning with unusual characters such as '~', or having the 
extension '.TMP') may be deleted to recover disk space.

If you don't have a specific temporary directory, these files are often placed in the root directory 
of the C: drive. Be careful removing files from the root directory, as there are many files there 
needed by the system.



[5010] Error loading keyboard accelerators

This error is reported during startup if ThumbsPlus cannot access the keyboard accelerator tables 
in the resource. THUMBS.EXE is most likely damaged, or your system is very low on memory 
(see [5001]). 



[5011] Cannot find resource <name> 

Many of the tables, icons, bitmaps, cursors, strings and other information required during 
running ThumbsPlus are stored in the THUMBS.EXE file as resources. ThumbsPlus could not 
locate one it expected to be there.

Most likely, the THUMBS.EXE file is damaged. Reinstall and try again.



[5012] Cannot create file <filename>

ThumbsPlus could not create the file. Several explanations are likely:

1. The file name, directory path or drive is invalid.

2. The specified disk is read-only or unavailable.

3. The network drive is unavailable.

4. You don't have sufficient permission to create files on the network drive.

5. The disk is completely full.



[5013] Error reading file

This error appears when ThumbsPlus gets an operating system error attempting to read the 
contents of a file. It is generally caused by:

1. Internal file problems (i.e., pointers past end-of-file)

2. Invalid disk allocation information (run SCANDISK or CHKDSK to verify the integrity of 
your file and directory information on the disk).

3. A bad disk sector. Run SCANDISK with a surface test to see if there are bad (unreadable) 
sectors on the disk.

4. Disk drive failure.

5. A network drive becoming unavailable.



[5014] Format error in file

ThumbsPlus reports this error when it cannot process the contents of the file because they do not 
match published specifications, or because ThumbsPlus does not support the particular "flavor" 
of file. Sometimes ThumbsPlus will report this error for newer versions of a file type, as it no 
longer matches earlier specifications.



[5015] Unsupported file format 

ThumbsPlus reports this error when it finds unusual values in file information which preclude it 
from processing the file.

This may be because of a limitation in ThumbsPlus (for example, YCbCr TIFF files are not 
currently supported), or because a field in the header which ThumbsPlus depends on to decode 
the file has an invalid or unrecognized value.



[5016] Error accessing clipboard

        When ThumbsPlus attempted to open the clipboard (to copy or paste), another application 
had opened it without closing it. You may want to close other applications to see if you can find 
the faulty one -- applications should not keep the clipboard open.

If you cannot determine which application has locked the clipboard, restart Windows and try 
again.



[5018] Filter not found for type <filetype> 

ThumbsPlus has been directed to use a Graphics Import Filter to access the file type, but the 
specified filter was not found or could not be loaded. Check the File Type Configuration for the 
file type and correct if necessary.



[5019] Available memory restricted simultaneous open images to <number>

 You specified a number of open images larger than could be accommodated in the Viewer 
Options dialog box. Select a lower number to avoid this message.

Also, if you receive this message, you are probably running low on memory. The only memory 
ThumbsPlus attempts to allocate is for control information; no actual image memory has been 
allocated, so as soon as you try to operate on some file, you'll most likely get an [5001] Out of 
Memory error.



[5020] GIF Library error

The GIF library could not process the file. There will be additional information following this 
message which should give more detail for the problem.



[5021] Error creating child window!

ThumbsPlus failed during initialization or re-initialization to create a necessary window (i.e., the 
file list, the directory list or the toolbar).

This is a fatal error. ThumbsPlus will exit.

The only known causes are insufficient or corrupted memory. Restart Windows and try again.



[5022] Do you really want to delete file '<filename>'? 

This is just a question to be sure you really want to remove this file from your disk (using either 
the File - Delete option, or the trash can on the tool bar).

You can disable this confirmation using the Options - Confirmations menu selection. 



[5023]    Could not delete file '<filename>'

ThumbsPlus was unable to remove the file. The most likely reasons are:

1. The file is on a read-only (CD-ROM) or write-protected disk.

2. The file is on a network drive and you do not have sufficient permission to remove it.

3. The file is open by another application on your system, or on another system on the 
network. 

4. The file doesn't exit (the thumbnail is an orphan). In this case, you may remove the 
thumbnail without attempting to remove the file by using the Thumbnail - Remove menu 
option, or Shift+Delete.



[5024] Unrecognized file

ThumbsPlus could not identify the contents of the file. Note that ThumbsPlus uses the actual file 
contents rather than the file extension to make positive identification. The file may be in a format 
that ThumbsPlus does not support, or may be corrupted, or may be a more recent revision of the 
file format.



[5025] Insufficient memory to load file

ThumbsPlus could not allocate enough memory to load the file. For suggestions on making more 
memory available, please see error [5001] Out of Memory.

Some file types which are compressed require quite a bit more memory to load than is indicated 
by their file size. For raster (bitmap) types, the memory required will be at least as much as the 
width x height x color depth. In some cases, file decompression may require large amounts of 
memory in addition to this.



[5026] Do you wish to save changes to '<filename>'?

This question is asked when closing a view window which has been modified by one of the 
editing functions. You can disable this question altogether using the Options - Confirmations 
menu selection. 



[5027] Really exit ThumbsPlus?

This question verifies that you want to exit ThumbsPlus. It is only active if enabled from the 
Options - Confirmations dialog box.



[5028] Image has too many colors (>256) to save as a GIF file

GIF files are limited to 256 colors (8-bit color depth), and the current image is 24-bit. You must 
use the Image - Color Depth menu option (or the Color Depth button for batch conversion) to 
convert the file to 8-bit indexed color to save it as a GIF file.



[5030] Cannot execute command '<command>'

ThumbsPlus could not execute the command (most likely specified in the File Type 
Configuration dialog box). Check the command for syntax, and be sure that the program 
specified is either in a directory specified by the current PATH environment variable, or that the 
complete path is specified in the command line.



[5035] Error creating font resource for '<filename>'

ThumbsPlus could not temporarily install the font to generate a thumbnail or view of the 
character set. Generally, this is caused by a write-protected Windows SYSTEM directory, or by 
the disk being full. It may also be caused if the font resource file already exists.



[5036] Error adding font resource for '<filename>' to system.

ThumbsPlus could not add the font resource to the system. Possible problems include:

1. Insufficient network privilege to write the Windows or Windows System directory.

2. Insufficient memory or system resources. Try exiting Windows and restarting.



[5037] Could not match font in file '<filename>'

ThumbsPlus could not find the font name specified in the font file after it added to the system 
temporarily.

Usually this is caused by:

1. Invalid information in the .TTF file.

2. ThumbsPlus searching for the font name in a different encoding than Windows (both try to 
handle as many encodings as possible, but the order and types of encodings supported by 
Windows are not (yet?) documented, so we're doing our best!)

Please let Cerious Software know the font name and vendor of any fonts producing this message.



[5038] '<filename>' is not a directory 

When browsing for a directory, you entered a directory specification that was not valid. Check 
the entry or use the browse directory list    to select the directory.



[5039] Directory <directory> does not exist; do you wish to create it?

You specified a directory which does not exist. ThumbsPlus can create this directory if you want 
it to -- just click YES. If you entered an incorrect specification, click NO.



[5040] Unable to create directory '<directory>'

ThumbsPlus could not create the directory. This is generally caused by the same sorts of 
problems reported by error [5003].



[5041] The file '<filename>' already exists; do you want to overwrite it?

ThumbsPlus saw that the file you specified was already there. Click YES to replace it, or NO to 
leave it alone.



[5042] Cannot open

ThumbsPlus could not open the specified file. Some probable causes are:

1. The file no longer exists.

2. The network drive is no longer available.

3. The file is locked by another application on your system, or by another system on the 
network.

4. The file information on disk is invalid; run SCANDISK or CHKDSK to validate file and 
directory allocations.



[5043] Cannot create

ThumbsPlus could not create the specified file. Some probable causes are:

1. The file name is invalid, or the directory path or drive doesn't exist.

2. The disk is read-only or write-protected.

3. The disk is full.

4. The network drive is no longer available.

5. The file is locked by another application on your system, or by another system on the 
network.

6. You don't have sufficient permission to create files in the directory on the network drive.

7. The file information on disk is invalid; run SCANDISK or CHKDSK to validate file and 
directory allocations.



[5044] Error writing file

ThumbsPlus could not write to the file. Most likely causes are the same as for error [5007].



[5045] Could not delete (file was copied) 

When moving a file, ThumbsPlus was unable to delete the original, so the file was copied 
instead. Possible reasons that ThumbsPlus could not remove the original are the same as for error 
[5023].



[5046] Do you really want to move the selected files to <directory> ?

If the 'Moving files' box is checked from the Options - Confirmations dialog box, this question 
will be asked before ThumbsPlus moves files.



[5047] Do you really want to copy the selected files to <directory>?

If the 'Copying files' box is checked from the Options - Confirmations dialog box, this question 
will be asked before ThumbsPlus moves files.



[5048] JPEG error: <message> 

The JPEG library encountered an error attempting to read the file. More information about the 
specific problem should follow.



[5049] Load aborted by user 

This message displays if you abort loading a file (by pressing the ESC key).



[5050] The page size selected is not large enough to contain the catalog. Please 
select a larger page size and try again.

The selected page size    is not large enough. Since ThumbsPlus can print as small as diskette 
labels, the selected size must be really small!



[5051] Invalid margin(s) specified

You have selected margins that are either:

1. Smaller than allowed by your printer (for example, most LaserJets do not allow margins less 
than about .25 inches).

2. Too large (there's no space left to print after accounting for the margins).



[5052] ThumbsPlus cannot access the printer. 

ThumbsPlus could not open the printer. Use the Windows Control Panel to be sure that a valid 
printer is configured and set as the default.



[5053] No files could be loaded for the slide show, or all loadable files were too 
small

Of the files selected, none were capable of being shown -- either because the file type was not 
recognized or not viewable, or because the files were smaller than the minimum dimensions 
specified in the Slide Show Options dialog box.



[5054] <filename> is not a ThumbsPlus thumbnail catalog file 

The file you selected is not a valid database (.TUD) file. If it was a valid file previously, then 
most likely the header information has been corrupted. You may want to run SCANDISK or 
CHKDSK to check for file system problems, and you'll have to reload the file from backups.



[5055] Unable to create dialog box. ThumbsPlus is most likely corrupted and 
should be reloaded.

 ThumbsPlus could not create a dialog box for the selected function. Other possibilities (besides 
THUMBS.EXE corruption) are:

1. The Windows system is hosed and needs to be restarted.

2. Memory or resources are very low, so Windows should be restarted.



[5057]    Unable to rename '<filename>' to '<new name>'

ThumbsPlus could not rename the file. Most probable causes are:

1. The file is on a read-only (CD-ROM) or write-protected disk.

2. The file is on a network drive and you do not have sufficient permission to rename it.

3. The file is open by another application on your system, or on another system on the 
network. 

4. The file doesn't exit (the thumbnail is an orphan). In this case, you may remove the 
thumbnail by using the Thumbnail - Remove menu option, or Shift+Delete.



[5058] Corrupted file

ThumbsPlus could not read the file because of errors in its internal format.



[5059] No image data in file

 The file does not contain any information that can be viewed.



[5060] The file <filename> is currently locked. Do you want to retry?

The file is in use by another application or another system on the network. Answer YES for 
ThumbsPlus to try to open it again; answer NO to skip the operation.



[5061] File is empty

There is no information in the file (it has a length of zero). Except in the case of special 
"sentinel" files for some weird applications, such files may usually be deleted.



[5062/<oscode>] Cannot open

 ThumbsPlus is unable to open the file. Additional information (an operating system message) 
should follow this message. You can look up that error code in this document for more 
information.



[5063] Thumbnails have been generated for this disk (<drive:label>). If you relabel 
it, these thumbnails will still be accessible, but ThumbsPlus will not be able to 
ask for the correct disk. Do you wish to continue?

Thumbnails have already been generated for the removable or network volume. If you put a new 
label on it, you should make the thumbnails again so that they will correspond to the disk. You 
can also remove the old thumbnails (Thumbnail - Remove Tree).



[5064] Unable to write disk label to drive <drive>

ThumbsPlus could not write the disk label. Note that ThumbsPlus cannot label:

1. CD-ROM drives.

2. Write-protected diskettes.

3. Network volumes



[5065] Cannot access disk <drive>

ThumbsPlus could not access the specified disk drive. Be sure the disk is valid, formatted, and 
inserted.



[5066] Could not locate CorelDRAW preview bitmap

When CorelDRAW! (CDR) files are set for Internal loading (from the File Type Configuration 
dialog box), ThumbsPlus only loads the preview bitmap from the file. You must save Corel files 
with previews enabled.

Another option is to set up Corel files for OLE access, which does not use the preview bitmap 
(but it does require that CorelDRAW be installed on the machine). Note that Corel is a very slow 
OLE server.



[5067] Internal error: attempt to free IMAGE structure already on free list

This error should not occur -- please report it to Cerious Software if you receive it. Also, you 
should probably exit and restart ThumbsPlus, as its internal structure lists are no longer usable.



[5071] TIFF Library error

This message is used to report errors from the TIFF library. Additional information will follow 
with details about the problem.

We currently do not provide a reference for all of the possible TIFF error reports, though this is 
planned for the future.



[5072] TIFF library warning (continuing)

ThumbsPlus uses this message to report TIFF library warnings. The actual message text depends 
on the problem encountered.

TIFF file processing continues after the message.



[5073] Error opening Undo file <filename>

ThumbsPlus could not create or re-open the temporary file (for saving a copy of the image before 
performing the operation).

Be sure that your TEMP environment variable points to a valid, writable disk drive with 
sufficient free space.



[5074] Error writing Undo file <filename>

ThumbsPlus could not write to the Undo file. Make sure the directory specified in the TEMP 
environment is valid and on a writable disk drive with enough free space.

Large images take large amounts of disk space for the Undo file. For example, a 1024x768x24-
bit image takes about 2.5 Mb of disk space. It can also take a while to write the undo file. The 
storage is released when the image is closed, so it's not a permanent use.

However, you can disable the Undo capability from the Options - Viewer dialog box.



[5075] Error reading Undo file <filename>

ThumbsPlus could not read from the Undo file. Make sure the directory specified in the TEMP 
environment is valid and on a writable disk drive with enough free space.



[5076] Insufficient memory to read Undo buffer

ThumbsPlus could not allocate enough memory to retrieve the image from the Undo buffer. See 
the information about error [5001] Out of Memory for information on memory usage.



[5077] Unable to create palette for gamma test

ThumbsPlus could not create a color palette for determining the proper gamma for your monitor. 
Be sure you're running a video mode with at least 256 colors, and that there is enough memory 
and free system resources.



[5079] OLE error attempting to link

ThumbsPlus could not link with the server application to process the file. Ensure that:

1. The server application is loaded on the machine.

2. It has not been moved to a different directory or disk (unless you also updated the Windows 
Registration Database).

3. It is not already running, processing another OLE request, or busy with some other task.

Sometimes, the server application itself will report an error before ThumbsPlus reports this error. 
In this case, the error reported by the other application generally describes the problem (an 
unsupported file, for example).

Known OLE server problems:

Designer 4.0 and 4.1 often fail when attempting an OLE link. This is unrelated to ThumbsPlus -- 
the same failures occur when linking from other applications. Micrografx is supposedly working 
on the problem.

Word for Windows and many other applications often have problems linking when a document 
includes linked or embedded objects of its own.



[5080] '<filename>' is not an Aldus Rev 1 graphic import filter

ThumbsPlus could not locate the proper routines in the specified .DLL or .FLT file to call it as an 
Aldus filter.

The most reliable way of finding and using external filters is to use the "Hunt for Filters" button 
in the File Type Configuration dialog box. ThumbsPlus will search any or all disks for Aldus Rev 
1 filters. Then, you can associate the appropriate filter with a file type by selecting it from the 
drop-down list.



[5082] There is not enough memory to count all of the 24-bit colors in this image. 
Would you like a count of the number of 15-bit colors instead?

ThumbsPlus cannot allocate a buffer large enough to quickly count the actual number of distinct 
colors in the image (the buffer requires 2Mb, one bit for each possible color). You may count the 
number of distinct 15-bit colors instead (the buffer only requires 4K).



[5083] Error opening as a CGM file

The CGM processing code could not recognize the innards of the file as a CGM file. Note that 
ThumbsPlus only supports binary-encoded CGM files.



[5084] CGM library error

This message indicates a CGM library error processing the file. Processing stops when an error 
occurs.



[5085] You must enter a value in this field

The field in the dialog box requires a value. The field in error will receive the input focus (caret 
cursor) after you click OK.



[5086] That extension is already defined

This error is reported if you attempt to use the New button from Options - File Types to define a 
file type that is already set up. Double-click (or click Modify) to change it instead.



[5089] Only one editing session can be active on a 256-color display

Because editing (color adjustment) requires exclusive access to the palette on a 256-color 
display, you may only open an editing dialog box for a single image at a time.



[5090] Unrecognized raw image grayscale size

ThumbsPlus recognizes raw files by their physical size on disk (based on width x height, as 
entered in the THUMBS.INI file). The specified file does not match any size listed in the INI 
file. See the page on the Raw file type for more information on setting up raw files.



[5091] Error opening as GEM metafile

The GEM processing code could not recognize the file as a GEM metafile.



[5092] Unrecognized or invalid EPS file

ThumbsPlus only accesses EPS files with TIFF or WMF previews. The specified file may be a 
MAC format file (with a PICT preview), may have an EPSI preview, or may not have a preview 
at all.

ThumbsPlus only processes the preview image or metafile. No attempt is made to interpret the 
PostScriptTM text.



[5093] Invalid color depth (number) requested

ThumbsPlus can modify files to 1-bit (bi-level), 4-bit (up to 16 colors), 8-bit (up to 256 colors), 
or Truecolor.

The most likely cause of this message is manually editing the .INI file and specifying an invalid 
color depth.



[5094] I don't know how to save type 'type'

ThumbsPlus does not have provision for saving anything but raster or vector files. This error 
may be reported if you try to save a font file.



[5095] CGM library warning

This error is reported when the CGM library reports an error interpreting a CGM file. It should 
be followed by more detailed information about the specific problem encountered.

Processing continues after a warning.



[5096] Invalid or unsupported IFF file

ThumbsPlus detected a problem in the header of the (supposed) IFF file which made it 
impossible to process. If the file is recognized as a proper IFF file by other software, please send 
a copy to Cerious Software for evaluation.



[5097] Invalid or unsupported GEM image

ThumbsPlus could not process the IMG file as a GEM image. If other software recognizes the 
file as an IMG file, please send a copy to Cerious Software for evaluation.



[5098] Can't create wallpaper from type <filetype>

ThumbsPlus can only create wallpaper from metafile or raster graphics files. Fonts and movies, 
for example, cannot be used as wallpaper.



[5099] Unable to add font

ThumbsPlus could not add the font to the Windows environment. There may not be enough 
memory, or the font file may be invalid. The system may also report an additional error.



[5100] Error removing font

Windows could not remove the selected font; perhaps it is in use or corrupted. Try restarting 
windows and removing the font again.



[5101] Unable to create font resource (.FOT) file

When installing a font, ThumbsPlus has to create a font resource file for Windows, and it could 
not. Some possible reasons:

1. The font resource already exists because an application removed the font without removing 
the .FOT file. You can delete the file manually.

2. The Windows system directory (usually \WINDOWS\SYSTEM) is shared and not writable.

3. The disk containing the Windows system directory is full.

4. The font resource already exists because an application removed the font without removing 
the .FOT file. You can delete the file manually.

5. Some other disk error or problem.



[5102] Could not locate font in WIN.INI for removal

When you select to remove a font, ThumbsPlus attempts to locate it in the WIN.INI file and 
remove its entry, so it won't be loaded again when Windows starts. This message indicates that 
the font was not there. It's usually safe to ignore this message, but if you get it a lot, it probably 
means that some application is installing fonts without setting them up to be loaded at Windows 
startup.



[5103] Could not locate facename in .FOT file

ThumbsPlus attempts to locate the font face name in the font resource file (.FOT). It could not 
locate the appropriate area in the file. The FOT file may be invalid, or may not be a font resource 
file.



[5104] Could not open WIN.INI file to update

ThumbsPlus must manually update the WIN.INI file to perform some functions. It may not be 
able to if WIN.INI is write-protected or on a write-protected disk or network drive.



[5105] Error writing WIN.INI to remove font

ThumbsPlus could not write the WIN.INI file to remove the font entry. However, the original has 
not been modified (nothing has changed).



[5106] The clipboard does not contain a palette to paste

If the current palette selection in the Color Depth dialog is "Paste from clipboard," there must be 
a palette (or an image with a palette) on the clipboard to use.



[5107] Error writing file. Check for a full or write-protected disk.

Well, the most likely causes are covered in the message itself. Other possibilities are:

1. A corrupted file allocation table on the disk. Use SCANDISK or CHKDSK to validate the 
structure.

2. A bad sector on the disk. Use SCANDISK with surface test to check.

3. A network drive is no longer available.



[5108] Can't convert <type> files to <type>

ThumbsPlus cannot convert bitmap files to WMF files, except as bitmaps embedded in a WMF 
(which is a separate Save As or Batch Edit/Convert selection).

Conversion to vector format requires a tracing program, such as Adobe Streamline or 
CorelTRACE!



[5109] Skipped: Destination file (<filename>) already exists

Unless you select to overwrite existing files in the Batch Convert/Edit dialog box, ThumbsPlus 
will skip any conversion that would result in an overwritten file.



[5110] Unable to convert <filename> to a format suitable for wallpapering

Windows can only wallpaper with bitmap (.BMP) files. ThumbsPlus converts any other format 
to the BMP type (a temporary file) before installing as wallpaper. Some file types that 
ThumbsPlus handles, such as Sounds, do not make sense as wallpaper.

Other types, such as fonts and movies, are wallpapered using the thumbnail.



[5111] Drive <drive> does not have enough available space to write the thumbnail 
record (in <filename>). There are only <number> bytes free. Free some space by 
deleting or moving files, or purging the database, then try again.

Pretty much says it all, doesn't it?



[5112] The native application was unable to render the file

ThumbsPlus attempted to have the OLE server application draw the file into memory for viewing 
or thumbnailing, but the other application failed to do so. You may have received message(s) 
from the other application detailing the problem.

Please note that this problem is almost always a limitation or problem in the other application, 
rather than a problem in ThumbsPlus.



[5113] Don't know how to print <class> files

ThumbsPlus can print bitmaps (raster images) and metafiles (vector images). Most documents 
are imported as metafiles.

· Movies

· Sounds

· Other



[5114] Error printing <message>

The message should give more information about the problem, such as:

Print job aborted The print job was aborted, probably by Print Manager or a network 
print server.

Insufficient disk space The disk used for temporary files is full.

Insufficient memory There is not enough memory in the system to print the file. See the 
tips for error message [5001] for ideas on increasing available 
memory.



[5115] No print routine defined for type <extension> (<file type>)

The print method is set to "None" for the specified file type. If the print method is set to 
"internal" instead, but ThumbsPlus doesn't have the capability to print the type, error [5113] is 
issued instead.



[5116] Unable to create or open temporary file for details

ThumbsPlus writes any file details (TIFF tags, for example) to a temporary file. It was unable to 
create it, or unable to open it to read the details in. The disk may be full, unwritable, or 
corrupted.

ThumbsPlus writes this file in the directory specified by the TEMP environment variable.



[5117] Cannot write to temporary details file

ThumbsPlus could not write detail information to the temporary file. See [5116] for more 
information.



[5118] Error reading temporary details file

ThumbsPlus could not read detail information from the temporary file. See [5116] for more 
information.



[5119] File details truncated

ThumbsPlus is not able to display the entire detailed information from the file. Either the system 
is low on memory, or, for Windows 3.1, the list box was full to the maximum capacity allowed.



[5120] File is incomplete (some image data is missing)

The file does not contain all of the image data specified in its header, so some of the picture may 
not be available. The file may have been damaged on download, or truncated by SCANDISK if 
cross-linked sectors were found, or written incorrectly.



[5124] No valid PhotoCD resolutions located in file

PhotoCD files may be available at several standard resolutions; ThumbsPlus could find none of 
these in the .PCD file. It may still load the file, using whatever default resolution it can load as.



[5125] Unable to copy <filename> to the clipboard (no metafile or bitmap contents)

To copy a file to the clipboard, ThumbsPlus must be able to load it as a graphic (metafile or 
bitmap). Some types that cannot be copied to the clipboard:

· Movies

· Sounds

· Executables

· Other



[5126] System resources are too low to attempt OLE access

To avoid system problems, ThumbsPlus requires a minimum level of available system resources 
(GDI and USER space) before attempting to start an OLE server.

There must be at least 20% free GDI and 20% free USER space, and the largest available 
memory block must be at least 4K before ThumbsPlus will attempt OLE access.



[5127] System resource levels are low. You may wish to exit some application(s) 
or restart Windows.

ThumbsPlus periodically checks system resource levels and will warn you if they become to low 
to continue processing. It warns you if free GDI or USER space drops below 20%, or if the 
largest available memory block is less than 4K.



[5128] ThumbsCD is unable to locate the required Registration file. If you've 
copied the catalog to your hard drive, be sure to copy the THUMBSCD.REG file to 
the same directory.

ThumbsCD requires the THUMBSCD.REG file be located in the same directory as the 
THUMBS.TUD file. If you've copied this file from your CD-ROM to the hard disk (to improve 
performance, or to see the thumbnails without having to insert the CD-ROM), you must copy the 
THUMBSCD.REG file to the same directory.



[5129] Insufficient space on drive <drive> for sorted thumbnail file (<number> 
bytes required)

When sorting the thumbnail database, ThumbsPlus complete re-writes the file. If there is not 
enough space on the disk to encompass the new, sorted database, you'll get this error.

Once the thumbnail file is sorted, the original is removed, freeing up its space; but, during the 
sort, there must be enough free space for both the original and the sorted database to be on disk 
simultaneously.



[5130] Unable to create temporary thumbnail file for sorting (<filename>)

ThumbsPlus could not create the temporary file for sorting. The name is displayed so you can 
check for problems on the disk. Note that once the sort is complete, ThumbsPlus will remove the 
original .TUD file and rename the temporary file to be the new .TUD file.

Check for a valid disk name, that the disk is writable, and that it is free from problems 
(SCANDISK or CHKDSK).



[5131] Unable to copy font file <filename> to <font-directory> for installation

ThumbsPlus copies any font files to be installed from removable media (diskette or CD-ROM) to 
the Windows system directory (or to the directory specified in the CopyToDir entry of the 
[Fonts] section of the THUMBS.INI file). The directory may not be accessible or the disk may 
be full.



[5133] Please insert the disk containing <filename> in drive <drive>

ThumbsPlus requires the disk that has the specified file name. This message is usually only 
generated if the THUMBS.TUD file is on removable media and the disk is removed. Also, if the 
database is on a network drive and the drive becomes unavailable, you may see this message.



[5134] WPG Library error

The WPG library could not process the file. The message should give more detail about the 
problem.



[5135] WPG Library warning

The WPG library could not completely process the file. Processing does continue after this 
warning.

Note that ThumbsPlus suppresses multiple identical WPG warnings to avoid needless repetition.



[5136] Video for Windows is not installed

You must install Video for Windows version 1.1d or later to view AVI files from ThumbsPlus. 



[5137] Only one animation may be active at a time

ThumbsPlus can only play one animation (AVI or MOV file) at a time. Close the open animation 
window before attempting to play another, or use Window - Close All function to close all open 
windows.



[5138] Please enter a number between <min> and <max>

The current field requires a number between the specified values. When you click OK, 
ThumbsPlus will position the cursor and set focus to the control with the invalid entry.



[5139] Are you sure you want to remove filter '<name>'?

Just making sure that you really want to delete it...



[5140] Invalid path entered

You have entered an invalid directory path or file name for your operating system.

For DOS, the rules are:
» Each directory name must be a valid file name.
» Directory names are separated by backslashes (\).
» File names are 8 characters with a 3 character extension, separated by a period.
» There can be only one period.
» The following are not valid in file names or extensions:

control characters
space
/ slash
\ backslash
: colon
; semi-colon
* asterisk
[] square brackets
? question mark
| vertical bar (pipe)
% percent 

» Lower case and upper case letters are considered equivalent.
» Multinational characters may also be used.



[5141] Unable to open data source

 TWAIN could not open the data source. Be sure that a TWAIN module is installed and valid for 
your scanner or other acquisition device. Also be sure the scanner is on and connected correctly.



[5142] Unable to start data source user interface

ThumbsPlus could not communicate with the selected device's user interface. Be sure that it's not 
active for some other applications, and be sure it is installed properly.



[5143] Unable to read image from source

The TWAIN data source may have aborted unexpectedly or otherwise failed, or the image may 
be in an unrecognized format.



[5144] Unsupported bits-per-pixel from data source. ThumbsPlus requires 1, 4, 8 
or 24 bits per pixel.

ThumbsPlus cannot currently handle other scanned image formats, such as 2, 4, 16 or 48 bits per 
pixel. Use the data source user interface to select a bit depth that ThumbsPlus can handle.



[5145] Unable to load palette from data source

The data source failed trying to send the palette (color map) data to ThumbsPlus for an indexed 
image.



[5146] Unsupported color mode. Please select bi-level, grayscale, RGB, or RGB 
palette.

ThumbsPlus can only support scanning using these color modes. Here are some alternate names 
that a data source may use:
» bi-level: monochrome black & white bitmap
» grayscale: intensity single channel gray black & white
» RGB: Truecolor Full color 24 bit
» RGB palette: indexed mapped 8 bit



[5147] Error attempting to coordinate memory transfer

ThumbsPlus retrieves images from a data source using memory transfers, and was unable to 
negotiate an acceptable method of retrieving the data from the source.



[5148] Please close current acquisition dialog before selecting a source.

You cannot use the File - TWAIN Select Source when an acquisition screen (File - TWAIN 
Acquire) is active. Close the scanner user interface window and try again.



[5149] Unable to access Source Manager to select a data source

ThumbsPlus could not access the TWAIN source manager. Make sure that TWAIN is properly 
installed on your system.



[5150] Internal error

An internal error was detected that indicates either a programming bug or a corrupted executable. 
Try re-installing ThumbsPlus; if that does not correct the problem, contact Cerious Software.



[5151] Image is too wide to be filtered. The maximum width is approximately 9000 
pixels (for grayscale images), or 3000 pixels (for color images).

ThumbsPlus cannot currently filter images larger than this. This restriction will be removed in a 
future release.



[5152] Only linear filters may be edited

You may adjust the convolution mask only for linear filters. Other types (statistical, noise, and 
multi-pass) are defined internally.

You may create or modify multi-pass filters by editing the THUMBS.FLT file.



[5153] Unable to allocate enough memory to filter

ThumbsPlus cannot allocate enough memory for the filter buffer. See error [5001] for 
information on increasing the amount of memory available to ThumbsPlus.



[5155] The mask defined for <filter> is all zeros

An all-zero filter mask would produce simply an all-black image.



[5156] <filename> does not have a palette

To load a palette from a file, it should either be a ThumbsPlus .PAL file, or an image containing a 
color map (palette). Some types that often (but not necessarily always) contain palette are:

.BMP, .GIF, .IFF, .PCX, .IMG, .TIFF



[5158] The width and height must be a value less than <maxval>, or a percentage 
less than <maxpct>%.

Enter a non-zero value for the width and height. Use '%' to enter percentages; i.e., 50%.



[5159] Common dialog error: <number>

ThumbsPlus received an unexpected error from a Windows common dialog. The number may be 
useful for diagnosing the problem by Cerious Software .



[5160] <filename>: JPEG warning: <warning>

The JPEG library reported a warning about the file; however, the file was processed. If there are 
problems with the appearance of the file, this warning may give more information about why.



[5161] Memory heap corruption: <heap name>

ThumbsPlus's memory heap has been corrupted, either by a bug in the program or a problem 
with an external library. You may want to exit and restart ThumbsPlus.



[5162] <filename>: file '<filename>' already exists; not overwritten

The uudecoded destination file already exists, so ThumbsPlus did not overwrite it. You can 
modify this behavior using Options - File Loading - UUdecode.



[5163] <filename>: Unable to create uudecode output file '<filename>'

ThumbsPlus could not create the output file specified in the Uuencoded file. The file name may 
be invalid, or you may need to change the output path (from Options - File Loading - 
UUdecode).



[5164] <filename>: end-of-file and no continuation file found (while decoding to 
'<filename>')

While uudecoding the file, ThumbsPlus could not find the 'end' record or a continuation file. 
Continuation files should have the same name as the first file, with the extensions '.002', '.003', 
etc.



[5165] <filename>: Invalid input line in file (continuing)…

An invalid line was found in the uuencoded file, but was skipped.



[5166] <filename>: No 'end' record found

ThumbsPlus could not locate an 'end' record in the uuencoded file. The file is processed through 
end-of-file instead.



[5167] <filename>: Error deleting uudecode temporary file '<filename>'

ThumbsPlus could not remove the temporary file used for uudecoding. It may have been 
removed by another program, or currently open. You can remove the file manually.



[5168] <filename>: Cannot delete after decoding to '<filenaeme>'

ThumbsPlus could not remove the original encoded file after decoding. It may be open by 
another program. You can remove the file manually.



[5169] <filename>: <number> warnings encountered during decode to 
'<filename>'

ThumbsPlus encountered several problems decoding the file. These warnings will be listed 
preceding this message.



[5170] <filename>: Successfully decoded to '<filename>'

The file was successfully decoded and written.



[5171] <filename>: PNG library error: <error message>

The PNG library reported an error processing the file.



[5172] Database error: <error message>

An error occurred accessing the database. Additional information is provided from the database 
library. You may need to rebuild your database using the Rebuild utility.



[5173] Unable to register window class for toolbar

ThumbsPlus could not create the toolbar. Your system may be low on memory or resources. 
Restart Windows and try again.



[5174] Unable to copy '<filename>' to '<filename>'

ThumbsPlus could not copy the file. This error should be accompanied by an error message from 
the system with more information.



[5175] Unable to find any files in your selection to process for contact 
sheets/catalog.

The current directory or sub-directories do not contain any files that ThumbsPlus could process 
for the contact sheet or catalog. Make sure that you've selected the correct directory, and that the 
desired file types are selected (Options - Preferences - File Types).



[5176] <filename>: skipped — PhotoCD file is encrypted or watermarked for 
retrieval at <width> x <height>

During batch processing, ThumbsPlus skips PhotoCD files that are encrypted or watermarked. 
You can process these files singly and enter the appropriate password when loading.



[5177] Unable to print catalog

ThumbsPlus could not print the catalog. This message is accompanied by a system error message 
describing the problem.



[5178] Error initializing print job on printer '<printer>'

ThumbsPlus could not start the print job. This message should be accompanied by a system 
message describing the problem in more detail.



[5179] <filename>: Adobe Type Manager has not been installed, or is not active

ThumbsPlus could not communicate with the Adobe Type Manager. Make sure ATM is properly 
installed and active.



[5180] <filename>: Unable to match font name

After loading the font, ThumbsPlus could not locate the name using ATM. The font may be 
corrupted or invalid.



[5181] <filename>: Unable to load ATM font

ThumbsPlus could not install the font. The font file may be corrupted or invalid.



[5182] Unable to remove directory '<directory>'

ThumbsPlus could not remove the directory. This message should be accompanied by a system 
message with more detailed information about the problem.



[5183] The file <filename> is a system, read-only or hidden file; do you really wish 
to delete this file?

You should verify that the file is not needed before deleting it.



[5184] The directory '<directory>' is not empty. Are you sure you wish to delete 
this directory and all its files and subdirectories?

Selecting "yes" will cause ThumbsPlus to remove the directory and all of the directories and files 
within it.



[5185] TWAIN: Unable to open data source manager

Ensure that 32-bit TWAIN is installed and properly configured on your system.



[5186] Missing required COLORMAP tag

The TIFF file is set as a color mapped file, but there is no color map tag. The software which 
created the file did so improperly.



[5187] Unsupported image format

The TIFF file has an unsupported image or color format. See the TIFF information for known 
limitations of TIFF file processing in ThumbsPlus.



[5188] Insufficient memory for buffer

ThumbsPlus could not allocate enough memory for the TIFF strip buffer. See error 5001 for 
more information on memory problems.



[5189] This image has too many colors to save as a GIF file. Do you want 
ThumbsPlus to reduce it automatically?

GIF files can only contain 256 colors, and the current image has more. Select "Yes" for 
ThumbsPlus to automatically reduce the color depth of the image before saving. ThumbsPlus 
will use a 256-color optimized palette and Stucki dithering.



[5190] <filename>: Invalid TIFF compression for image; will compress using 
<method> instead

Some TIFF compressions are valid only for certain color depths; for example, the CCITT Group 
3 and Group 4 compression methods are only valid for bi-level (monochrome) images. In batch 
mode, ThumbsPlus uses another compression method instead (generally LZW).



[5191] <filename>: Unsupported TIFF color mode

ThumbsPlus does not support the color mode of the TIFF file; for example, L*a*b. More 
information about TIFF support can be found in the TIFF information.



[5192] ThumbsPlus cannot be run from a network after the trial period has 
expired.

You must purchase a site or concurrent use license to run ThumbsPlus on a network.



[5193] Warning: the ThumbsPlus trial period has expired. After a fifteen day grace 
period, you will not be able to run from a network.

You must purchase a site or concurrent use license to run ThumbsPlus on a network.



[5194] No network license installed. Please run ThumbsPlus from a local disk.

Neither the executable (THUMBS.EXE) or the database (THUMBS.TDB) may be located on a 
network unless you have installed a site or concurrent usage license.



[5195] Note: overwriting file <filename> with <filename>

This message appears in the 'Errors Encountered' area of the progress box when you have 
selected "Yes to All" and a file is overwritten.



[5196] Note: file <filename> already exists - skipping <filename>

This message appears in the 'Errors Encountered' area of the progress box when you have 
selected "No to All" and a file already exists.



[5197] Note: overwriting file <filename> with newer <filename>

This message appears in the 'Errors Encountered' area of the when a newer file is overwriting 
and older file (you selected "Yes to Newer" from the replacement confirmation dialog box).



[5198] Note: <filename> skipped; newer than <filename>

The file was not overwritten because you selected "Yes to Newer" but the destination was newer 
than the file being moved or copied.



[5199] The credit card number is invalid. Please enter a valid Visa or Mastercard 
number before printing.

Double-check your card number.



[5200] The credit card expiration date is invalid. Please enter the date in the form 
MMYY; for example, 0797.

Double-check your expiration date.



[5201] Nothing is ordered. Please select a license before printing.

Use the "License" drop-down to select the type of license you want to order.



[5202] <filename>: Unable to load as DXF file

The DXF library was unable to recognize and process the file.



[5203] The disk in drive <drive>:\ has no volume label. Without a volume label, 
ThumbsPlus cannot generate thumbnails for it. Would you like to give it a label 
now?

Click Yes to assign a volume label to the drive.



[5204] The disk <drive>:\ has the same volume label (<label>) as <drive>:\. 
Without a unique label, ThumbsPlus will not be able to generate thumbnails for it. 
Would you like to relabel <drive>:\ now?

Click Yes to assign a new volume label to the drive.



[5205] <filename>: Error removing ATM font

ThumbsPlus could not remove the ATM font.

Note: ATM fonts (PFB files) are supported only on Windows 95. Be sure that ATM 3.02 is 
installed and active, and that the font is not currently in use.



[5206] <filename>: Unable to locate associated font metrics (PFM)

Each ATM font is composed of two files: the .PFB file, which contains the actual font outlines, 
and the .PFM file which contains metric information. Both files must be present, and the .PFM 
files should be in the "PFM" sub-directory of the directory containing the .PFB files. This is the 
standard Adobe installation format.



[5207] Unable to execute CSWATM16.EXE to obtain ATM font information

The file CSWATM16.EXE should be in the same directory as the THUMBS.EXE program.

Note: ATM fonts (PFB files) are supported only on Windows 95. Be sure that ATM 3.02 is 
installed and active, and that the font is not currently in use.



[5208] <filename>: The import filter encountered an exception while processing

Windows detected that the import filter (.FLT) encountered a GPF, IPF or other unrecoverable 
error while processing. ThumbsPlus trapped the error and can continue processing; however, 
some resources or memory may have been lost until you exit and restart ThumbsPlus



[5209] Note: file <filename> overwritten with identical file <filename> (which was 
deleted)

You selected "Yes to same" for confirmation of moving files, and ThumbsPlus lists the files that 
are moved because they are identical.



[5210] Note: file <filename> is different from <filename> (file not moved)

You selected "Yes to same" for confirmation of moving files, and ThumbsPlus determined that 
these files were different, so the move did not complete.



[5211] <filename> is a multi-page file containing <count> images. If you save with 
the same name, the other images will be lost.

Although it can read them, ThumbsPlus does not currently save multi-page files. If you select 
File - Save while viewing such a file, this dialog box gives you the opportunity to select a 
different name so the other pages (images) are not lost.

You can also use the Edit - Split Pages menu selection to split a TIFF or DCX file into separate 
files for each page.

Note: This message is currently only active for .TIF files; DCX files automatically cause the 
Save As dialog to be generated, since ThumbsPlus cannot save in the DCX format.



[5301] Filter does not recognize file

The Aldus Rev 1 graphic import filter is not able to process the file.



[5302] Picture too big for filter

 Some import filters may limit the size of file they can handle, and will report this error if a file is 
beyond its capacity.



[5303] Invalid bitmap in file

The file contains a raster image that is invalid, or that the filter cannot process.



[5304] Invalid character in data

 The filter could not process the file because of an invalid character. The file is either bad or 
beyond the capability of the filter.



[5305] Invalid token in data stream

The filter could not process the data in the file. The file may be bad or a more recent version than 
the filter can handle.



[5306] Failed to verify imported story

The filter could not properly handle the data in the file.



[5307] Unknown file type

The filter cannot recognize the file.



[5308] Not a WP file

The filter could not recognize the file as a WordPerfect file. You should use the internal methods 
of ThumbsPlus for loading WP graphics instead.



[5309] Invalid file data

The data in the file is not compatible with the filter, or otherwise corrupted.



[5310] Filter aborted

The Cancel button was pressed, or an internal error occurred in the filter.



[5311] Insufficient memory

The filter could not allocate enough memory to process the file. See error [5001] for hints on 
making more memory available.



[5312] Could not render missing system font

Some font referenced in the metafile could not be found in the system.



[5313] Resultant metafile too large

The result of the conversion (a metafile) is too large to hold in memory, or too complex to render. 
The file cannot be processed by the filter.



[5314] Invalid Lotus .PIC file

Reported by the PIC import filter when the file is not recognizable as a Lotus .PIC file. It could 
be some other kind of .PIC -- several vendors have chosen that extension for graphics.



[5315] Unable to lock memory handle

This is probably an internal coding error in the filter; or the Windows global memory heap could 
be corrupted. Restart Windows and try again.



[5341] Unsupported compression mode

The import filter can only process some compression methods.



[5342] Unsupported file version

The file format has been updated, and the filter does not support this version of the file. Try to 
obtain a more up-to-date filter, or save the file in a different format.



[5343] Unsupported color type

The import filter does not support all color types; this file cannot be processed. You may want to 
use its native application to convert it to a different file type, or to a color type which the filter 
can process.



[6001] Your current Windows display is not set for at least 256 colors...

...For the best viewing (especially of images), we highly recommend that you run ThumbsPlus 
with a 256 color (8-bit), Hicolor (15-16 bit) or Truecolor (32 bit) display driver.

ThumbsPlus will run best on machines with Hicolor or Truecolor displays, and performs well on 
machines with 256 colors (palette-based). 16-color and monochrome display systems are not 
recommended unless you'll be working only with low-resolution images.

See the section on Windows Video Drivers for general information about Windows display 
drivers.



[6002] This operation will cause the image to be promoted to 24 bit, so that proper 
color information can be interpolated.

ThumbsPlus can only do some color operations on truecolor (24-bit) or grayscale images. If you 
plan to use the image on 256-color displays (or if you're running a 256-color display), you may 
want to reduce the color depth before saving the file.



[6003] This operation will cause the image to be promoted to 8-bit grayscale, so 
that proper grayscale levels can be interpolated.

ThumbsPlus can only do some grayscale or monochrome image operations on 256-level 
grayscale images. The current image has fewer than 256 levels, so it must be converted to 256-
level (8-bit) grayscale before processing.



[6004] JPEG-compressed TIFF files are not widely supported.

…For compatibility with other applications, you may wish to choose a different compression 
method.

This is just a warning that the file type you have chosen may not be recognized by other 
programs. You may want to test other programs before deciding to use this type for many files.



[6005] ZIP-compressed TIFF files are experimental and not widely supported.

…For compatibility with other applications, you may wish to choose a different compression 
method.

This is just a warning that the file type you have chosen may not be recognized by other 
programs. You may want to test other programs before deciding to use this type for many files.



[6006] Progressive JPEG files are not supported by many other applications.

This is just a warning that the file type you have chosen may not be recognized by other 
programs. You may want to test other programs before deciding to use this type for many files.
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A
Aspect Ratio 

Autocrop

.AVI

.ANI
B

Bitmap 

Bi-level

.BMP

.BMF

Burkes, see Dither
C

CD-ROM 

.CDR

.CEL

.CGM

CIE L*a*b

CMYK

Color Depth

Color Quantization 

Convolution mask, see Digital Image Filtering

Crop 

.CUR 

cursor
D



Desktop 

.DCX

.DIB

Digital Image Filtering 

Dither

DPI, see Resolution

Drag and Drop

.DXF
E

.EPS

Error diffusion, see Dither 
F

.FIF

Floyd-Steinberg, see Dither

Font
G

Gamma 

.GEM

.GIF

Graphics Filter 

Grayscale
H

Highcolor
I

.ICO

Icon 

Identity palette 

.IFF

.IMG

Import filter, see Graphics Filter

Indexed color

Interpolation
J

.JFI

.JIF

.JPG 
K

.KDC



.KIZ
L

.LBM 
M

Metafile 

Median cut, see Color Quantization

.MF

.MID

.MND

Monochrome

.MOV

.MPG
N
O

OLE 
P

Palette 

Path 

.PCC

.PCD

.PCX

.PFB

Pixel 

Profile (.INI file) 

.PNG

.PSD

Purge, see Compact
Q

Quantization, see Color Quantization
R

.RAS

Raster, see Bitmap

Rasterize

.RAW

Resolution

RGB, see Truecolor
S

Stucki, see Dither



.ST4, .STX, .ST5, .ST6, .ST7, .ST8
T

Targa

.TGA

Thumbnail 

.TIF

Token 

Truecolor

TrueType

.TTF
U

.UUE
V

Vector graphic 
W

 Wallpaper 

.WAV

.WMF

.WPG
X
Y
Z



Drag and Drop

Drag-and-drop is the process of moving files by pointing with the mouse, clicking the left mouse 
button, and "dragging" to the desired location. In ThumbsPlus, you can use this method to move 
or copy graphics files.



Aspect Ratio

The relation between the height and width of an image. For example, a square has an aspect 
ration of 1-to-1 (the height is the same as the width).



Pixel

A pixel is a dot in a raster image, or bitmap. Depending on the color resolution, a pixel takes 
from 1 to 24 bits to represent in memory and on disk. Therefore, an uncompressed bitmap which 
is 100 pixels wide by 100 pixels high can require from 10,000 to 240,000 bits (1250 to 30,000 
bytes).



Metafile

A metafile is a stored sequence of drawing commands which the computer can repeat to generate 
an image. Like vector graphics, metafiles can contain simple drawing commands (such as line, 
rectangle, circle, arc, polygon); they may also contain commands to set colors, fill areas, display 
text. Unlike vector graphics, metafiles can include bitmaps. Thus, metafiles are much more 
flexible than bitmaps, but they are more difficult for programmers to support and usually slower 
to display.



Grayscale

A grayscale image contains various levels of gray. At its simplest form (two levels of gray -- 
black and white), this is a bi-level image. Usually, grayscale images contain from 4 to 256 levels 
of gray, though some file formats (notably TIFF) can store as many as 65,536 levels of gray per 
pixel.



Monochrome

This term is sometimes used to refer to a bi-level    graphic; other times it refers to a single-
channel (grayscale) image. In ThumbsPlus, it is used as a synonym for bi-level.



Bi-level

Of two intensities (generally black and white). Bi-level graphics are sometimes referred to as 
monochrome or black and white, but either of these terms can be misleading, as each sometimes 
refers to single-channel color, which can be grayscale. Bi-level is a much less ambiguous 
description of a one-bit-per-pixel bitmap.



Bitmap

A bitmap (also known as raster graphic) is a graphics image composed of small dots (pixels). 
These dots can be simple on-or-off bits (a bi-level bitmap), or represent colors. Windows 
supports four levels of raster images: bi-level (1 bit per pixel), 16-color (4 bits per pixel), 256-
color (8 bits per color), or 16 million color (24 bits per pixel, also known as Truecolor). Raster 
graphics do not generally scale to larger sizes very well; the dots become squares or rectangles 
and the image appears grainy. Also, raster images use lots of disk space and memory. However, 
they generally display faster than metafile or vector graphics and can show much more true-to-
life detail than vector graphics. Scanned images, such as CompuServe GIF files, are raster 
images.



Autocrop

A method to automatically remove same-colored borders from an image. In ThumbsPlus, this 
may be accomplished using the Edit - Autocrop menu option, or in batch mode from the 
Miscellaneous Batch Operations dialog box.



Color Depth

For images, Color Depth refers to the amount of information required to specify the color or 
level of a pixel. Here are some common depths (in bits), and corresponding common names for 
them:

1-bit Bi-level Monochrome

4-bit Indexed color Grayscale

8-bit Indexed color Grayscale

24-bit Truecolor RGB

32-bit CMYK RGBA

48-bit Truecolor RGB



Crop

Cropping an image involves selecting an area and removing the rest. ThumbsPlus can crop 
manually (where you select the crop area) from the View Window; ThumbsPlus can also 
autocrop, removing unnecessary space from around an image. You can control when 
ThumbsPlus does this automatic cropping from the General Options dialog box.



Color Quantization 

Color quantization is the process of finding the best set of colors (palette) for representing an 
image. Two methods are provided in ThumbsPlus - median cut, which does a very good job for 
real-world (scanned or photographed images), and popularity, which does well for drawn 
images.

The popularity method simply picks the n colors used the most in the image; this tends to leave 
out colors for highlights in photographs, which are important even though not the most popular.

The median cut method assigns all available colors to boxes, then splits the boxes to determine a 
representative set of colors. There are three median cut options in ThumbsPlus: 5-bit, 6-bit and 8-
bit. The more bits available for each color component, the more memory and time required to 
quantize, and the better color matches that are obtained.



Gamma

Generally, gamma correction is a process to make pictures appear more accurately on a specific 
monitor. Differences in color value do not exactly map to changes in brightness on the screen; 
the gamma value defines a curve which specifies the way a monitor displays specific color 
values. The Monitor Gamma dialog box helps you find the appropriate gamma value for your 
monitor.

The other piece of the equation is figuring out the corrected gamma value to which an individual 
picture was adjusted. The Compuserve GIF definition specifies that GIFs should be adjusted for 
a gamma value of 2.0 -- you can set the "assumed gamma" for any picture, or set the default for 
any file type.

Generally, if pictures appear dark and have little detail in the shadow regions, they're probably 
linear (gamma = 1.0). Try setting your monitor gamma to an appropriate value, and the assumed 
gamma to 1.0.

Note: If either the assumed gamma or the monitor gamma is zero, ThumbsPlus will not gamma 
correct the image for display.



Desktop

The window that acts as the background for all windows in Windows 3.1. Other windowing 
systems generally call this the root window. Icons appear at the bottom of the desktop window.

Wallpaper appears on the desktop.



Palette

A color palette is much like an artist's palette -- it's the selected color values that are used to 
represent an image. 24-bit (truecolor) images don't have a palette; each pixel includes the color 
information in it. When reducing a 24-bit image to an 8-bit or 4-bit image, you'll need to select 
an appropriate color palette, or have ThumbsPlus compute an optimized palette for you, using 
color quantization.

A palette stored with an indexed color image is also known as a color map.



Wallpaper

A    Windows bitmap displayed in the background (the desktop). From ThumbsPlus, this image 
may be tiled (repeated to fill the screen) or centered.



Graphic Import Filter

A program or library (DLL) which can convert graphics from one format to another. Microsoft 
provides several filters with Word for Windows and other products. ThumbsPlus can sometimes 
use these filters to import graphics files, though because they are not written or supplied by 
Cerious Software, they cannot be guaranteed to work.



Token

A sequence of letters or symbols which represent something else. For example, '%F' is a token 
which represents a file name in the editor command string invoked by ThumbsPlus.



Indexed color

Indexed color images contain several colors or levels of gray and a palette (or color map) which 
specifies the color of each given level. Most indexed color images are 4 or 8 bits per pixel (16 or 
256 colors).



CMYK

This color specification derives from the names of the colors of inks combined for printing in 
color:

Cyan

Magenta

Yellow

blacK

The more common method of specifying color for display is RGB (red, green, blue).



Truecolor (RGB)

A truecolor image is most often represented by a full color value for each pixel of the image. In 
most cases, 8 bits (256 levels) each of red, green and blue (RGB). Other schemes may represent 
colors using other methods, such as HSI, HSL, YUV, YCbCr, L*a*b, or CMYK. Because RGB is 
the prevalent method for representing images for display, it is used internally by ThumbsPlus.

Some file formats may allow more bits per pixel (12 or 16), but the difference in image quality is 
usually slight. The chief advantage of a wider range of pixel values is less information loss 
during image processing.



Dither

Dithering is a process which allows many colors to be represented by a few. For example, the 
standard Windows VGA driver only has 16 colors, and combines these in simple patterns 
(ordered dither) to represent many more. An ordered dither is acceptable when viewed from a 
distance, but often causes images to appear grainy and cluttered. Better dithering methods, called 
error diffusion, provide a better appearance, especially for real-world images. One key to a 
successful dither is providing enough and appropriate colors to work with (palette selection or 
color quantization).

ThumbsPlus provides several error diffusion dithers for use when reducing the number of colors 
in an image: Floyd-Steinberg, Burkes and Stucki; and a single ordered dither (ThumbsPlus 
Quick), which is used to quickly dither Truecolor (24-bit) images for an 8-bit (indexed color) 
display.



Profile (.INI file)

Lists configuration options and selections for a program. The Windows profile is called 
WIN.INI; the general profile for ThumbsPlus is THUMBS.INI. Profile files are generally stored 
in the Windows directory to be unique for each user in a network environment. Also, 
ThumbsPlus stores database-specific options in a THUMBS.TUO file, in the same directory as 
the database. For more information on the THUMBS.INI file and THUMBS.TUO files, see INI 
& TUO File Settings.



Identity palette

An identity palette is a 256-color palette that includes the 20 reserved Windows colors in the first 
10 and last 10 positions in the palette. Files created with such palettes may be somewhat quicker 
to display in 256-color display mode. Also, some graphics applications require files with identity 
palettes. You can make any palette with 17 or more colors (and 236 or fewer) into an identity 
palette by selecting the option in the Color Depth dialog box.



OLE (Object Linking and Embedding)

Object linking and embedding is a method used in Microsoft Windows to connect documents of 
one type to another. For example, a Paintbrush picture (BMP) may be embedded in a Word 
document, or a Corel drawing may be linked into a Write file. ThumbsPlus can sometimes use 
OLE to create thumbnails of file types which aren't directly supported; see the File Type 
Configuration dialog box for more information.



Digital Image Filtering

Digital image filtering performs processing on an image by combining or comparing individual 
pixels with their neighbors. Many interesting and useful affects can be obtained, such as 
sharpening, blurring, edge detection and embossing. Many such filters are available in 
ThumbsPlus from the Image - Filter - Select Filter menu selection.

Linear filters -- those with a fixed array (or convolution mask) defining how to combine a pixel 
with its neighbors to compute the result -- may be defined in ThumbsPlus using the Image - 
Filter - New Filter menu selection. 



Path

The DOS Environment variable which specifies where DOS and Windows look for executable 
files when no explicit drive or directory information is given. It is usually set in the 
AUTOEXEC.BAT file, which runs when DOS starts up.

Also, a directory specification may be referred to as a path.



CD-ROM

A CD (compact disk) used to store data. ROM stands for "Read-Only Memory." You cannot 
write to a CD-ROM disk, but they are quite useful for distribution of large amounts of data, and 
much more reliable than floppy disks.



Compact

To eliminate unneeded, unused or deleted space. In the context of ThumbsPlus, you can compact 
the database by selecting the Compact selection from the TDBUtil program (which comes with 
the registered version). This will release all disk space occupied by deleted or moved thumbnails 
so it can be used for other files.

Note that version 3 of ThumbsPlus will automatically re-use deleted space for new thumbnails, 
so compacting (purging) is not required nearly as often.



Icon

An icon is a small representation of something. Icons in the Windows environment are not 
usually worshiped; but judging by the size of some people's icon libraries, they're at least 
admired.



Resolution

The resolution of an image describes the detail at which it was obtained, or at which it is 
designed to be printed. For example, a 300 dpi image was scanned at or designed to be printed at 
300 dots per inch. (So, a 300 x 300 pixel image at 300 dpi should print as 1 inch by 1 inch).

Except in the U.S., resolution is usually referred to as dots per centimeter (dpc) or pixels per 
meter (ppm).

Note that changing the resolution of a bitmap does not change its information content -- 
resolution is really a hint to an application program to suggest a suitable size for printing. Most 
applications scale for the output device to present the image at or close to its original size.

Most applications also allow you to scale an image to a desired size. Also, many images do not 
contain resolution information.



TrueType

A TrueType font is a font developed using a particular font technology which describes each 
character as a sequence of closed b-spline curves. There are also provisions for hinting, which 
provides better-looking characters at small point sizes.



Font

A font is a particular type style. For example, Arial is the font in which this help file is rendered. 
ThumbsPlus can create thumbnails of and view character sets of    TrueType fonts.



Highcolor

This term usually refers to display hardware that is capable of reasonably good color depth, but 
not as realistic as Truecolor (24-bit).

Most high-color displays are 15-bit (32,768 colors -- 5 bits each for red, green and blue) or 16-bit 
(65,536 colors -- 5 bits each for red and blue; 6 bits for green because the eye is more sensitive to 
green).

Although high-color displays save some video memory, they generally run slightly slower than 
truecolor displays because of the translation requirement (Windows runs in truecolor mode, but 
the display driver must translate the 8-bits-per-pixel RGB pixels to the high-color 
representation).



Interpolation

Interpolation is a process of computing intervening values from given values (generally by 
averaging). For example, when ThumbsPlus changes the size of a bitmap, it can interpoloate and 
compute the extra pixels as weighted averages (based on closeness) of neighboring pixels.



Rasterize

Rasterizing (or rasterization) is the process of drawing a metafile or vector graphic to a bitmap. 
This creates a fixed-size raster graphic from the metafile or vector graphic.



Thumbnail

A small representation of an image, used as an aid in indexing or cataloging graphics images.

ThumbsPlus is particularly adept at creating useful thumbnails for bitmaps , fonts and metafiles.



Vector graphic

Vector graphics are graphic objects composed of the definition of drawn shapes and lines -- 
rectangles, arcs, ellipses, curves, etc. Metafiles    are similar, but more robust; they may also 
contain text and bitmap (raster) elements.

Because they are descriptions of shapes rather than a table of individual dots (pixels), vector 
graphics may be scaled more readily and more accurately than raster graphics.



CIE L*a*b 

The L*a*b colorspace was designed by CIE to provide a device-independent way to specify 
colors. Photoshop PSD files can be saved in L*a*b format, as can TIFF files.

ThumbsPlus converts the colors to RGB based on default values for monitor settings.




